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Overview

Introduction

CallPilot Part 5: 1001rp Server Maintenance and Diagnosgioavides
information and instructions for maintaining a CallPilot server, as well as
troubleshooting tips for potential problems.

Who should read this guide

This guide is for planners, administrators, technicians, and engineers responsible
for maintaining a CallPilot server.

It includes information for installing, repairing, replacing, and upgrading
hardware and software components. The guide assumes that the reader:
m  has basic computing skills

m is familiar with necessary safety procedures

m  has the hardware documentation provided by the manufacturer available as
a reference

m is maintaining or troubleshooting an existing CallPilot server.

Glossary and Related Guides

Part 1 of this binder contains a glossary and a list of related guides.

14 CallPilot
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Skills you need

Introduction

This section describes the skills and knowledge you need to use this guide
effectively.

PC experience or knowledge

Knowledge of, or experience with, the following PC products will be of
assistance when administering the CallPilot server:

= Microsoft Windows 95 or Windows NT
m client/server architecture
m Internet Protocol (IP)

Other experience or knowledge

Other types of experience or knowledge that can be of use include:

m database management
m  programming

Part 5: 1001rp Server Maintenance and Diagnostics 15
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Structure of this guide

Introduction

CallPilot Part 5: 1001rp Server Maintenance and Diagnostiefines the
hardware and software diagnostic and recovery activities that a support
technician should perform.

The first five chapters of this guide describe the tools that are available for
identifying, diagnosing, and fixing hardware problems. If a problem is
discovered, Chapter 6 provides procedures for removing the malfunctioning
hardware component and upgrading or installing a new component.

If the problem is software-related, Chapters 7 and 8 describe the procedures for
installing the server software in a recovery situation.

Regular server maintenance procedures are described in Chapters 9 and 10.

If required, the procedures for uninstalling and reinstalling the server software
are described in Chapters 11 and 12.

The last chapter provides procedures for recovering from a hard drive failure.

16
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Symbols and conventions

Introduction

This section describes the symbols and conventions used in this guide.

Symbols

You might encounter the following symbols in this manual.

DANGER

Risk of electric shock

Warns you of an immediate electrical hazard that, if not
avoided, will result in shock, serious injury, or death.

WARNING
& Risk of personal injury

Warns you of a situation in which you can be injured if
instructions are not followed exactly as stated.

Part 5: 1001rp Server Maintenance and Diagnostics 17
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CAUTION
& Risk of equipment damage

Alerts you to situations where data can be lost or damaged,
equipment can be damaged, actions can result in service
interruption, and productive time can be lost.

ATTENTION Provides information essential to the completion of a
task.

Note: Describes the secondary results of procedures or commands, or special
conditions under which a procedure or command must be used.

18
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Preparing for maintenance activities

Introduction

Perform maintenance activities to ensure the proper functioning of your server
or to fix any problems that occur. Before you begin any maintenance activities,
collect the tools you need and follow recommended safety precautions.

This section discusses the tools and equipment required for performing
maintenance procedures in the field. Recommended safety precautions for
electrostatic discharge, handling cards, and handling your server are also
included.

Part 5: 1001rp Server Maintenance and Diagnostics 19
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Required tools and safety precautions

Introduction

If you need to replace or upgrade any system parts, follow Nortel Networks tools
and safety guidelines to prevent personal injury and damage to the server or
replacement parts

WARNING
& Risk of personal injury and equipment damage

Field maintenance must always be performed by fully
qualified, trained personnel.

Maintenance tools and materials checklist

Use this checklist for the tools and materials you need to perform maintenance
and diagnostics tasks.

Check |Description

Phillips cross-head screwdriver

Standard slot-head screwdriver (1/4" and 1/2")

Sidecutters

Jumper removal tool or needle nose pliers

Tape measure for determining cable lengths

Tweezers

Antistatic ESD wrist strap (recommended)

Pen or pencil for writing notes, cable lengths, and cable
identifications

Flashlight for examining interior of chassis

Cable tie wraps

20 CallPilot
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Check |Description

192)

Pen or pencil for noting cable lengths and labeling cable

Head-cleaning tape kit

Cable identification labels

Equipment log. This is used to record the model and serjal
number of the system, all installed options, and other
information.

Windows NT emergency disk. This contains the configuration
data for Windows NT.

Windows NT 4.0 Setup disks. The three disks are used for
reinstalling the operating system.

Microsoft DOS 6.20 disks. These three disks are used fg
reinstalling the operating system for maintenance and
diagnostics.

=

A package of blank disks.
Intel Ethernet LAN Adapter Driver disk

Keycode data. This governs what software features you will
be installing.

pcANYWHERE32 software. This will be used to allow
remote access by Nortel Networks service. It is on the MAS
2.0 Operating System CD-ROM.

RAID driver disk and configuration disk (optional)

Approved replacement parts

Before replacing any parts on your server, contact your Nortel Networks
customer support representative for a list of approved add-in boards and
peripheral devices. The use of non-approved replacement parts can cause serious
system problems or void your Nortel Networks warranty.

Part 5: 1001rp Server Maintenance and Diagnostics 21
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General safety

Nortel Networks recommends that you observe these safety guidelines as you
work on your server:

s Plug the computer and peripheral devices into properly grounded power
sources to prevent electric shock.

m  Use a surge protector or uninterruptible power supply to protect your
system from sudden increases and decreases in electrical power.

m  Ensure that nothing rests on your server's cables and that cables cannot be
tripped over or stepped on.

s Do not handle food or liquid around the server.
m Do not push any objects into the openings of your server.

Safety precautions for working with your server

Observe these safety guidelines before removing the top cover of your server:
1. Turn off all peripheral devices connected to the server.

2. Turn off the system by using the push-button on/off power switch. Unplug
the AC power cord from the system or wall outlet.

3. Label and disconnect all peripheral cables and all telecommunication lines
connected to the 1/0O connectors or ports on the back of the system.

4. Provide electrostatic discharge (ESD) protection by wearing an antistatic
wrist strap attached to the chassis ground of the system when handling
components. Attach your wrist strap to any unpainted metal surface.

Cooling and airflow

For proper cooling and airflow, always install the chassis top cover before
turning on the system. You risk damaging system parts if you operate the system
without the cover in place.

22 CallPilot
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Avoiding electrostatic discharge

Introduction

Electrostatic discharge (ESD) can seriously damage component parts such as
disk drives, boards, and other parts. Nortel Networks recommends that you
perform the maintenance procedures described in this section at an ESD
workstation.

Antistatic wrist strap

If an ESD workstation is not available, provide some ESD protection by wearing
an antistatic wrist strap. Ground the ESD wrist strap by attaching it to any
unpainted surface on your system chassis.

While you work
As you work inside the server, periodically touch an unpainted surface to
discharge any static your body might have accumulated.

Conductive foam padded in-boards

Expansion cards are extremely sensitive to ESD. After removing a card from its
protective wrapper or from the system, place it component-side up on a
conductive foam pad. If possible, use antistatic floor pads and workbench pads.

Part 5: 1001rp Server Maintenance and Diagnostics 23



About this guide Standard 1.0

Handling cards

Introduction

Electronic components are sensitive to the environment and to electrostatic
discharge. To protect equipment and prolong the useful life of components,
Nortel Networks recommends that you follow the precautions described below.

Avoiding electrostatic discharge

Electrostatic discharge (ESD) affects the performance and decreases the useful
life of system components. Use caution when handling Error Code Correction
(ECC) memory modules, SBC cards, and add-in boards to prevent damage.
Wear an ESD wrist strap when handling system parts.

Precautions for handling cards

Take these precautions with any procedure that includes an add-in board:

m  After removing a board from its protective wrapper or from the server,
place it component-side up on a grounded, static-free surface.

s Do not slide a board over any surface.
m Do not touch board components or gold-edge connectors on the board.
s Hold a board by the top edge, or by the side edges.

Installing boards

When installing boards on the server, remember the following details:
m  The backplane is flexible and supported with stand-offs.

m  Board slots resist connector insertion.

m  Firm, steady force seats a board in its slot properly.

m  Boards seat with friction followed by a solid stop.

m  External connector plates, attached to add-in boards, are seated in the rear
panel and secured with a screw.

24 CallPilot
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Handling hard disks

Introduction

Hard disks are extremely sensitive to vibration and physical shock. To protect
equipment and prolong the life of hard drives, Nortel Networks recommends the
following precautions.

Avoid vibration or physical shock

Hard disks are susceptible to even slight vibrations. A hard disk can be damaged
if it is placed on a table that is accidently knocked or moved. Use caution when
handling hard disks to prevent damage.

Precautions for handling hard disks

After removing a hard disk from its protective wrapper, or from the server, place
it on an antistatic, padded workbench or workstation to avoid movement or
jarring.

Shipping damage

If your hard disk is shipped independently for either an upgrade or a
replacement, note any dents or damage on the padded container and packaging.
Keep the container to prove that the part was damaged during shipping and
handling.

Remove hard drives

The drives are hot-swappable and can be removed without a system shutdown.

Store hard drives

If you purchase extra hard disks, store these hard disks in the original padded
container. Store the disks away from places where they might be moved or
jarred.

Part 5: 1001rp Server Maintenance and Diagnostics 25
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Handling CD-ROM disks

Introduction

When removing a CD-ROM disk from its protective case or loading a disk to a
drive, hold it by its center hole and outer edge. Avoid touching the disk’s data
surface (the non-labeled side).

To protect a disk against scratches and dirt when not in use, keep it in its
protective case.

To load a CD-ROM disk

1  Press the eject button on the CD-ROM drive to eject the disk tray.
2  Place the disk on the tray with its labeled side facing up.

3 Press the eject button or gently press the front of the disk tray to retract the
tray back into the drive.

To eject a CD-ROM disk
1 Press the eject button on the CD-ROM drive to eject the disk tray.

2 Remove the disk from the tray and put it in its protective case.

3  Press the eject button or gently press the front of the disk tray to retract the
tray back into the drive.

26 CallPilot
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Overview

Introduction

This chapter provides procedures for

= turning on the peripheral devices and the server, and verifying proper
startup. SeéStarting up the serveéon page 29

s shutting down the server if you need to install, reinstall, or replace hardware
components. Se&hutting down the serveon page 30

28 CallPilot
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Starting up the server

To turn on the system
1  Ensure the modem power switch is on.
2 Turn the monitor power switch on.
3 Press the server power switch on.
4

Observe the Power-On Self-Test (POST) and initialization messages as the
server starts.

Startup sequence

The following is the sequence for the server startup:

Stage |Description

1 POST messages appeatr.

SCSI (or RAID) initialization messages appear.

Allow selection of Windows NT/DOS.

Server boots to Windows NT and displays the logon screen.

Press Ctrl + Alt + Delete.

2
3
4 Server boots to DOS. Runs High Memory Test and PC Diags.
5
6
7

Log on as the administrator with the appropriate password

To interpret the POST beep codes that your CallPilot emits, réfateapreting
POST diagnostics” on page.38

Part 5: 1001rp Server Maintenance and Diagnostics 29
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Shutting down the server

Introduction

Any time you need to power down the server, follow the procedure in this
section.

To shutdown the server

1 Press the Ctrl, Alt, and Delete keys simultaneously.
Result: The Windows NT Security dialog box appears.
2 Select Shutdown.
Result: The Shutdown Computer dialog box appears.
3 Select Shutdown.
4 Click OK.

Result: The Shutdown Computer window displays the message It is
now safe to turn off your computer

a. You might be informed that an SQLAnywhere service is running with
connections, and asked if you want to end it.

b. Click Yes or End Task.

Result: You might also be asked if you want to save ACD proxy
changes.

c. Click No.

30 CallPilot
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Overview

Introduction

This chapter includes the following information:

Section A: “System diagnostics” on page 33 for running the confidence test

Section B: “Startup diagnostics” on page 35 for help in interpreting the
startup diagnostics on the 1001rp server

Section C: “Performing Windows NT online diagnostics” on page 47 to
help you use the run-time diagnostics provided by the Windows NT server
software

Section D: “Invoking and interpreting serial port diagnostics” on page 69
for running serial port diagnostics using the TSTERIO command

32
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Running the confidence test

Introduction

The following procedure and results are specific to the 1001rp server.

To run the confidence test

1 Power on the server and observe the front panel display.

Result: All LEDs on the panel illuminate for a few seconds. The green
power LED remains illuminated.

2 Observe the following server actions:

m Cooling fans on the front panel start up, and the red fault LED next to
each fan extinguishes.

= Drives spin up, and the amber hard drive activity LEDs over the front
panel display, extinguish, and then flash with activity.

m LEDs illuminate temporarily as the system checks the floppy drive, tape
drive, and CD-ROM drive.

m  The LED on each power supply lights up red as supply fans spin up and
components charge. LEDs turn green when the attached power supply
is fully operational.

3 Check the monitor as the server counts RAM and completes a Power-On
Self-Test (POST).

Result: A descriptive prompt appears on the monitor.

34 CallPilot
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Startup diagnostics overview

Introduction

This module contains procedures for interpreting the startup diagnostics on the
1001rp server.

Startup diagnostics are available only when you boot to DOS or when you first
install a system.

Startup diagnostic classes

Two classes of startup diagnostics are available on the server:

m  Power-On Self-Test (POST) diagnostics

m  SCSI controller diagnostics
or

»  RAID controller diagnostics

These diagnostics are available at initial system startup, or after any 1001rp
server reset.

36 CallPilot
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Power-On Self-Test diagnostics

Definition

The Power-On Self-Test (POST) is a system diagnostic program (stored in the
BIOS) that runs every time the 1001rp server is started. POST’s function is to
test system components and then display status messages.

POST message formats

POST reports on the system status in three ways:

m  POST beep codes

m  POST error codes and messages

s countdown codes displayed during normal BIOS POST

Part 5: 1001rp Server Maintenance and Diagnostics 37
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Interpreting POST diagnostics

Introduction

This section provides an explanation of the POST diagnostic codes.

POST beep codes

If an error occurs before video initialization, POST emits beep codes that
indicate errors in hardware, software, or firmware.

A beep code is a series of separate tones, each equal in length. Write down the
beep code sequence before calling Nortel Networks technical support.

ATTENTION _
Some POST beep codes are fatal and require that you
replace the SBC. See the table below for more
information about beep codes.
Beep sequence Error message and conditions
1-2-2-3 Checksum the BIOS.
1-3-1-1 Verify proper refresh operation.
1-3-4-1 Test the DRAM address lines.
1-3-4-3 Test the base memory.
1-4-1-1 Test lower memory.
2-1-2-3 Verify that the copyright message is intact.
2-2-3-1 Check for any pending hardware interrupts (there should be
none).
1-2 ROM checksum error; no/faulty video card. Initialize all ISA
and PCI option ROMs.
1 One short beep before boot.

Beep the speaker.
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POST error codes and messages

The BIOS indicates errors through POST by displaying a POST diagnostic code
on the screen.

The following chart lists the on-screen POST error codes and messages:

Beep code POST code Description / test point

1-1-1-3 02 Verify Real Mode

1-1-2-1 04 Get CPU type

1-1-2-3 06 Initialize System Hardware

1-1-3-1 08 Initialize chipset registers with initial POST values
1-1-3-2 09 Set in POST flag

1-1-3-3 0A Initialize CPU registers

1-1-4-1 oC Initialize cache to initial POST values

1-1-4-3 OE Initialize 1/0O

1-2-1-1 10 Initialize Power Management

1-2-1-2 11 Load alternate registers with initial POST values
1-2-1-3 12 Jump to UserPatchO

1-2-2-1 14 Initialize keyboard controller

1-2-2-3 16 BIOS ROM checksum

1-2-3-1 18 8254 timer initialization

1-2-3-3 1A 8237 DMA controller initialization

1-2-4-1 1C Reset Programmable Interrupt Controller
1-3-1-1 20 Test DRAM refresh

1-3-1-3 22 Test 8742 Keyboard controller

1-3-2-1 24 Set ES segment to register to 4 Gbytes
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Beep code POST code Description / test point

1-3-3-1 28 Autosize DRAM

1-3-3-3 2A Clear 512 kbytes base RAM

1-3-4-1 2C Test 512 base address lines

1-3-4-3 2E Test 512 kbytes base memory

1-4-1-3 32 Test CPU bus-clock frequency

1-4-2-1 34 CMOS RAM read/write failure (this commonly

indicates a problem on the ISA bus, such as a card
not seated correctly)

1-4-2-4 37 Reinitialize the chipset

1-4-3-1 38 Shadow system BIOS ROM

1-4-3-2 39 Reinitialize the cache

1-4-3-3 3A Autosize cache

1-4-4-1 3C Configure advanced chipset registers
1-4-4-2 3D Load alternate registers with CMOS values
2-1-1-1 40 Set Initial CPU speed

2-1-1-3 42 Initialize interrupt vectors

2-1-2-1 44 Initialize BIOS interrupts

2-1-2-3 46 Check ROM copyright notice

2-1-2-4 47 Initialize manager for PCI Options ROMs
2-1-3-1 48 Check video configuration against CMOS
2-1-3-2 49 Initialize PCI bus and devices

2-1-3-3 4A Initialize all video adapters in system
2-1-4-1 4C Shadow video BIOS ROM

2-1-4-3 4E Display copyright notice
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Beep code POST code Description / test point

2-2-1-1 50 Display CPU type and speed

2-2-1-3 52 Test keyboard

2-2-2-1 54 Set key click if enabled

2-2-2-3 56 Enable keyboard

2-2-3-1 58 Test for unexpected interrupts
2-2-3-3 5A Display prompt “Press F2 to enter SETUP”
2-2-4-1 5C Test RAM between 512 and 640 kbytes
2-3-1-1 60 Test expanded memory

2-3-1-3 62 Test extended memory address lines
2-3-2-1 64 Jump to UserPatchl

2-3-2-3 66 Configure advanced cache registers
2-3-3-1 68 Enable external and CPU caches
2-3-3-2 69 Initialize SMI handler

2-3-3-3 6A Display external cache size

2-3-4-1 6C Display shadow message

2-3-4-3 6E Display non-disposable segments
2-4-1-1 70 Display error messages

2-4-1-3 72 Check for configuration errors
2-4-2-1 74 Test real-time clock

2-4-2-3 76 Check for keyboard errors

2-4-4-1 7C Set up hardware interrupts vectors
2-4-4-3 7E Test coprocessor if present

3-1-1-1 80 Disable onboard 1/O ports
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Beep code POST code Description / test point

3-1-1-3 82 Detect and install external RS-232 ports

3-1-2-1 84 Detect and install external parallel ports

3-1-2-3 86 Reinitialize onboard 1/0 ports

3-1-3-1 88 Initialize BIOS Data Area

3-1-3-3 8A Initialize Extended BIOS Data Area

3-1-4-1 8C Initialize floppy controller

3-2-1-1 90 Initialize hard-disk controller

3-2-1-2 91 Initialize local-bus hard-disk controller

3-2-1-3 92 Jump to UserPatch2

3-2-2-1 94 Disable A20 address line

3-2-2-3 96 Clear huge Es segment register

3-2-3-1 98 Search for option ROMs

3-2-3-3 9A Shadow option ROMs

3-2-4-1 9C Set up Power Management

3-2-4-3 9E Enable hardware interrupts

3-3-1-1 A0 Set time of day

3-3-1-3 A2 Check key lock

3-3-3-1 A8 Erase F2 prompt

3-3-3-3 AA Scan for F2 key stroke

3-3-4-1 AC Enter SETUP

3-3-4-3 AE Clear in-POST flag

3-4-1-1 BO Check for errors

3-4-1-3 B2 POST done — prepare to boot operating system
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Beep code POST code Description / test point

3-4-2-1 B4 One beep

3-4-2-3 B6 Check password (optional)

3-4-3-1 B8 Clear global descriptor table

3-4-4-1 BC Clear parity checkers

3-4-4-3 BE Clear screen (optional)

3-4-4-4 BF Check virus and backup reminders

4-1-1-1 Co Try to boot with INT 19

4-2-1-1 DO Interrupt handler error

4-2-1-3 D2 Unknown interrupt error

4-2-2-1 D4 Pending interrupt error

4-2-2-3 D6 Initialize option ROM error

4-2-3-1 D8 Shutdown error

4-2-3-3 DA Extended Block Move

4-2-4-1 DC Shutdown 10 error

4-2-4-3 DE Keyboard Controller Failure (most likely problem
is with RAM or cache unless no video is present)

4-3-1-3 E2 Initialize the chipset

4-3-1-4 E3 Initialize refresh counter

4-3-2-1 E4 Check for Forced Flash

4-3-2-2 E5 Check HW status of ROM

4-3-2-3 E6 BIOS ROM is OK

4-3-2-4 E7 Do a complete RAM test

4-3-3-1 ES8 Do OEM initialization
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Beep code POST code Description / test point

4-3-3-2 E9 Initialize interrupt controller
4-3-3-3 EA Read in bootstrap code
4-3-3-4 EB Initialize all vectors

4-3-4-1 EC Boot the Flash program
4-3-4-2 ED Initialize the boot device
4-3-4-3 EE Boot code was read OK
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Interpreting startup diagnostics from SCSI
BIOS

Introduction

The results from the SCSI controller diagnostics appear after the POST results.

Applicable cards

Results of the startup diagnostics appear only if you have the following adapter
cards installed on your system:

m  Adaptec SCSI controller

The adapter is integrated in the SBC and can be disabled.
= Mylex RAID adapter

The RAID adapter is optional.
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Section C: Performing Windows NT
online diagnostics

In this section

Overview 48
Checking hardware using Windows NT 4.0 diagnostics 49
Invoking the chkdsk utility 53
Invoking and interpreting TCP/IP diagnostics 55
Invoking and interpreting Token Ring card diagnostics 67
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Overview

Introduction

This section outlines how to access the run-time online diagnostics provided by
the Windows NT server software.
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Checking hardware using Windows NT 4.0
diagnostics

Introduction

The Windows NT 4.0 system provides tools that can be used to diagnose and
debug system problems, including

m  Windows NT Diagnostics screen
m  Event Viewer

Windows NT Diagnostics window

The Windows NT 4.0 Diagnostics window allows you to view details
concerning the system and network components.

You can open the following tabs on the Diagnostics window to display specific

information:
= \ersion
s System
m  Display
s Drives

= Memory

m  Services

= Resources

s Environment
= Network
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Windows NT Diagnostics main window

ndows NT Diagnostics - \ADELGADOD
File Help

Resources | Environment | Metwark
Swztem I Dizplay I Drives I I emany

Microsoft [R] Windows NT [TH] Server
Yersion 4.0 (Build 1321: Service Pack 3)

%86 Uniprocessor Free
50370-111-1111111-76118

Riegistered to:
Martel
MNarthern T elecom

Eraperties Hefrest Fririt | ak I

To access Windows NT 4.0 diagnostic tools

1 Log on to Windows.

2  Select Start > Programs > Administrative Tools (Common) > Windows NT
Diagnostics to access the Windows NT Diagnostics window.

3 Select the appropriate tab on the Diagnostics main window to view
information concerning the system and network. Details available on each
tab are supplied in the following table:
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Select

To display details about

Version

Version
Registration

System

System identifier
HAL
BIOS information
Processors

Display

BIOS information
Adapter
Driver

Drives

Drives by type or letter

To view specific details, select a drive, and then p
Properties to view details for the drive, including s
labels, and so on.

Memory

Memory, including totals, physical and kernel
memory, commit charge, kernel

Services

Service and state for both services and devices

To view specific details, select a service, and ther
press Properties to view details, including pathna
dependencies, service flags, and so on.

Resources

Select one of the following buttons to display
information about the resources available on the
system:

IRQ

I/O Port
DMA
Memory
Devices
To view specific details, select a resource, and the

ress
ze,

me,

press Properties.
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Select To display details about

Environment | Variable and value for both system and local useyr

Network Select one of the following buttons to display
information about the network and components:

m General
m Transports
m Settings
m Statistics

Event Viewer

Windows NT 4.0 provides an Event Viewer that is used to view event logs to
assist in diagnosing and debugging system problems.

Three types of event logs are available from the Event Viewer, as follows:

System Logs events by Windows NT 4.0 components,
including RAS or other WIinNT services.

Security Logs security events, such as logons, logoffs,
illegal access, and so on. This option is available
only to users with Administrative access.

Applications Logs events by application, such as database file
errors, and so on.

To access the Event Viewer
1 Log on to Windows.
2  Select Start > Programs > Administrative Tools (Common) > Event Viewer.

3  Select the appropriate tab to view the associated event logs.
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Invoking the chkdsk utility

Introduction

The chkdsk utility checks a specified disk on the server and displays a status
report. Use this utility on drive C or D.

Note: A version of this utility, called autocheck, automatically runs at Windows
NT boot-time. Output from this utility appears on the start-up blue screen.

Chkdsk utility syntax
The chkdsk utility uses the following syntax:

chkdsk [drive:][path]filename] [/F] [/V] [/R]

Parameters  Description

[drive:] The drive letter of the drive you want to check.
filename The names of files to check for fragmentation.
IF Add this switch to fix errors on the disk.

v Add this switch to display the full pathname of

every file on the disk.

/IR Add this switch to locate bad sectors and to
recover readable information.

To run the chkdsk utility from Windows NT 4.0

1 Select Start > Programs > Command Prompt to display the MS-DOS
command prompt window.

Result: The MS-DOS Command Prompt window appears.

2 Atthe MS-DOS prompt, type chkdsk <drive letter:> (for example, chkdsk
).
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3  Press Enter.
Result: The system runs the chkdsk utility.
4  Type Exit to exit MS-DOS and return to Windows NT 4.0.
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Invoking and interpreting TCP/IP diagnostics

Introduction

This section outlines the following TCP/IP diagnostic tools available for the
Ethernet card. The first three tools are the most useful:

= ipconfig
= ping

= tracert
map

= nbtstat
= netstat

The ipconfig command

The ipconfig command displays IP configuration information.

Ipconfig default

Running the command without flags displays the IP address, subnet mask, and
default gateway for each adapter bound to TCP/IP.

Ipconfig command syntax

ipconfig /[]

The following flags are available for the ipconfig command:

Flag Description

? Displays Help information.

fall Displays full configuration information.

Irelease Releases the IP address for the specified
adapter.
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Flag Description
frenew Renews the IP address for the specified
adapter.

To run the ipconfig command from Windows NT 4.0

1  Select Start > Programs > Command Prompt to display the MS-DOS
command prompt window.

Result: The MS-DOS Command Prompt window appears.

2 Atthe MS-DOS prompt, type ipconfig <with appropriate parameters:>
(for example, ipconfig /all).

3 Press Enter.
Result: The system runs the ipconfig utility.

4  Type Exit to exit MS-DOS and return to Windows NT 4.0.
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The ping command

The ping command sends an echo request to a specified host.

Ping command syntax
The ping command uses the following syntax:

ping [-t] [-a] [-n count] [-] size] [-f] [-i TTL] [-v TOS]

[-r count] [-s count] [[-j host-list] | [-k host-list]]

[-w timeout] destination-list

send.

Parameters  Description

-t Pings the specified host until interrupted.
-a Resolves addresses to host names.

-n count Specifies the number of echo requests to
-l size Sends buffer size.

-f Set Don't Fragment flag in packet.

-i TTL Time To Live.

-v TOS Type Of Service.

-r count Record route for count hops.

-sS count Time stamp for count hops.

-j host-list Loose source route along host list.

-k host-list Strict source route along host list.

-w timeout Timeout in milliseconds to wait for each reply.
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To run the ping command from Windows NT 4.0

1 Select Start > Programs > Command Prompt to display the MS-DOS
command prompt window.

Result: The MS-DOS Command Prompt window appears.

2 Atthe MS-DOS prompt, type ping <destination IP address:>  (for
example, ping 47.286.32.0:).

3  Press Enter.
Result: The system indicates a successful ping.

4  Type Exit to exit MS-DOS and return to Windows NT 4.0.
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The tracert command

This utility determines the route taken to a destination.

How tracert works
The tracert utility follows several steps to complete its task:

Tracert sends Internet Control Message Protocol (ICMP) echo packets with
varying Time-To-Live (TTL) values to the destination.

Each router along the path must decrement the TTL on a packet by at least
1 before forwarding it, so the TTL is effectively a hop count.

When the TTL on a packet reaches 0, the router sends back an ICMP Time
Exceeded message to the source system.

Tracert determines the route by sending the first echo packet with a TTL of
1 and incrementing the TTL by 1 on each subsequent transmission until the
target responds, or the maximum TTL is reached.

Tracert then examines the ICMP Time Exceeded messages sent back by
intermediate routers.

Tracert syntax
tracert [-d] [-h maximum_hops] [-j host_list] [-w timeout] [target_name]

Tracert parameters
The tracert command uses the following parameters:

Parameter Description

-d

Specifies not to resolve addresses to
hostnames.

-h maximum_hops Specifies the maximum number of hops to

search for target.

-j host-list Specifies a loose source route along the
host list.
-w timeout Waits the number of milliseconds

specified by the timeout for each reply.
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Parameter Description

target_name The name of the target host.

To run the tracert command from Windows NT 4.0

1 Select Start > Programs > Command Prompt to display the MS-DOS
command prompt window.

Result: The MS-DOS Command Prompt window appears.
2 Atthe MS-DOS prompt, type
tracert [-d] [-h maximum_hops] [j host_list] [-w timeout] [target name]
(for example, tracert 47.286.0.32 210 47.236.0.04)
3  Press Enter.
Result: The system runs the tracert utility.

4  Type Exit to exit MS-DOS and return to Windows NT 4.0.
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The arp command

The arp command displays and modifies the IP-to-physical address translation
tables used by Address Resolution Protocol (arp).

Arp command syntax
The arp command uses the following syntax:

arp -s inet_addr eth_addr [if_addr]
arp -d inet_addr [if_addr]

arp -a [inet_addr] [-N if_addr]

Parameter Description

-a Displays current arp entries by interrogating
the current protocol data. If inet_addr is
specified, the IP and physical addresses for
only the specified computer appear. If more
than one network interface uses arp, entries for
each arp table appear.

-g Same as -a.
inet_addr Specifies an Internet address.
if _addr Specifies the Internet address of the interface

whose address translation table should be
modified. If not present, the first applicable
interface is used.

eth_addr Specifies a physical address.

-N if_addr Displays the arp entries for the network
interface specified by if _addr.

-d Deletes the host specified by inet_addr.

Part 5: 1001rp Server Maintenance and Diagnostics 61



Diagnostics Standard 1.0

-S Adds the host and associates the Internet
address inet_addr with the Physical address
eth_addr. The physical address is given as six
hexadecimal bytes separated by hyphens.|The
entry is permanent.

To run the arp command from Windows NT 4.0

1 Select Start > Programs > Command Prompt to display the MS-DOS
command prompt window.

Result: The MS-DOS Command Prompt window appears.

2 Atthe MS-DOS prompt, type arp with the required parameters (for
example, arp -g 47.286.0.32).

3 Press Enter.
Result: The system runs the arp command.
4  Type Exit to exit MS-DOS and return to Windows NT 4.0.
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The nbtstat command

The nbtstat command displays protocol statistics and current TCP/IP
connections using NBT. This command is available only if the TCP/IP protocol

is installed.

Nbtstat command syntax
The nbtstat command uses the following syntax:

nbtstat [-a remotename] [-A IP address] [-c] [-n] [-R] [-S] [-s] [interval]

Parameter

Description

-a remotenam

its name.

-A IP address

Lists the remote computer’s name table U
its IP address.

Lists the contents of the NetBIOS name c4
giving the IP address of each name.

Lists local NetBIOS names. Registered
indicates that the name is registered by
broadcast (Bnode) or WINS (other node

types).

Reloads the LMHOSTS file after purging a
names from the NetBIOS name cache.

networking name resolution. On a Window
NT computer configured to use WINS, this
option returns the number of names resolv
and registered through broadcast or throug
WINS.

Displays both client and server sessions,

Lists name resolution statistics for Windowss

listing the remote hosts by IP address only,

e Lists the remote computer's name table using

sing

che
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-S Displays both client and server sessions, and
attempts to convert the remote host IP address
to a name using the HOSTS file.

interval Displays selected statistics, pausing interval
seconds between each display. Press CTRL+C
to stop displaying statistics. Without this
parameter, nbtstat prints the current
configuration information once.

To run the nbtstat command from Windows NT 4.0

1 Select Start > Programs > Command Prompt to display the MS-DOS
command prompt window.

Result: The MS-DOS Command Prompt window appears.
2 Atthe MS-DOS prompt, type nbtstat with the required parameters.
3  Press Enter.

Result: The system runs the nbtstat utility.

4  Type Exit to exit MS-DOS and return to Windows NT 4.0.
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The netstat command

The netstat command displays current TCP/IP network connections and protocol

statistics.

Netstat command syntax
The netstat command uses the following syntax:

netstat [-a] [-e] [-n] [-S] [-p proto] [-f] [interval]

To run the netstat command from Windows NT 4.0

Parameter Description

-a Displays all connections and listening ports.

-e Displays Ethernet statistics. This can be
combined with the -s option.

-n Displays addresses and port numbers in
numerical form.

-S Displays per-protocol statistics.

-p proto Shows connections for the protocol specified
by proto. Proto can be tcp or udp. If used with
the -s option, proto can be tcp, udp, or ip.

-r Displays the contents of the routing table.

interval Redisplays selected statistics, pausing
between each display. Press CTRL+C to stop
redisplaying.

1 Select Start > Programs > Command Prompt to display the MS-DOS
command prompt window.

Result: The MS-DOS Command Prompt window appears.

2 Atthe MS-DOS prompt, type netstat with the required parameters.

3 Press Enter.

Result: The system runs the netstat utility.
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4  Type Exit to exit MS-DOS and return to Windows NT 4.0.
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Invoking and interpreting Token Ring card
diagnostics

Introduction

If TCP/IP protocol is installed, you can diagnose faults on the Token Ring card
by using the ping command under Windows NT.

Using the ping command

Instructions for using the ping command are in the proceéduareun the ping
command from Windows NT 4.@n page 58
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Section D: Invoking and interpreting
serial port diagnostics

In this section

Overview

Shutting down services

Conducting TSTSERIO tests

Conducting TSTSERIO tests with the loopback plug

B RREB
o N W - O

Restarting services
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Overview

Introduction

Run serial port diagnostics on the 1001rp server using the TSTSERIO
command. Direct the TSTSERIO command to serial ports on the server after
services on these ports have been shut down manually.
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Shutting down services

Introduction

Use the instructions in this section to shut down the services that are using the
serial port you want to test before you begin the TSTSERIO local loopback tests.

CAUTION
& Risk of communications loss

By stopping the services on COM 1 or COM 2, you lose the
support access feature.

CAUTION
& Risk of stopping call processing

By stopping the services on COM 2, you stop call
processing on CallPilot.

Services to stop for COM 1 testing
s Remote Access Server

Services to stop for COM 2 testing
s CallPilot SLEE
= MAS EMCI
m  MAS Notification Service
=  Remote Access Server

Net Stop command

Use the Net Stop command to stop a specified service on a serial port.
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NET STOP command syntax
The Net Stop command uses the following syntax:

net stop “[service-name]’

ATTENTION
You must restart the services that you shut down through
the Net Start command after running the diagnostic. For
details, see “Restarting services” on page 78.

To invoke the Net Stop command from Windows NT 4.0

1  Select Start > Programs > Command Prompt to display the MS-DOS
command prompt window.

Result: The MS-DOS Command Prompt window appears.

2  Atthe MS-DOS prompt, type net stop “[service name]”. For example, type
net stop “Remote Access Server.”

3  Press Enter.
Result: The system runs the net stop command utility.

4  Type Exit to exit MS-DOS and return to Windows NT 4.0.
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Conducting TSTSERIO tests

Introduction

The TSTSERIO command performs local loopback tests of the serial
communications ports from the 1001rp server run-time environment.

Note: Before conducting these tests, shut down services using the NET STOP
command detailed on page 71.

CAUTION
& Risk of communications loss

By stopping the services on COM 1 or COM 2, you lose the
support access feature.

CAUTION
& Risk of stopping call processing

By stopping the services on COM 2, you stop call
processing on CallPilot.

TSTSERIO command syntax
The syntax for the TSTSERIO command is as follows:

TSTSERIO [/?] /P:comport [/S:subtstname [/L:loops]

Flag Requirement Description
[?] n/a Displays Help.
/P:comport Required Specifies the symbolic port

name assigned to the port you
want to test.
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Flag Requirement Description
[/ Optional Specifies a TSTSERIO
S:subtstname] subtest. See the table on

below for a description of the
available subtests.

[/L:loops] Optional Specifies the number of times
(up to a maximum of 65 535)
to execute the requested test.
The default number of tests|is
1. A value of 0 infinitely
loops until you enter
CTRL+C.

TSTSERIO internal loopback diagnostic subtests

The following internal loopback subtests are available for the TSTSERIO
command. For each of these tests, the communications resource must be

available:

Subtest

name Description

idata Internal data bus loopback

imsr Internal modem status register

baud Internal data bus loopback at various baud
rates

word Test 5-, 6-, 7-, and 8-bit data lengths

stop Test 1, 1.5, and 2 stop bits

pari Test odd/even parity

fifo Test that device can operate in fifo mode
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To invoke the TSTSERIO /P command from Windows NT 4.0

1 Select Start > Programs > Command Prompt to display the MS-DOS
command prompt window.

Result: The MS-DOS Command Prompt window appears.

2  Atthe MS-DOS prompt, type tstserio with the required parameters. For
example, type TSTSERIO /P com1 or TSTSERIO /P com 2.

Press Enter.
4  Type Exit to exit MS-DOS and return to Windows NT 4.0.
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TSTSERIO external loopback plug subtests

The following external loopback subtests are available for the TSTSERIO
command. For each of these tests, an external loopback connector must be used.
For more information, see “Conducting TSTSERIO tests with the loopback

plug” on page 77.

Subtest
name

Description

edata

External data bus loopback. This test requires
an external loopback connector.

emsr

External modem status register. This test
requires an external loopback connector.

eint

Test ability of device to generate interrupts.
This test requires an external loopback
connector.

To invoke the TSTSERIO /S command from Windows NT 4.0

1 Select Start > Programs > Command Prompt to display the MS-DOS
command prompt window.

Result: The MS-DOS Command Prompt window appears.

2  Atthe MS-DOS prompt, type tstserio with the required parameters. For
example, type TSTSERIO /P com1 /S extr .

Press Enter.
4  Type Exit to exit MS-DOS and return to Windows NT 4.0.
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Conducting TSTSERIO tests with the loopback
plug

Introduction

The TSTSERIO command requires an external loopback connector plug for its
edata, emsr, and eint subtests.

9-pin connector plug

The standard serial loopback connector is a female 9-pin D-sub connector. This
connector has the following pins wired together:

m  CTS (pin 8) wired to (pin 7) RTS
s SIN (pin 2) wired to (pin 3) SOUT
s DTR (pin 4) wired to (pin 6) DSR

Once the plug is installed on the serial port, TSTSERIO can be invoked
according to the procedure outlined in the previous section.
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Restarting services

Introduction

This section details how to restart the services for COM 1 or COM 2 after
invoking the TSTSERIO local loopback tests.

Services to restart after COM 1 testing
s Remote Access Server

Services to restart after COM 2 testing
s CallPilot SLEE
= MAS EMCI
m  MAS Notification Service
= Remote Access Server

Net Start command

Use the NET START command to restart a specified service on a serial port.

NET START command syntax
The NET START command uses this syntax; net start “[service-name]”

To invoke the Net Start command from Windows NT 4.0

1  Select Start > Programs > Command Prompt to display the MS-DOS
command prompt window.

Result: The MS-DOS Command Prompt window appears.

2  Atthe MS-DOS prompt, type net start “[service name]”. For example, type
net start “Remote Access Server”.

Press Enter.

4 Type Exit to exit MS-DOS and return to Windows NT 4.0.
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Overview

Introduction

This chapter provides information on how to detect, isolate, and fix hardware
problems on the CallPilot server using the CallPilot Administration Client
software on the administrative PC.

m  The sectiorf Detecting, isolating, and fixing hardware probléms page
81 provides details on how to detect, isolate, and fix hardware problems.

= The sectiorf Working with the Maintenance windéwn page 9describes
how to use the Maintenance window as you detect, isolate, and fix
hardware problems.

Note: The components in the Maintenance window vary based on the type of
switch connected to CallPilot and the server type. The dialog box examples in
this chapter are for illustration purposes and might not appear exactly the same
on your system.
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Section A: Detecting, isolating, and
fixing hardware problems

In this section

Overview

Detecting hardware problems

Viewing events and isolating problems
Checking channel status

RRER
~N BN
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Overview

Introduction

This section provides guidelines on how to detect, isolate, and fix potential or
real hardware problems.

s “Detecting hardware probleihsn page 83rovides information on the
different ways in which you typically become aware of hardware problems.

= “Viewing events and isolating problefhmn page 84lescribes how to work
with the Alarm Monitor, Event Browser and Maintenance screen. These
tools are used to isolate the cause of problems and plan a strategy to fix
hardware problems.

s “Checking channel statusn page 8 ®escribes how to view channel status
in the Channel Monitor and Multimedia Monitor.

Component dependencies

The status of some components depend on the operational status of other
components. If a component fails or is stopped, the dependent components go
out of service.

Note: Based on the type of switch connected to CallPilot and the server type,
some of these components might not appear on your system.

Component Dependent components

SChus all MPBs, MPCs, and all Multimedia and Call channels
Master Timeswitch  all MPBs, MPCs, and all Multimedia and Call channels

Timeswitch all Multimedia and Call channels connected to the same
MPB as the timeswitch

MPC all multimedia channels on the MPC-8 card

DS30x all Call channels associated with that DS30x link cable
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Detecting hardware problems

Introduction

Typically, you first become aware of a hardware problem when an alarm is
raised. All hardware faults produce an alarm (or series of alarms, depending on
the problem) in the Alarm Monitor.

Note: By default, the Alarm Monitor appears on the screen as soon as an alarm
is raised. It does not appear if Alerting Off has been set in the CallPilot system
window. For more information on setting or resetting the alerting feature, refer
to theMonitoring and Security for the Administratguide.

Other indications of a hardware problem

Other indications of a hardware problem include the following:

user complaints

call processing difficulties, such as busy signals, static, dropped calls,
trouble connecting, and cross talk (hearing other conversations)

system administrator log on difficulties
alert icons on the Maintenance window

Part 5: 1001rp Server Maintenance and Diagnostics 83



Using the Administrative PC to diagnose the server Standard 1.0

Viewing events and isolating problems

Introduction

Use one of the following methods to isolate and plan a strategy to fix a hardware
problem:

m  Go to the Alarm Monitor to investigate one or more raised alarms.

m  Use the Event Browser to investigate a series of events that occurred around
the time an alarm was raised.

s Go to the Maintenance window to get status information for any suspect
components. For some components, you can use the Diagnostic tab of the
Maintenance window to run a diagnostic test.

Note: For detailed information on how to use the Alarm Monitor and Event

Browser (for example, how to set preferences), refer tMtirétoring and
Security for the Administratagguide

Using the Alarm Monitor

Each alarm in the Alarm Monitor has Help text that often provides a solution to
the problem. If the solution is not apparent, use the Event Browser or the
Maintenance screen to further investigate the problem.

£* Alarm Monitor - NTORI164 - Toronto Lab M= 3
File “iew Help
sl 7| | = ohe|
i Time Stamp | Event Code | Severity | Object ID | Instance | Diescription
Tuesday, August 25, 1998 94013 M 40752 I ajor Configuration Mgmt ... 0 Failed to communicate with
bonday, August 24, 1998 12:59.37 PM 44346 I ajor Maintenance Server 0 Time out tying to build insta
bonday, August 24, 1998 12:09.24 PM - 41504 I ajor Sustem Manager Ser..0 Internal eror in gervice nbbk
bonday, August 24, 1998 12:00043 PM - 40592 Critical Fault: NT Log Monitor 0 Ewent from MT System Log[
1 | i
Far mare information about an Event Code. double-click on the: itern in the list. |Active Alarms: Critical= 1 Major=3 Minar=0 [HUM 2
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To investigate using the Alarm Monitor

1 If the Alarm Monitor is not already visible, then in the CallPilot system
window, go to System Administration > Alarms and Events > Alarm Monitor.

2 Double-click the first critical or major alarm.
Result: The Help window appears.
View the description and recovery action.

4  Repeat steps 2 and 3 for a few more alarms.

5 If the solution to the problem is not apparent, obtain the return code of the
first event and continue the investigation by using the Event Browser (go to
“Using the Event Browser” on page 85).

Using the Event Browser

The Event Browser lets you view events that have been recorded in the server
log. The event listing can help you better determine the root cause of the
problem. Use the Event Browser to view the time the event occurred, the object
that generated the event, and the cause of the event.

¥® Event Browser - NTORI164 - Toronto Lab M= 3
File “iew Help
S|R| <) | 6 isted eventis) g| gﬁ”
Time Stamp Event Code i i
4 Alarm 5 U orce logout

Alarm S Fault: Mo... 0 Ewent from MT Spster

Alarm Set Critical Fault: MT Log Mo... 0 Ewent from MT Spster
Thursday, August 20, 1998 11:15...405592 Alarm Set Critical Fault: NT Log Mo... 0 Ewent from MT Spster
Thursday, August 20, 1998 11:13...405592 Alarm Set Critical Fault: NT Log Mo... 0 Ewent from MT Spster
Thursday, August 20, 1998 11:13...405592 Alarm Set Critical Fault: NT Log Mo... 0 Ewent from MT Spster
Monday, August 17, 1998 1:40:3... 40552 Alarm Set Critical Fault: NT Log Mo... 0 Ewent from MT Spster
Friday, &ugust OF, 1938 413:05 ... 41550 Alarm Set Critical Svs Manager Libr... 0 The 5M could naot stz
Friday, &ugust OF, 1938 4:08:31 ... 405532 Alarm Set Critical Fault: NT Log Mo... 0 Ewent from MT Spster
4] | i
Far mare information about an Event Code. double-click on the: itern in the list. UM %
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To investigate using the Event Browser

1

In the CallPilot system window, go to System Administration > Alarms and
Events > Event Browser.

Double-click an event that appears to be related to the problem, or an event
that occurred near the time the alarm was raised.

View the description and recovery action.
Repeat steps 2 and 3 for a few more events.

If the solution to the problem is not apparent, contact your distributor.

Using the Maintenance window

If you suspect or discover a problem with an MPC-8 card or the timeswitch, use
the Diagnostic tab of the Maintenance window. You can view the results of the
last diagnostic test run against the component. This produces a list of
components that might be causing the problem. A probability percentage is
listed with each component that reflects how probable it is that replacing the
component will fix the problem.

For information on using the Maintenance window to view the results of the last
diagnostic test, se&/iewing last diagnostic resulten page 113

For information on all aspects of the Maintenance windowSseéon B:
“Working with the Maintenance windginon page 91
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Checking channel status

Introduction

The Channel Monitor shows the status of call channels (the connection between
the server and the switch that carries the call signal to CallPilot).

The Multimedia Monitor shows the status of multimedia channels (the DSP
ports that process the call— these are the voice, fax, and speech recognition
channels).

The Channel Monitor and Multimedia Monitor also enable you to start, stop, or
courtesy stop channels. To run diagnostics on a channel, use the Maintenance
window.

Note: For detailed information on how to use the Channel Monitor and
Multimedia Monitor, refer to the online Help in the CallPilot system window, or
refer to theMonitoring and Security for the Administratguide
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To view call channel states

1 Inthe CallPilot system window, go to System Administration > Maintenance
Administration > Channel Monitor.

2 Double-click Channel Monitor.

Result: The Channel Monitor window appears, showing the state of all call

channels on the system. For an explanation of the channel states, refer to
the online Help.

% Channel Monitor - 47.152.171.131 - C:\CallPilot Administration Client

File “iew Help

sl @)

D530xChannels |01[02]03]04]0s]08 |07 Joafoa1af11]

Posmi_ [PPPPRETOOLY

@ D=302

|‘ Active ?Idle [J In Test T Loading [ MoResources g Mat Configured fﬂemote [ellow] Alarm
[

& OF Doty @ Remote OFf Dty W Dizabled J“Shutting [rowin L Power O %Local [Red) &larm

| el
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To view multimedia channels

1 Inthe CallPilot system window, go to System Administration > Maintenance

Administration > Multimedia Monitor.

2 Double-click Multimedia Monitor.

Result: The Multimedia Monitor window appears, showing the state of all
multimedia channels. For an explanation of the channel states, refer to the

online Help.

2 Multimedia Monitor - CP10005 - TorMAC
File “iew Help

Sl #s) @

DSPsiChanrels | 01 | 02 | 03 [ o4 [ 05 | o5 | 07 [ 08 |

Paf

? DsPd

o ta

$ Dsr2 i

L DpsP3 b Ea La La La Lw La la

|‘ Active ?Idle [J Ih Test T Loading [ Mo Resources .NotEonfigured

b ofDwy | Disabled L ShutingDown & Power Off

Ready ? |[2, 2] Vaice Idie

=
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Section B: Working with the
Maintenance window

In this section

Overview 92
Introducing the Maintenance window 93
Obtaining general information about components 101
Viewing component states 103
Starting and stopping components 106
Running integrated diagnostics 110
Viewing last diagnostic results 113
Obtaining replacement part numbers 116
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Overview

Introduction

Use the Maintenance window to do the following:

Obtain general information about components.

View component states.

Start and stop components.

Run integrated diagnostic tests.

View the results of the last diagnostic test run against a component.
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Introducing the Maintenance window

Introduction

All physical and logical hardware components are listed in the Maintenance
window tree. This tree shows how components relate to each other. For example,
eight multimedia channels exist as subcomponents for each MPC-8 card.

When you select a component in the Maintenance window, at least one of the
following tabs appear:

Tab

Description

General

Maintenance

Diagnostics

Replacement

This page shows general technical
information about the selected
component.

This page shows the state of the selected
component. You can also take some
components out of service from this page.

This page enables you to run component-
specific diagnostics.

This page shows replacement part
numbers for selected components. This
option is not available for all platforms.
Contact your distributor for latest part
number information.

Note: The components in the Maintenance window vary based on the type of
switch connected to CallPilot and the server type. The dialog box examples in
this chapter are for illustration purposes and might not appear exactly the same

on your system.
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The General tab

Use the General tab to view general information about components.

:.f Maintenance - CPi0017 - C:ACallPilot Administration Client
File “Wiew Help
2| = okl @)
=0 Disk Partition [E:) =
=0 Dizk Partition [F:) General | Maintenance I Diiagnostics I
=P Disk Partition [C:] o | Ve
E'Oubse 4 MPE ID 1
Syhnar . MPC DOS Device Mame DsP1
= Fhysical Container [1] MPC Type CE2
-BEll Motherboard MPC Load Yersion NG O24Z_
2=} Compact Disk Dirive [Z:] MPC channel capacity =}
== Hard Dizk Drive [Physicallrived)
= Hard Dizk Drive [Phwsicallirivel]
= Hard Dizk Drive [Phwsicallirivez]
53 Floppy Disk Drive [#:)
- B Tape Drive [TAPED)
=-f SC Bus (SCBUST)
=5 MFE [MTEUS1]
ES Time Switch [NTBUS1)
H IEMFC [DSP)
=) MPC [DSPZ)
=) MPC [DSP3)
& MPC [D5P4) ll 8L
+]- ] MPC [D5PE] —
. £ MPC (D33 | ;l_l
=
LI
For Help, press F1 MUM 2
Box Description
Attribute Shows component-specific general technical information.
Value Shows additional details, such as the speed of a selected

device.
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The Maintenance tab

Use the Maintenance tab to view the state of the highlighted component and to
start and stop a component before running a diagnostic test.

:.(J: Maintenance - CPi0017 - C:ACallPilot Administration Client

Fil=  “Wiew Help

5| =] oln| |

=0 Dizk Partition [E:] ;l -
=1 Dhizk Partition [F:) General : |
-A=0 Dizk Partition [C:] _
B Mouse State: [idle
g Kevboard ~ DM Details
= Physical Container [1] . .
ﬂ Matherboard Administrative: IUnIDcked

@ Compact Dizk Dirive [£:] Aueailability: |Flunning
~i=a Hard Dizk Drive [Phwsicallrivel]
~i=a Hard Dizk Drive [Phusicallrivel] Operational: |Enab|ed
~i=a Hard Dizk Diive [Phesicallnwe2]
-5 Floppy Disk Drive [4: Usage: idte
Lo B Tape Drive [TAPED)]
=-fE SC Bus [SCBUST)
=g MPE INTEUS1)
= Time Switch [NTBUS1] st | Counesy stop | Sz
=] MPC [DSPT)
i eshar [Channel [DSP1.1)
#a Channel [DSP1.2)
Adf Channel [DSP1.3)
]

Aar Channel [DSP1 .4 -
4| P oo Channel I _'I_I

— — Operations

Fawern s I Fowern Dowmn I

A

For Help, press F1 MUK
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Box
State

Administrative

Availability
Operational
Usage

Stop

Description
Specifies the state of the highlighted component.

This is a Desktop Management Interface (DMI) summary
state. You do not need this state.

This is a DMI summary state. You do not need this state.
This is a DMI summary state. You do not need this state.
This is a DMI summary state. You do not need this state.

Use this button to take the selected device out of service
immediately. All calls in progress are disconnected.

Caution:

For CallPilot servers connected to a Lucent, Mitel, or
Rolm switch, if you stop an individual call channel, the
corresponding port on the switch side is not automatically
disabled. As a result, calls can continue to land on the
stopped channel resulting in a Ring-No-Answer.

If you need to stop an individual channel, you have two

options:

m Busy-out the port on the switch side. This must be done
manually by the switch administrator.

m Courtesy stop the entire hunt group that contains the
call channel or courtesy stop all call channels in the
system.

This caution does not apply to stopping DSP ports.
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Box

Courtesy stop

Start

Power Up

Power Down

Description

Use this button to take the selected device out of service
after all calls are finished. This prevents any calls from
being disconnected.

Caution:

For CallPilot servers connected to a Lucent, Mitel, or
Rolm switch, if you stop an individual call channel, the
corresponding port on the switch side is not automatically
disabled. As a result, calls can continue to land on the
stopped channel resulting in a Ring-No-Answer.

If you need to stop an individual channel, you have two

options:

= Busy-out the port on the switch side. This must be done
manually by the switch administrator.

m Courtesy stop the entire hunt group that contains the
call channel or courtesy stop all call channels in the
system.

This caution does not apply to stopping DSP ports.
Use this button to put the selected device in service.

Use this button to power up an MPC-8 card that had been
powered down. You can only use this button for MPC-8
cards on a 200i server.

Use this button to power off an MPC-8 card prior to
replacing it. You can only use this button for MPC-8 cards
on a 200i server.
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The Diagnostics tab

Use the Diagnostics tab to run a diagnostic test or to view the results of the last
diagnostic test run on a component.

:,(45 Maintenance - CPi0017 - C:iCallPilot Administration Client

File  “iew Help

| 75| olx| ]|

=D Dizk Partitian [E:] =]
(=0 Disk Partition [F:] General I Maintenance ;|
= EISk Fartition [C:] List of Diagnostics for Selected Device:
----- ouze
Keyboard Diag... | Diag Description -
i =l
= Physical Container (1] Default Host Test Suite

Address bus integrity test
Drata busz integrity test

ﬂ Fotherboard
@ Compact Dizk Drive [£:]
=3 Hard Disk Drive [PhysicalDriven) h | B
~=a Hard Dizk Drive [PhysicalDrivel)
~=a Hard Dizk Drive [PhysicalDrive?)
=3 Floppy Disk Drive (4] Laat
i B Tape Diive [TAPED)
- 5C Bus [SCEUST) :
EIE MPE (NTEUST) Inztructiong:
- JEF Time Switch (NTEUST)
== |MPC [DSP1]
{ A% Channel [DSP1.1)
A% Channel [DSP1,2]
@ Channel [D5F1,3]

| M Channel DSP1.4] o
ol T | _*l_I

Stop

= L) M

-
Loy R Y T R

LDrezcription:

|2l
B O \_ \_

=
I
For Help, press F1 MUK - 2
Box Description
List of Diagnostics for Shows the diagnostic tests that are available for the
Selected Device highlighted component.
Run

Use this button to run the selected diagnostics. For the
Timeswitch and MPC components, go to the Maintenance

tab to courtesy stop the component before you run
diagnostics.

Stop Use this button to stop the selected diagnostics

98 CallPilot



May 2000 Using the Administrative PC to diagnose the server

Box Description

Last Result Use this button to view the results of the last diagnostic
test.
The results include a list of Field Replaceable Units
(FRU), which, if replaced, might fix the problem. Each
FRU is shown with a percentage that shows how probable
it is that the component caused the hardware problem.

Description Shows a comment or description for a selected diagnostic
test.

Instructions Shows the instructions for the user to run the diagnostic

test.
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The Replacement tab

The Replacement tab shows component part number information. This tab is not
available for all platforms. To be certain you have the latest component
information, contact your distributor.

:.(5 Maintenance - cpilDD? - D:\CallPilot Administration Client
File  Wiew Help

= = o Hl
@ Meridian Application Server = =
(=0 Disk Partition [[:] General | Maintenance
(=0 Disk Partition [C:] Description:
E::bs:ard 101 Enhanced Keyboard
=5 Phyzical Container [1]
E|E| tatherboard
@ Digk Contraller [Scsil:)
-2 Disk Contraller [Sesil:)
? F':rallelogéft EBI_[F'TFI:?I Manufacturer,  MNortel Netwarks
..... P ] ;
_____ V:SEES[EDIISPLAY‘I] Model Bevizion: Awailable
. 3?;:13 IBDIgS[D[]D] PartNumber:  WTRHE013 / ADBE3838
- F Serial Port [COM1) ) _
_____ # Serial Port [COM2) Technical Support LRL:
-8 MPC[DSP1) I=|
- MPC[DSP2) b
-{E] MPC[DSP3)
{65 Time Switch [NTELS1) (=
= Hard Disk Drive [PhysicalDrive0)
w2 DE304[1) =l
=l
=l
For Help. press F1 MUK 2
Box Description
Description Shows the name of the highlighted component.
Manufacturer Shows the manufacturer of the component.
Model Revision Shows the revision number for the component.
Part Number Shows the part number for the component.
Technical Support URL Shows a web site address where you can get technical
support.
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Obtaining general information about
components

Introduction

Find general technical information for each hardware component listed in the
tree using the General tab of the Maintenance window.

For a description of the General tab, $€be General tdton page 94

Type of technical information

Technical information about hardware components typically includes details
such as the following:

m the name, class, type, series, or version of a component
m various capabilities of a component (for example, the speed of a CPU)
m the available disk space
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Getting there  CallPilot system > System Administration > Maintenance
Administration > Maintenance

To view component details

1  From the left pane of the Maintenance window, select the hardware
component about which you want to obtain information.

Result: The General page appears with general information shown.

:.(J: Maintenance - CPi0017 - C:ACallPilot Administration Client
Fil=  “Wiew Help

=| | @l @l
=2 Disk Parlition [E:) =]
A=D1 Disk Partition [F:) General | Maintenance | Diagnostics |

A=0 Dizk Partition [C:]

Maouze h.-’:‘lll.::t'lEi;blu[tje | \:Ifalue
Feyboard

; ) MPC DOS Dewvice Mame D=1
= FPhysical Container [1] MPC Type CH2

Bl Motherboard MPC Load Wersion NE0242_
2=} Compact Dizk Drive [£:] MPC channel capacity g
-z=a Hard Dizk Drive [PhusicalDrivel]
-z=a Hard Dizk Drive [PhusicalDrivel]
-z=a Hard Dizk Drive [Phesicallive2]
= Floppy Disk Diive (4]
-8l Tape Drive [TAPED]
EI% SC Bus [SCEUST]

=G MPE INTEUST)
& Time Switch [NTEBUS1)

- [DSP1)

[DSPZ2)
[DSP3)
[D5P4) < |
[

-8 MPC [DSPE) =
<I s - _’l_l

A

For Help, press F1 MUM 2
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Viewing component states

Introduction

View a component’s state to determine the general condition of the component,
including whether the component is disabled or off duty. You can view the state

of components that are listed in the Maintenance tab of the Maintenance
window.

For a description of the Maintenance tab, ‘SE&e Maintenance tdlmn page
95.

Component states

The state of a hardware component changes depending on the following factors:

m  whether the component is currently involved in processing a call
m  whether a diagnostic test is being run on the component
m  whether the component is out of service

You can determine the state of a component by looking at the State field in the
Maintenance tab.

State Description

Active The component is working and currently involved in
processing a call.

Idle The component is working but not currently involved in
processing a call.

Uninstalled The component is not installed or properly configured. This

usually happens only when the system is being configured,
or if the database is corrupted.

Shutting Down  The component is in the process of stopping.

This state occurs quickly and is immediately followed by Off
Duty.
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State Description

Loading The component has been started, which takes it out of the
Off Duty state.

This state occurs quickly and is immediately followed by
Idle.

No resources The hardware required for the component to operate is not
installed or not operating properly.

Off duty The component has been stopped.

Remote Off Duty The component has been taken out of service at the switch.

Details

These states (Administrative, Availability, Operational, and Usage) are standard
Desktop Management Interface (DMI) states. They are shown for administrators
who understand and use the DMI standard in other aspects of their jobs. You do
not need to use the DMI states; the summary state listed in the State field is
provided instead.

Alert icons

If one of the following icons appears next to a component in the tree, the
component or one of its subcomponents is experiencing a problem:

Icon Description

This means that a diagnostic test run on the component has failed
x and the component has been placed into disabled status.

You must view the last results of the diagnostic test. See
“Viewing last diagnostic resuften page 113

This means that a problem exists with one of the component’s
@] subcomponents.

Expand the tree to locate the subcomponent with the problem.

104

CallPilot



May 2000 Using the Administrative PC to diagnose the server

Getting there cCallPilot system > System Administration > Maintenance Administration
> Maintenance

To view the state of a hardware component

1  From the left pane of the Maintenance window, select the hardware
component.

Result: The General page appears.
2 From the right pane, click the Maintenance tab.

Result: The Maintenance page appears.

:.(J: Maintenance - CPi0017 - C:ACallPilot Administration Client

Fil=  “Wiew Help

| 5| o] &

=1 Disk Partition (E:] =
=D Dizk Partition [F:) General
=0 Disgk Partition [C:]
Mouse State: |Id|e
i Keyboard —DMI Datails
7 ..E}IEC;LEEEZEBI ) Adriniztrative: IUnIocked

2=} Compact Dizk Drive [£:] Anailabiliby: IHunning
-=a Hard Disk Drive [Physicallrived]
-=a Hard Dizk Drive [PhusicalDrivel] Operational: |Enabled
-=a Hard Dizk Drive [PhusicalDrive2]
‘=3 Floppy Disk Drive [£:) Usage:
-~ B Tape Drive [TAPED]
=-f SC Bus [SCEBUST) = — (Openalisms

=S MPE [NTEUST)
S Tims Switch NTBUST) cior | Courtesystop | SlieE

=] MPC [DSF1)
i LAl Channel [DSF1.1

[idle

Fower E I Fovern e I

~Aa¢ Channel [DSP1.2
-8 Channel [D5P1.3

| M Charnel DSP14) o
4] _ | _>|_I

A

For Help, press F1 MUM - 2

3 View the state of the selected component in the State field.
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Starting and stopping components

Introduction

When you stop a component, it goes out of service and stops operating. You
must either stop or courtesy stop a component before you can run a diagnostic
test on it.

ATTENTION Nortel Networks recommends that you courtesy stop a

component if possible.

In the Maintenance window, the courtesy stop option is
available only at the individual channel level.

To courtesy down CallPilot, use the Multimedia Monitor to
courtesy stop all DSPs.

To courtesy stop a range of multimedia channels or all
multimedia channels on an MPC [DSP] card, use the
Multimedia Monitor. SeéChecking channel statusn page
87 for an overview of the Channel Monitor and Multimedia
Monitor.

When you start a channel, it goes back into service. You must start a channel
after replacing it, or after running a successful diagnostic test, to bring it back
into service.

Courtesy stop

A courtesy stop takes the component out of service only after the component has
finished processing the active call. If the component is currently processing a
call, the call is not dropped. If the component is not currently in use, it is taken
out of service immediately. This method is preferred over a regular stop.

Stop

A stop takes the component out of service immediately, regardless of whether
the component is currently processing calls. All active calls are dropped.
Typically, you perform a stop only when severe problems occur that are
affecting a large number of incoming calls, or if your organization determines a
special need for it.
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CAUTION
& Risk of Ring No Answer on disabled (stopped) call channel on

Lucent, Mitel, or Rolm systems

For CallPilot servers connected to a Lucent, Mitel, or Rolm
switch, if you stop an individual call channel, the corresponding
port on the switch side is not automatically disabled. As a result,
calls can continue to land on the stopped channel resulting in a
Ring-No-Answer.

If you need to stop an individual channel, you have two options:

m Busy-out the port on the switch side. This must be done
manually by the switch administrator.

m Courtesy stop the entire hunt group that contains the call
channel or courtesy stop all call channels in the system.

This caution does not apply to stopping DSP ports.

Components that can be started and stopped
This section lists components that can be started and stopped.

If you want to start or stop more than one or two multimedia or call channels,
use the Channels windows. S&&hecking channel statusn page 87or an
overview of the Channel Monitor and Multimedia Monitor. For detailed
information, refer to thdonitoring and Security for the Administratguide.

Note: Based on the type of switch connected to CallPilot and the server type,
some of these components do not appear or do not have the Stop option:

Component Effect of stopping

SChbus takes out of service all call processing
resources

Timeswitch takes out of service the MPB16 card that is

serviced by the timeswitch
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Component Effect of stopping

MPC-8 cards takes out of service the selected MPC-8
card

Multimedia (DSP) takes out of service the selected DSP

channels channel

Switch Interface Link takes out of service the selected link to the
(found under the Switchswitch
Interface Card

component)
Call channels takes out of service the selected call channel
DS30x link takes out of service the selected DS30x link
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Getting there cCallPilot system > System Administration > Maintenance Administration
> Maintenance

To start or stop a component in the Maintenance window

1  From the left pane of the Maintenance window, select the hardware
component you want to start or stop.

Result: The General page appears.
2 From the right pane, click the Maintenance tab.

Result: The Maintenance page appears.

:.(J: Maintenance - CPi0017 - C:ACallPilot Administration Client

Fil=  “Wiew Help

| 5| o] &

=1 Disk Partition (E:] =
=D Dizk Partition [F:) General
=0 Disgk Partition [C:]
Mouse State: |Id|e
i Keyboard —DMI Datails
7 ..E}IEC;LEEEZEBI ) Adriniztrative: IUnIocked

2=} Compact Dizk Drive [£:] Anailabiliby: IHunning
-=a Hard Disk Drive [Physicallrived]
-=a Hard Dizk Drive [PhusicalDrivel] Operational: |Enabled
-=a Hard Dizk Drive [PhusicalDrive2]
‘=3 Floppy Disk Drive [£:) Usage:
-~ B Tape Drive [TAPED]
=-f SC Bus [SCEBUST) = — (Openalisms

=S MPE [NTEUST)
S Tims Switch NTBUST) cior | Courtesystop | SlieE

=] MPC [DSF1)
i LAl Channel [DSF1.1

[idle

Fower E I Fovern e I

~Aa¢ Channel [DSP1.2
-8 Channel [D5P1.3

| M Charnel DSP14) o
4] _ | _>|_I

A

For Help, press F1 MUM - 2

3 Click Start, Courtesy Stop, or Stop.

Part 5: 1001rp Server Maintenance and Diagnostics 109



Using the Administrative PC to diagnose the server Standard 1.0

Running integrated diagnostics

Introduction

You should run diagnostic tests from the Diagnostic tab in the Maintenance
window in the following circumstances:

m  After installing or reinstalling a component, make sure it is operating
properly. (A component must be Off Duty [stopped] before you can run the
diagnostic test. S€&tarting and stopping components page 106§

m  Run the tests if the CallPilot server experiences trouble processing
incoming calls. Problems include static, dropped calls, and cross talk
(hearing another conversation).

Note: For a description of the Diagnostic tab, S€be Diagnostics tdlon page
98.

List of components that have diagnostic tests available
= MPC (DSPs)

s Timeswitch (depending on the switch type, diagnostics might not be
available)

To view available diagnostic tests

The available diagnostic tests for each component appear in the Diagnostic page
of the Maintenance window. Click a component to see the diagnostic tests
available for that component.

If a diagnostic test fails or cannot be run

If a warning box appears, the diagnostic test cannot be run because a prerequisite
condition has not been met. If a diagnostic test fails, the failure is indicated at the
bottom of the Diagnostic tab.
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In both cases, check the Alarm Monitor to determine the reason and the

appropriate action to take. (SHeetecting, isolating, and fixing hardware
problems$ on page 81

To run a diagnostic test

Note: See" Starting and stopping componénis page 106or details about

courtesy stopping a component. Nortel Networks recommends that you courtesy

stop rather than stop a component if possible.

1  From the left pane of the Maintenance window, select the hardware
component for which you want to run a diagnostic test.

2 From the right pane, click the Maintenance tab.
Result: The Maintenance page appears.

3  Stop the component.

4  From the right pane, click the Diagnostic tab.

Result: The Diagnostic page appears.

:.(J: Maintenance - CPi0017 - C:ACallPilot Administration Client

Fil=  “Wiew Help

| w5 @] |
=2 Disk Parlition [E:) =]
=3 Dizk Partition [F:) General I M aintenance
= E"Sk Fartition [C:] List of Diagnostics for Selected Device:
ouse = - —
Keuboard | Diag... | Diag Description
syhaar Default Host Test Suite
= FPhysical Container [1]

Address bus integrity test

- ﬂ Matherboard Drata bus integrity test

=) Compact Dizk Drive 23] Clomrt ol el roomopee s bk
~i=a Hard Dizk Drive [PhwsicalDrivel] J I L
~iz=a Hard Dizk Drive [PhusicalDrivel]
~iz=a Hard Dizk Diive [Physicalliive2]
--% Floppy Disk Drive [4:] =il
-8l Tape Drive [TAPED]
EI% SC Bus [SCEUST] .
= E MFE [MTELUS1] Instructions:
S Time Switch [NTEUS1)

EI :I MPC [DSP1)

H A Channel [DSP1.1

Stop

a0 =

Description:

Adp Channel [DSP1.2
A4 Channel [DSP1.3

- Charnel [DSP1.4
< T _>l_I

L

L

For Help, press F1

NUM 2
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5  Select the diagnostic test you want to run.
6  Click Run.

7  View the diagnostic test results at the bottom of the Diagnostic page.
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Viewing last diagnostic results

Introduction

If the Alarm Monitor and Event Browser do not provide a solution to a hardware
problem, a component might need to be replaced or serviced. If the problem
rests with a component that is not replaceable because it is not a physical entity
(such as the timeswitch), you must replace its parent component or contact
technical support, depending on the component.

Replaceable parts are called Field Replaceable Units (FRUs). View the last
diagnostic test result in the Diagnostic tab of the Maintenance window to obtain
a list of FRUs that, when replaced, will likely fix the problem.

Notes:

1. For general information on investigating hardware problems, see
“Detecting, isolating, and fixing hardware probléms page 81

2. For a description of the Diagnostic tab, $§€Be Diagnostics tdlon page
98.

Field replaceable units

When you view the last results of a failed diagnostic test, a Diagnostic Result
description appears at the bottom of the Diagnostic tab. This description
includes a list of components that might have caused the problem.

Each FRU is shown with a percentage that represents how probabile it is that the
component caused the hardware problem. Use these percentages as a guide to
determine which component to try replacing first; the higher the percentage of
probability, the better the chance that replacing the FRU will fix the problem.
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To view the last diagnostics result

1

4

From the left pane of the Maintenance window, select the hardware

component.

Result: The General page appears.

From the right pane, click the Diagnostics tab.

Result: The Diagnostics page appears.

Click Last Result.

Result: The results of the last diagnostic test appear at the bottom of the

Diagnostics page.

:.(E Maintenance - CPi0017 - C:\CallPilot Administration Client

File “iew Help

| 5 ol 5]

% Keyboard ;I

=] Physzical Container (1]
ﬂ Motherboard
@ Compact Dizk Drive [£:]
= Hard Disk Drive [PhysicalDrive0]
=2 Hard Disk Drive [PhysicalDrivel)]
= Hard Disk Drive [PhysicalDrive2]
=g Floppy Disk Drive (&)
- B Tape Drive [TAPED)
=-fi@ 5C Bus (SCBUST)

=G MPE NTBUS1)
& Time Switch [NTBUST)
= 1EMPC [DSF)
MPC [D5P2)
MPC [D5P3)
MPC [D5P4)

-3 MPC [DSPE) -
4 ; | B

Generall Maintenance Diagnostics |

List of Diagnostics for Selected Device:

Dizq... | Diag Description A| Bun |
1 Default Host Test Suite
2 Address bus intedrity test Stop
3 [rata bus integrity test - —I
A Clmrk alsmrmd remrmmen bmsb
« I _>l_I
Description:
Diza ID 1; Runs all the C52 DSP host based | Last Result
diagnostics. I_I
Instructions:

Selected device must be Off Duty, Disabled, or Mot ;I
Installed.

Diagnostics R esult

Last Diag Result

Target Object: MPC [DSF1]

Diag ID: 12

Diiag Fesul: Return Code = 0, Status = PASS

Faor Help, press F1

| v

=]
NOM

View the last results to determine what action to take.
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Last diagnostic results

The results of the last diagnostic test display the following information at the
bottom of the Diagnostic page:

Information Description
Target Object This is the component selected in the tree.
Diag ID This is the ID of the diagnostic test that was run.

The diagnostics IDs and descriptions are listed in
the List of Diagnostics for Selected Device
window on the Diagnostics page.

Diag result The diagnostic result includes a return code and
whether the diagnostic test passed or failed.

Result Description This section appears only when the diagnostic test
fails. This is a more detailed description of the
problem. This description includes the following:

= the error that was encountered

= a list of components that might have caused
the error with a probability percentage

m troubleshooting instructions
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Obtaining replacement part numbers

Introduction

If you determine that a component needs to be replaced, contact your distributor.

The Replacement tab in the Maintenance window provides component
information. However, your distributor has the latest part number information.
The Replacement tab is not available on all platforms.
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Overview

Introduction

The following table lists the CallPilot system utilities:

Diagnostic Enables CallPilot startup diagnostics to be
enabled or disabled (turned on or off).

PEP Maintenance Displays a list of installed PEPs and enables PEP
uninstall.

Services Monitor Displays the true status of all CallPilot services

according to WinNT definition.

Session Trace Provides detailed information about the activity
in a user's mailbox and the state of the message
waiting indicator (MWI).

System Information Displays particulars about the CallPilot System
such as names, keycodes, serial numbers, IP
addresses, and system numbers.

System Monitor Displays the status of all CallPilot subsystems
related to call processing.

VoiceBridge Monitor Troubleshooting tool that provides phone
simulation for the DSE connectivity.

Accessing the System Ultilities

All CallPilot customer administrator tools are accessible from the server using
Start > Programs > CallPilot > System Utilities.
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Diagnostics

Introduction

The Diagnostics startup utility is a graphical user interface that enables CallPilot
startup diagnostics to be enabled or disabled as required by the user or the
system.

CallPilot startup diagnostics automatically identifies hardware problems that
might exist when the system and its services are started (DSP, TimeSwitch,
SChus).

This tool saves time during system maintenance operations where restarts or
Call Processing services restarts are required.

There are three recommended steps:

m  Use the Diagnostics tool to turn off CallPilot startup diagnostics.

m  Perform system maintenance.

s Use the Diagnostics tool to turn on CallPilot startup diagnostics.
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To access the startup Diagnostic Tool utility

From the Windows Start menu, click Programs > CallPilot > System Utilities >
Diagnostic Tool.

Result: The Diagnostics Tool window appears.

i Diagnostics Tool
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To enable startup diagnostics

From the menu, select Configuration > EMCI Startup Diag > Enable.

ﬁ Diagnostics Tool

[TINEGN Edit  Wiew Help

EMCI Startup Diag  » M=
Dizable
il'his tool is used to eTianTe or disable ;I
diagnostics. Disabling the diagnositics

will prevent the system from identifying

any hardware problems {(e.g. D5P,
Timeswitch, 5CBus, Telephony Eoard)
automatically when the system and

service(s) are starting.

S|S0

To disable startup diagnostics
From the menu, select Configuration > EMCI Startup Diag > Disable.

Note: Nortel Networks recommends that you leave the startup diagnostics
turned on.

When you disable CallPilot startup diagnostics; you prevent CallPilot from
automatically identifying hardware problems that might exist when the system
and its services are started (DSP, TimeSwitch, SCbus).
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PEP Maintenance utility

Introduction

The PEP Maintenance utility displays a list of all installed PEPs on the server
and enables you to uninstall PEPS.

For information on uninstalling PEPs, refer to “Installing PEPs” on page 338.

To access the PEP Maintenance utility

From the Windows Start menu, click Programs > CallPilot > System Utilities >
PEP Maintenance.

The DMI Viewer window appears.

X DMI Viewer
| — Dkl comporent——————————
b anufacturer:

Rioot companent M43 Suite’
CallPilat Server
[i]- MAS Base

INDrteI Metworks

Product M ame:
ICaIIF‘iIc-t Server

Wergion:
|u1 07.07

Lazt Operation Time:
IApl 13,00 14:07.58

FEETwpE:

Thiz component is a software package

This component is part of the root
component

Thiz companent is present

= Eemove | Heagl

Show Suites |

122 CallPilot



May 2000

System utilities

To view a list of all installed PEPs

1
2

Click the component to display the PEP list.

Click Show PEPs.

Result: A list of all installed PEPs appears to the right of the window.

X DMI Viewer E

Foot component 'tMAS5 Baze'
iCallPilat Server ;

£ MAS 8051 Board Drriver

- a5 Backup and Restore

- MaS DSP Board Driver

- bAS HotPluggable Driver

- MAS [ntegrated User 2

- bAS MMFS

- MMAS Security Device Driver
- MAS Suite

- bAS Time Service

[N I s R s B e R B R B R A R e e |

H|
2
2]
H|
H-- MAS Middlewars
)
H|
H|
)
2]

- SOL Arywhere Patch

— DM| component
fManufacturer:

INorteI Metwork s

Product Marme:
ICaIIF'iIot Server

Wersion:
|n1 07.07

Last Operation Time:
[Apr13.00 14:07:58

FEE Tupe:

Thiz component iz a zoftware package

This component needs the root
companent

Thiz component iz present

ShowEEF’sI Hemawe I F!eagl

Show Suites I
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Services Monitor

Introduction

The Services Monitor is a graphical user interface tool that helps to determine
whether the CallPilot server is fully operational. It displays true states of the
CallPilot services according to Windows NT definition, including the states that
are not available through the control panel.

To access the Services Monitor

From the Windows Start menu, click Programs > CallPilot > System Utilities >
Service Monitor.

Result: The ServiceMon window appears.

& ServiceMon M=l

ISEHVICE_HUNNING

ISEHVIEE_HUNNING

ISEHVIEE_HUNNING

ISEHVICE_HUNNING

ISEHVICE_HUNNING

ISEHVIEE_HUNNING

ISEHVICE_HUNNING

ISEHVICE_HUNNING

ISEHVIEE_HUNNING

ISEHVICE_HUNNING

[P |

LD&P |

Adrit |

SLEE |

CallFilat Matification |
Backup Restore |
Configuration Manager |
EMLCI |

Ewent Scheduler |
Fault Manager |

ISEHVICE_HUNNING

ISEHVICE_HUNNING

ISEHVICE_HUNNING

ISEHVICE_HUNNING

ISEHVICE_HUNNING

ISEHVIEE_HUNNING

ISEHVIEE_HUNNING

ISEHVICE_HUNNING

ISEHVICE_HUNNING

ISEHVICE_HUNNING

ISEHVICE_HUNNING

|5 Seconds 'I
Set Refresh R ate |

ISEHWEE_HUNN'NG M4 ISEHVIEE—HUNNWG Maintenance Server |
ISEHVIEE_HUNNING MTA ISEHVIEE_HUNNING Wultimedia Cache |

Multimedia alume 1 |
Multimedia Yalume 2 |
Multimedia Yolume 3 |
OM_Server |
Security |
Draeman |

M anager |
Startup Server |
System Info |
Time |

MAS W atification |

Refresh Al |
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Using the Services Monitor

The Services Monitor provides the status of each CallPilot service (for example,
running, any pending or pausing state).

The Refresh All button enables the display to be refreshed. Use the Set Refresh
Rate button to set the rate of refresh or set to none.

Note: The fact that a service is running does not necessarily mean that it is fully
operational. It might require some initialization, database connections, internal
data structures, and so on.
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Session Trace

Introduction

The Session Trace tool allows you to obtain detailed information about the
activity in a user’s mailbox and the state of the message waiting indicator
(MW1). The session information includes

m Vvoice messaging
s call answering

m  express messaging activity (messages composed and sent, or left in a
mailbox)

s the number of messages played or unplayed at the beginning, middle, and
end of a session

m  messages and personal distribution lists restored into a mailbox
m the last change to the MWI (turned on or off, or untouched)

This session information allows an administrator or technician to study the state
of a user’'s mailbox and the MWI, and to use that information to follow up on

any user complaints. For example, a user might complain that the MWI was on,
but no voice messages were in the mailbox when the user logged on. The session
information might tell the administrator why the MWI was turned on.

To access the session trace tool

From the Windows Start menu, click Programs > CallPilot > System Utilities >
Session Trace Tool.

Result: The MCE Session Trace window appears.
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To find a session

1 From the Session Type drop-down menu, select the type of session.

Session Type: |Expired Messages j

Last Mame: f "
WEng

First Mame: | E*pired Meszages
Express Meszaging
Mailbox Mumber: |Logon
b
Called Dd: | Selective Restare

Calling D: |
Start Date & Time: |4£25£99 11:55:15 AM @
End Date & Time: |4£25mn 11:55:15 &M @

Last Search Time:  11:55:47 AM

To display a list of all session types, select All Session Types.

2 Enter as much information in the search criteria fields in the window to
identify the session you want to view.

To display a list of all users for the selected Session Type, leave the search
criteria fields blank.

3 Click Search to initiate the search.

a. If you did not enter any user information, a list of users matching the
Session Type appears on the bottom of the window.

To select a user from the list, double-click the user name to display
session type information.

b. If you selected All Session Types for a user, the session type
information appears to the right of the window.

4 Double-click the session type to display the session information.

Result: The Session Type information appears on the bottom of the
window.
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Session type information

Call Answer session type information

3 MCE Session Trace [ [5]
Filz  ‘iew Help

| 2]

Session Type | Start Time | End Time | -
Session Type: |4l Session Types =l [ Logon 0K TEI7 14 Apr 28 153540 Apr 28
Last Mame: IEIint T Wl Off 153041 Apr 28 153841 Apr 28
: - mLogon ok 15:39:40 Apr 28 15:40:09 Apr 28
Frst Name: [Bil 5 M Of 16401040 28 154010 Apr 28
Mailbax Mumber: IBU5U ring 15:42:30 Apr 28 15:42:40 Apr 28
: @ Ml On 1542404028 1542:40 Apr 28
Caled N: | (i Logon 0K 154247 Apr 28 15,4356 Apr 28
2 Logon c42: I 143 pr
Calling DM I @ befi'l CEF 154317 dpr28 194311 Apr 28
Stat Date & Tine: [F12/38 112315 @ @ ww Of . 154357 4pr 28 154357 Apr 28
'2d Call Answering 154648 bpr 28 1H4ER3 Apr 28
EndDate & Time: [5/2/00 11:2315 M @ § Wl On 165624 Ap 28 16:56:20 At 28

) @ k'l On 01:3013 Apr29  01:30:13 Apr 29
SN AR B EvpiedMessages (3300350129 (330030028 o |

Session Type: Call Anzwering I

Start Time: 15:42:30 Apr 28 tessage Length: 1 second
End Time: 14240 Apr 23 Mezzage Digposition; Meszage left
Sezsion Length: 10 seconds
Called DM: 8050
Calling DM: 8051

Call Qrigination: Inbound

43 records found [ [NOM
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Expired messages session type information

3, MCE Session Trace

File Wiew Help

M[E E3

4 2|

_ Session Type | Start Time | End Time | -
Session Type: |4l Session Types = P Lagon 0K TRITT4Ap 28 153040 Apr 26
Last Mame: IEIint @‘ b1 Off 1503841 Apr 28 15:38:47 Apr 28
First Name: [B1 mLognn 0K 153940 Apr 28 15:40:09 Apr 28
st Name:[B 0 M O TRA0T0AD 28 15:40:10 Apr 26
Mailbes Murber: |8050 1! Call Answering 154230 Apr 28 15:42:40 Apr 28
Caled DN: I @ v On 15:42:40 4pr 28 15:42:40 Apr 28
: EﬁLogun 0k 1hd4247 dpr 28 15:43:56 Apr 28
Caliing DM: I @' hefi] OIFF 154377 Apr 28 154317 Apr 28
Start Date & Time: I5.-"2.-"99'|'|:23:'|5AM @ C_@' hefi] OIfF 104357 dpr 28 15:43:67 Apr 2a
\&f Call Answering 15:46:48 Apr 28 15:46:53 Apr 28
End Date & Time: |5!2a’DU‘|‘I:23:15AM @ BEE24 A0 28 165624 Apr 26
013013 Apr 29 01:30:13 Apr 29
S El S R 033009 AE: 29 033009 ,*.\E: 23 o
Seszion Type: Ewpired Meszages |
Date dnd Time:  03:30:09 dpr 29
Mezzages Deleted: 0
43 records found MM
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Express messaging session type information

———————
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3, MCE Session Trace [_[C]
File “iew Help
| 2
_ - Session Type Start Time End Time -
Session Type: |4l Session Types [ 7§ Logon K 153714 Apr 28 15:38:40 Apr 28
Last Mame: |Elint 8 Ml OIfF 15:38:41 Apr 28 15:38:41 Apr 28
Eirst Name: [Bil EE,Logon QK 153340 Apr 28 15:40:03 Apr 28
ot Hame: [Ei T M| Off 15401040 28 15:40:10 Apr 23
Mailbox Mumber: |SD5D 15 Call Arsweting 15:42:30 Apr 28 1%:42:40 Apr 28
Called DN: | @ M On 15:42:404pr 28 15:42:40 Apr 28
: & 15:42:47 4pr 28 154356 4pr 28
Calling DM: | @ b OfF 154377 Apr 28 1504377 Apr 28
Start D ate & Time: |5£2£99 11:2315 AM @ @_ bl Off _ 154357 Apr 28 15:43:57 Apr 28
: — \f Call &nswering 1504648 Apr 28 154653 Apr 28
End Date & Time: [5/2/00 11:23 15 4h @ @ Mwl On 165624 Apr 28 16:56:24 Apr 28
) @ ksl O 01:3013 Apr 29 07:30:13 Apr 29
- 11:26: Search
Last Search Time:  11:26:30 AM Evpiied Messages  0330094p1 29 133009Am 29 |
Session Type: Lagon 0K Start OF Session During Seszion
Start Time: 15:42:47 Apr 28 Session Length: B3 seconds Total Msgs: 1 New Fl.ead: 1
End Time: 15:43:56 Apr 28 Call Originatior: Inbound U ez © et L
Caled DN: 3751 End Of Seszion
Calling DN: - 8051 Tuotal Mzgz: O Unread Mzgs: 0
Message Lenaths [Seconds] Sn?nt: 0 Composed: 0
i Tk total Replied: 0 Forwarded: 0
Voice: 0 ] ] Tirne Delivered: 0 Total Deleted: 1
Fax: 1 1 1 Mew Deleted: 0
43 recards found MUM
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Selective restore session type information
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System Information

Introduction

Use this utility to view particulars about the CallPilot system, such as names,
keycodes, serial numbers, IP addresses, and system numbers.

To access the System Information utility

From the Windows Start menu, choose Programs > CallPilot > System Utilities >
System Information.

Result: The CallPilot System Information window appears.

? CallPilot System Information

| CallPilot Release 01.07.03
| Serial #1111
| Feycode E2T'W TCEE 9205 0WRD 4kDD KP4D 8011

Hardware Platform IPE
Operating System WINNT
Switch Type M1
Connectivity Mechanism Proprietary CTI
Number of MPUs 24
Number of Yoice Channels 12
Number of Fax Channels P
Mumber of Speech Activated Channels 2
Hours of Storage 100
Mumber of Prompt Languages b
Mumber of Speech Recognition Languages 3
AppBuilder Fax Yes
Metworking Yes
NMS Yes
Mumber of Yoice Messaging Seats 1000
Mumber of Fax Messaging Seats 1000
Mumber of Desktop Messaging Seals 1000
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To use the System Information utility
Use this utility to view CallPilot system information at a glance.

After viewing the information on this screen, click Close to close the window.
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System Monitor

Introduction

The System Monitor is a graphical user interface based tool that provides a
single point of view of CallPilot call processing status at any time. The status
provided reflects the true internal status of the Call Processing subsystem,
including all related call processing components. This eliminates the need to use
multiple tools to get the same information.

The System Monitor queries the current status of each component it is
monitoring and displays them in a graphical user interface. The status of each
service is obtained from the Windows NT Service Controller; Middleware
Components status are obtained from the CT Media server; and the DSP and
Call channels status are obtained by querying Middleware.

This tool shows the status of

m  CallPilot Critical Services related to call processing
m  CT Media-based Middleware Services

m  CallPilot Call Channels and Media Channels

System Monitor is a nondestructive tool that does not alter the behavior of any
CallPilot components.

Note: Users of this tool require an understanding of CallPilot and the
components they want to monitor.
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To access the System Monitor

From the Windows Start menu, click Programs > CallPilot > System Utilities >
System Monitor.

Result: The CallPilot System Monitor window appears.

CallPilot System Monitor =]

File FRefresh Rate Help

| status ||

Nortel Hetworks

User interface

The user interface comprises four main areas listed below. Each area indicates
the status of the particular components of the CallPilot server.

1. Services Area for Critical Windows NT-based services
2. CT Media Services Area for Middleware-based services
3. Call Channel Area for Call Arrival/Departure activities

4. Media Channel Area for DSP channel usage activities
CallPilot Critical Services

Critical Services needed for CallPilot Call Processing include

s CT Media Server Service
m  Telephony Server (TAPI) Service
s MAS EMCI Service
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m  MAS Notification Service

m  MCE SLEE Service

»  MCE Notification Service

m  SQL Anywhere Service

s VBPC Load Service (useful in a DSE system)

CT Media-based Middleware Services
Middleware resources needed for CallPilot include
m Dialogic CT Media Server Core Service

m Dialogic CT Media Server ISE Service

m  Call Channel Resource Service

m  Blue Call Router Service

m  Media Resource Service

m  Maintenance Service Provider Service

CallPilot Call Channels and Media Channels
Call and media channels needed for CallPilot include

m  Multimedia Ports and Call Channel (DSP channel usage as well as Call
Channel usage)

Online Help
To obtain a description of the various status codes for each of the window's
components, use the online Help.

Menu items
The System Monitor tool provides several menu items for configuration:

File Closes the tool.

Refresh rate Changes the refresh rate to a desired level.

Help Displays a legend for each status symbol
shown.
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VoiceBridge Monitor

Introduction

The VoiceBridge Monitor is a graphical user interface tool that provides help
when the CallPilot DSE system is first configured by simulating a phoneset.

It can also be used to troubleshoot phoneset, line, cable, or switch-related
problems should they occur.

The simulated phoneset provides the ability to

m answer an incoming call

= make an outbound call

m transfer an incoming call to another extension
m display dialed party extension

m  show the carrier presence on the phoneset

m  show other characteristics specific to the phoneset being simulated, such as
time of day and other features programmed on the phoneset

Note: This tool is for DSE only. Users require an understanding of switches
involved in DSE connectivity.
Installing VoiceBridge Monitor

The VoiceBridge Monitor can be installed from the CallPilot Server PEP CD.
For information on installing VoiceBridge Monitor, refer to “Installing software
for the Lucent, Mitel, and Rolm switch” on page 348.

It takes approximately three minutes to install this tool and requires a system
restart.
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To access VoiceBridge Monitor

Click Start > Programs > VoiceBridge 2000 > VoiceBridge Monitor.

ATTENTION Do not use this tool when CallPilot is in use as it
can affect CallPilot operation. When this tool is
connected to an external phoneset, you cannot
hear on the soft phoneset.

Using the VoiceBridge Monitor

Once executed, the VoiceBridge Monitor tool appears.

w1z WoiceBridge Monitor - NORTEL
File “iew Mode Help

0O =z
- | =0 ] ~

For Help, press F1 | Active PC Phone 4

Menu items
The VoiceBridge Monitor tool includes several menu items for configuration:

Mode menu Allows for the selection of a different mode of
operation. Only active mode is used with this tool in
DSE connectivity.

File menu Allows for the selection of a preferred channel for
monitoring. Some channels can be opened.

Use the mode menu to select Active PC Phone mode.
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Note: Nortel Networks recommends that you do not use other modes, as they
require additional hardware components to function.

Once the Active PC Phone mode is selected, you can open any or all channels of
the VoiceBridge boards from the File menu and view them, as shown below:

Channel Humber EE

Cancel |

I.I— Enter channels to open.
[e.a. 9or1-8 ar 3,6,8)

Using soft phones

The soft phone is connected to the VoiceBridge 2000 board installed on the
CallPilot system and can be considered a physical phoneset. Actions that can be
done with a soft phone include

m checking if a carrier exists between the phoneset and the switch

m  making a call to the physical phoneset and viewing the phoneset or the DN
that is assigned to this CallPilot port

m making a call from a physical phoneset to this soft phone to check if the call
shows up on the soft phone

m  making a call from a physical phoneset to this phoneset and transferring it
to another physical phoneset to see if transfer is possible with CallPilot
ports

Soft phone displays
The display of the soft phone varies depending on the switch to which the
CallPilot server is connected.
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Rolm phone
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Mitel phone

w15 WoiceBrnidge Monitor - [MITEL Channel 1 ==H0 CARRIER=~]

File View Mode ‘Window Help =18 x|
o] 22
: s e

!0 CRRRIER! !!! - Channsl 1

Mie )

Fal Op Y

Tol Down )

Mo Carrier |&ctive PC Phone W
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Lucent 8400
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Chapter 6

Performing hardware maintenance

In this chapter

Section A: Chassis components 149
About the 1001rp server chassis 150
Removing the chassis cover 151
Removing and replacing the front bezel 152
Replacing air filters 155
Replacing hot-swappable components 157
Replacing the fuse 163
Alarm board 166
Jumpers on the alarm board 168
Status display 170
Section B: RAID system 171
Overview 172
RAID system summary 173
Replacing the RAID card 174
Attaching cables to the RAID card 176
Replacing and configuring hard drives 179
Configuring hard disk drives 182
Rebuilding a hard disk in RAID 184
Maintaining RAID hard drives 188
Section C: Device settings 189
Overview 19
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Pentium 1l or Il slot assignments

IRQ mapping table

Section D: Video card

Overview

Troubleshooting the video card

Replacing the video card

Section E: Optional cards

_Overview

Replacing ELAN cards

Replacing Ethernet CLAN cards

Replacing Token Ring CLAN cards
Section F: The Pentium Il SBC card
The Pentium Il SBC card

Replacing the Pentium Il SBC card
Upgrading the BIOS

Dual Inline Memory Modules
Section G: The Pentium Il SBC card
The Pentium Il SBC card

Replacing the Pentium Ill SBC card
Upgrading the BIOS

Dual Inline Memory Modules

Section H: Adding and replacing switch-specific boards and cards
Replacing MPB16 boards
Adding a VoiceBridge 2000 card

Replacing the VoiceBridge 2000 card
Replacing the DT1/480SC board

Section |: Media drive bay

About the media drive bay
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Removing drive carriers from the media drive bay
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~

Replacing a drive in the media bay
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Section A: Chassis components

In this section

About the 1001rp server chassis 150
Removing the chassis cover 151
Removing and replacing the front bezel 152
Replacing air filters 155
Replacing hot-swappable components 157
Replacing the fuse 163
Alarm board 166
Jumpers on the alarm board 168
Status display 170
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About the 1001rp server chassis

Introduction

This section describes procedures for handling and replacing chassis
components on the 1001rp server.

Replacing components

Procedures covered include the following:

removing covers

replacing the air filter

replacing a power supply module
replacing a cooling fan

replacing SCSI hard drives
replacing the fuse

replacing the status board
replacing the panel display
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Removing the chassis cover

Introduction

Access the 7 ISA/1 SBC/12 PCI Slot passive backplane for performing any
maintenance activities by removing the cover.

Requirements

Before removing the cover, gather the following tools:

s flat-blade screwdriver
m  antistatic wrist strap

To remove the top cover

CAUTION
& Risk of equipment damage

Take precautions to protect internal components.
Electrostatic discharge (ESD) can render boards damaged
or unusable. Wear an ESD wrist strap.

DANGER
A Risk of electric shock

High current inside the chassis can cause severe injury.

1  Power down the server and disconnect all power cords.
2 Loosen the three thumbscrews at the rear of the top cover.

3 Remove the top cover by pulling the cover toward the rear of the chassis,
and then lifting it up and off.
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Removing and replacing the front bezel

Introduction

Two locked doors on the plastic front bezel enable you to access the external
peripheral bay, SCA disk drives, 3.5-inch floppy drive, and removable cooling
fans. Use the following procedures to remove and replace the front bezel before
replacing other system components.

Doors on the front bezel

Requirements

To remove the front bezel, you require the following tools:

m  keys to the front bezel
m  antistatic wrist strap
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The front bezel

To remove the bezel

CAUTION
& Risk of equipment damage

Do not attempt to move or lift the server before removing
the front bezel; the server might disengage from the bezel
and fall.

1  Unlock and open the double doors of the front bezel.
2 Firmly grasp the bezel by the hand-holds at either side of the chassis.

3 Pull the bezel from the chassis.

What's next?

Once the front bezel is removed, you can change the air filters or replace a hot-
swappable cooling fan. The procedures for each of these tasks are located in this
section.
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Ball stud on the faceplate

Groove on the bezel

To replace the bezel
Once you complete maintenance or part replacement activities, to replace the
front bezel, follow these steps.
1  Align the front bezel with the ball studs located at each faceplate corner.
2 Apply pressure evenly until the bezel snaps onto each ball stud.

3  Close the double doors of the front bezel and lock it into place.
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Replacing air filters

Introduction

Remove and clean air filters every six months in clean environments and every
three months in industrial or dirty environments to ensure your server cools and
functions properly. If they appear to be damaged or become inefficient, replace
the filters.

Locating the air filters

There are four air filters on the 1001rp server — one inside each of the two doors
of the front bezel, and two on the top half of the front bezel. They are made of
polyester foam material and are flame retardant.

Requirements

You require the following equipment to replace air filters:

m the customer’s chassis keys

To replace the front bezel air filter
1 Remove the front bezel from the chassis.
2 Pullfilters from the Velcro strips securing them to the bezel.

3 Replace the filter by seating new filter pads evenly over the velcro strips
and securing them.

4 Install and lock the front bezel on the chassis.

See also

To remove the air filter, remove the front bezel. Refer to the procedures for
“Removing and replacing the front bezel” in this section.
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To replace the door air filter

1
2

Unlock and open the front doors.

The air filter is trapped between the inside of the door and the wire. The
wire pivots near the key lock. Pull the wire away from the key lock to free the

air filter.

Remove and replace the air filter.

Pivot the wire to trap the filter, ensuring that the ends of the wires are

pinched inside the door.

Close and lock the doors.
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Replacing hot-swappable components

Introduction

If your system experiences problems with the cooling fan, hard drives, or the
power supply, replace these parts without shutting down the server. These hot-
swappable components enable you to leave the server on and operational while
you replace redundant components.

Note: You require a RAID card to replace hard disks without shutting down the
system.

System monitors

The chassis incorporates on-board management features that notify the operator
in case of a problem. Power supply, fan, and chassis temperature status are
constantly monitored. In the event of a failure, an alarm sounds and the
appropriate LED on the front panel turns on as an indication. The LED on the
failed power supply module turns from green to red.

Hot-swappable components

The following components are easily hot-swapped:
= power supplies

m cooling fans

m  SCA SCSI hard drives

Requirements
Before hot-swapping a power supply, cooling fan, or SCSI hard drive, gather the
following tools:
= one flat-blade screwdriver
m one Phillips screwdriver
m  One antistatic wrist strap
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m the replacement power supply, if needed

m the replacement cooling fan module(s), if needed

m the replacement hard drive(s), if needed
They can be any one or a combination of the following:
(1) 4 Gbyte SCSI Hard Disk, hot-swappable
(2) 9 Gbhyte SCSI Hard Disk, hot-swappable

When to hot-swap the power supply
A green LED indicates that the power supply is working properly. If the green
LED on the power supply module is unlit or red, the module is failing or has

failed. Other indicators are the alarm that sounds and the power supply module
LED on status display that turns red.

The power supply

Power
switch

Power
J input
B

Alarm Hot-swap power \@ \!/H Fuse

board supply modules J— receptacle

G100867

158 CallPilot



May 2000 Performing hardware maintenance

To hot-swap a power supply

DANGER

Risk of electric shock
High current inside the chassis can cause severe injury.

1 Loosen the thumbscrews at the top right and left of the failed power supply
module. If needed, use a flat-blade screwdriver. The thumbscrew must
rotate freely and not contact the chassis threads.

2 Pull the power supply module free from the chassis using the molded
horizontal handle on the power supply module.

Align the replacement module with the empty chassis bay.

4  Slide the replacement power supply module into the bay until the module is
secured by its connector. Use some force, if necessary.

5  Secure the power supply module to the chassis with two thumbscrews at
the corners of the power supply faceplate.

Result: The power supply LED illuminates green.

Note: If the LED does not illuminate, remove and reinstall the power supply
with more force. If this does not work, contact your Nortel Networks
customer support representative.
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When to hot-swap the fan

When the LED associated with a cooling fan becomes red, the fan requires
replacement.

Hot-swap fan modules

e} O _ ot Status panel

)

To hot-swap a cooling fan

1 Remove the front bezel. Use the front panel display LED to locate the
defective fan.

2 Loosen the thumbscrew located on the outside of the failed cooling fan
module. If needed, use a flat-blade screwdriver.

3 Unseat the cooling fan module by sliding the module horizontally away from
the display and toward the rack rail.

Result: The module power connector unseats from the power connector
located behind the display and LEDs.

4  Slide the failed cooling fan module out of the chassis.

Align the replacement cooling fan module tabs with the four support slots
on the chassis. Be sure the module is oriented with the thumbscrew, and
insert the tabs into the supporting slots of the chassis.

6  Slide the cooling fan module toward the front panel display and into
position.

Result: The fan module connects with slight resistance. The fans rotate
and pull air into the chassis. The cooling fan LED goes out.

7  Tighten the module’s thumbscrew and replace the front bezel.
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When to hot-swap hard drives

With a RAID controller, hot-swap device drivers, and operating system support,
SCA SCSI hard drives can be hot-swapped on the 1001rp server. Without the
RAID controller, hot-swap device drivers, and operating system support,
replacing a drive during server operation can cause a fatal error and force a
system restart. If a RAID controller is not installed, shut down the system first
and then replace drives.

Note: Identify which hard drive to remove using the Windows NT event log.

Removing hard drives

To replace hot-pluggable SCA SCSI hard drives

1  Open the front bezel doors.

2 Locate the SCA SCSI drive frame below a cooling fan and beside the
media drive.

Loosen the two thumbscrews on the hard drive carrier.

4  Remove an existing drive by loosening the four Phillips-head screws that
secure it to the carrier.

5  Attach the new drive to the carrier by four Phillips-head screws.
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Align the carrier with the drive frame and slide it into the chassis. Expect
resistance as the carrier and backplane connectors meet.

7 Fasten the two thumbscrews.

8 Close the front bezel and lock it into place.
What's next?

If the drive you replaced was part of a RAID mirrored system pack, run DAC
Administration software under Windows NT to rebuild that drive. If you do not
do this, the system is still prone to data loss if another disk fails.
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Replacing the fuse

Introduction

The fuse is located below the power input socket on the rear panel. When the
server’s fuse blows, the server stops operating.

CAUTION
& Risk of equipment damage and personal injury

Disconnect power from the server before replacing a
fuse.

Requirements
= an approved fuse for replacement

Two different types of fuses exist for North America and for international
use. Ensure that the fuse you are replacing has been approved by Nortel
Networks.

m flat blade screwdriver
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AC System only
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Power
0 ¢ switch
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° Power
input
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To replace the fuse

1

ga b~ W DN

© 00 N O

Power off the server.

Unplug the power cable from the wall outlet.

Unplug the power cable from the power input socket on the server.
Unscrew the fuse receptacle.

Slide the fuse receptacle out of the fuse chamber.

Note: Observe how the blown fuse is positioned in the receptacle.
Remove the blown fuse.

Install the approved fuse.

Slide the fuse receptacle back into its chamber.

Fasten the fuse receptacle with a flat-blade screwdriver.

Plug the power cable back into the power input socket on the server.
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11 Plug the power cable into the wall outlet.

12 Power on the server.

ATTENTION
If the fuse blows after replacement, swap one power

supply module with the other. If this does not work,
call your Nortel Networks customer support
representative.
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Alarm board

Introduction

The 1001rp server alarm board and panel display monitor and indicate the server
status. The confidence test on p&d¢ails if the board is defective or damaged.
When these units are damaged, replace them immediately.

CAUTION
& Risk of equipment damage

Take precautions to protect computer boards. Electrostatic
discharge (ESD) can render boards damaged or unusable.
Wear an ESD wrist strap.

Requirements

Before replacing the status board or panel display, gather the following tools:

m one Phillips screwdriver
m One antistatic wrist strap
m the replacement component(s)
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Alarm board location
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To replace the status board

1 Power off the server.

2 Loosen the two thumbscrews securing the faceplate at the left of the
1001rp server power supply modules.

Pull the carrier free from the chassis.

4  The status board is secured to the carrier by two Phillips-head screws.
Remove the defective status board from the carrier.

5  Secure the replacement status board to the carrier using two Phillips-head
screws.

6  Align the carrier with the chassis and slide the board into the chassis. The
card encounters some resistance as it meets the connector.

7  Tighten the thumbscrews to secure the faceplate to the chassis.
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Jumpers on the alarm board

Introduction

This section describes the features enabled or disabled by setting jumpers on the
alarm board.

Jumper block and switch on the alarm board

A——
R 2
= JP5
\ E‘ i 1% Sup
| - @ : [roi=] uP4
= % =1EL 3 PWR SUP
S i _ JP3
| - lﬁﬂé-ﬁnfl'l'la NO LCD
! JPS
SPKR DIS

Setting jumpers on the alarm board

The jumpers on the alarm board enable or disable sensing and display functions.
The default setting enables the sensing or display. The default setting is with the
jumpers removed.

JP6 - do not change

Leave the jumper installed.
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Disarming “No Power” in the bottom bay

Jumper block 1, JP5 : Jumper both pins to instruct the alarm board not to react to
no power signal coming from the bottom power supply. Jumper both pins when
one power supply is used, and install that supply in the upper power bay. Ensure
that both pins are not jumpered to allow the alarm board to sense power status
from both upper and lower power supply bays.

JP4

Jumper block 1, JP4 : not used.

Display or No display

Jumper block 1, JP3 : Jumper both pins to configure the alarm board to send
alarm signals to the full array of LEDs. If this jumper is not installed over both
pins, the alarm board does not send the correct format of signals to the front
panel display.

Part 5: 1001rp Server Maintenance and Diagnostics 169



Performing hardware maintenance Standard 1.0

Status display

Locating the display

The display is located at the front of the chassis and is cabled to the rear of the
chassis and the Status Board.

The status panel

— Status panel

IRESRSY
Senateesy
O "ee0tee!
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To replace the display
1  Power off the server.
2 Remove the top cover and the front bezel from the chassis.

3 Loosen the four Phillips-head screws securing the display to the front of the
chassis.

4  Disconnect the cable and lift the defective display up and out of the chassis.

Set the replacement display into position, and secure it to the chassis by
replacing the Phillips-head screws.

6 Reconnect the cable.

7  Replace the top cover and front bezel.
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Section B: RAID system

In this section

Overview 172
RAID system summary 173
Replacing the RAID card 174
Attaching cables to the RAID card 176
Replacing and configuring hard drives 179
Configuring hard disk drives 182
Rebuilding a hard disk in RAID 184
Maintaining RAID hard drives 188
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Overview

Introduction

A RAID card enables you to expand the capabilities of your server. This section
describes the 1001rp server RAID system and the procedures for replacing and
configuring its components.

Included procedures

Procedures covered include the following:

m replacing a RAID card

m cabling a RAID system

m  preparing to configure a RAID system
m creating a system drive

= initializing a system drive
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RAID system summary

Introduction

Redundant Arrays of Inexpensive Disks (RAID) is a technology that can
combine two or more drives for fault tolerance and performance. Configure the
drive bay in the 1001rp to RAID level 1 array using the optional hardware RAID
controller, or as individual drives (non-RAID).

Drive array bays

There are six Single Connector Architecture (SCA) 3.5-inch full-width drive
array bays available to add hot-pluggable disk drives.

RAID levels

The RAID controller is a PCIRAID SCSI card that provides high-performance
disk mirroring. It is always installed in PCI slot 12. RAID Level 1 is always
implemented.

m Level 1 - mirroring

Two equal-capacity disks mirror one another. One disk serves as the backup
copy of the other disk. If one drive fails, the other automatically replaces it.
This level prevents loss of information and network time.

RAID software

The Windows NT operating system supports mirroring in software without a
hardware RAID controller. This software-only approach is not recommended or
supported.

RAID and hot-swappable components

A RAID controller is also essential to hot-swap SCA SCSI hard drives. If you
replace a drive during system operation without the RAID controller, hot-swap
device drivers, and operating system support, you can cause a fatal system error,
force a system restart, and cause data loss.
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Replacing the RAID card

Introduction

You can replace or upgrade your RAID card. Follow the procedures in this
section to replace a RAID card and reconnect the cables.

Requirements

Before replacing the RAID card, gather the following tools:

m one Phillips screwdriver
m One antistatic wrist strap
m the replacement RAID card

To replace the RAID card
1 Review the manufacturer’'s documentation for the replacement card.
2 Power down the server and disconnect all power cords.

3 Remove the chassis cover and locate the installed RAID card in PCI slot
number 12.

4  Disconnect all cabling from the RAID card.

(&)

Use an adhesive label or a piece of tape to label each cable with its
connection.

Loosen the screw located at the top of the card’s faceplate.
Remove the card from the chassis.

Unpack the replacement card.

© 00 N O

Align the replacement card with PCI slot 12.

10 Apply downward pressure until the card is evenly and securely seated in
the slot.

11 Secure the card by tightening the screw at the top of the faceplate.

Note: If you replace your RAID card and the system does not come up, call
Nortel Networks support.
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What's next?

Once the card is secured on the chassis, reconnect the cables.

Part 5: 1001rp Server Maintenance and Diagnostics 175



Performing hardware maintenance Standard 1.0

Attaching cables to the RAID card

Introduction

Once you seat the RAID card firmly on the chassis, you need to connect cables
to the card. In a RAID configuration, use the SCSI Channel 1 to control the hard
disks, and the SCSI Channel 0 to control the tape drive.

Requirements

To connect the RAID card cabling, you require the following:

= RAID cables for two header connections

Both header connections must be cabled. Refer to the connections as
Channel 0 and Channel 1

= aproperly seated RAID card
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RAID card cabling with a Pentium Il or Il SBC

SBC card

CD ROM drive

Floppy drive
AN

To hard drive

To po

P
e

To power

68t0 50 —
pin adapter
(optional for
narrow tape
drives)

Active
terminator

|

Channel 1

Channel 0

RAID card

Note: This diagram applies to older drives. Newer drives do not have the same

adapter.
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To cable hard disk drives in a RAID system

CAUTION
& Risk of equipment damage

Ensure that no cable touches any SBC card component.
Heat transfer often causes serious damage to the system.

Connect a SCSI cable to Channel 1 on the RAID card.

Route the cable to the expansion card area through to the left side of the
system, and down to the SCSI backplane.

Result: The SCSI backplane provides termination for this SCSI channel.

To cable a RAID system for a tape drive

1
2

Connect a second SCSI cable to Channel 0 on the RAID card.

Route the cable between the RAID card and the right side of the system
chassis to the front of the chassis, and then down through the system to the
tape drive.

Attach a wide SCSI active terminator as the last device on the cable.

Note: The NTRH9034 tape drive cannot provide SCSI bus termination. You
must have an Active SCSI terminator as the last device on the SCSI cable.
Ensure that the jumper labeled TPWR is enabled on the tape drive. The
tape drive must always be connected to the second last connector on the
SCSI cable.

m  Wide active terminator (Part number A0766997)
The wide active terminator must be connected to the last connector on
the SCSI cable.

What's next?

Once you have installed and cabled the RAID card, you do not need to configure
the card. Power up the system. The card reads the configuration from the drives

and configures itself.

Note: If you replace your RAID card and the system does not come up, call your

Nortel Networks customer support representative.
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Replacing and configuring hard drives

Introduction

Replace any of the six SCSI hot-swappable drives from the drive bay if they
should fail, or if you want to upgrade. The 1001rp server also operates one
additional hard drive from the media drive bay that you can replace. Once you

replace hard drives, configure them.

Replacing hard drives
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RAID SCSI hard drive configuration

Non-RAID SCSI hard drive configuration

The table below indicates proper SCSI drive bay, channel, and ID configurations
in the hot-swappable drive bay. The SCSI backplane sets SCSI IDs: as follows:

Hard drive bay SCSI unit SCSI ID

1 (A-0) Channel 1,1D 0
4 (A-1) Channel 1, 1D 3
2 (B-0) Channel 1,ID 1
5 (B-1) Channel 1, ID 4
3 (C-0) Channel 1, ID 2
6 (C-1) Channel 1,ID 5
Front bay Tape drive Channel 0, ID 6

The table belowindicates proper SCSI drive bay, channel, and ID configurations

in the hot-swappable drive bay. The SCSI backplane sets SCSI IDs as follows:.

Hard drive bay SCSI unit $CSI ID

1 (A-0) SCSl ctrl, ID 0
4 N/A SCSl ctrl, ID 3
2 (B-0) SCSlctrl, ID 1
5 N/A SCSil ctrl, ID 4
3 (C-0) SCSl ctrl, ID 2
6 N/A SCSlctrl, ID5
Front bay Tape drive SCSlctrl, ID 6
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Note: Do not install drive bays 4, 5, and 6 in the standard non-RAID
configuration.

If you have a SCSI CD-ROM drive in a non-RAID hard drive configuration, then
the tape drive must have the following SCSI IDs:

Hard drive bay SCSI unit SCSI ID

Front bay Tape drive SCSilctrl, ID 6

To set SCSI IDs and disable termination

1 Set SCSI IDs to 0. Disable termination.

2  Check that the SCSI ID of the tape drive matches the table on the previous
page.
Ensure that Parity Checking is enabled on the tape and disks.

4  Check that the tape drive is configured to enable termination for its SCSI
channel.

Note: You require a wide (68-pin) to narrow (50-pin) connector to connect a
narrow tape drive to the wide SCSI bus.

What's next?

Once you have set the SCSI IDs, configure the system for specific drive
capacities.
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Configuring hard disk drives

Introduction

Your requirements determine the capacity of a system. Drives C-0 and C-1
might not exist in a standard RAID configuration. The procedures for
configuring each drive capacity are listed below.

Note: The following serves as an example only. Other combinations are possible
depending on your application.
Hard drive location

The following table indicates the relative physical location of hard drives and
their associated capacity:

Drive bay |Drive bay |Drive bay |Drive bay |Drive bay |Drive bay

1 2 3 4 5 6

9 Ghyte 9 Ghyte 9 Gbyte 9 Gbyte 9 Ghyte 9 Ghyte
A-0 B-0 C-0 A-1 B-1 C-1

Note: Drive bays can be either 4 Gbyte or 9 Gbyte.

To configure hard disk drives

1 Usethe “Hard drive location” table above to determine the appropriate drive
bay for installation.

2 Configure the hard drive to have no termination.

Result: The SCSI backplane handles proper termination of the SCSI bus.

Note: In a non-RAID configuration, only drives A-O and B-0 are installed for
a 13 Ghyte configuration. C-0 is installed only if the intended configuration
is 22 Gbyte.

In a RAID configuration, drives A-0, A-1, B-0, and B-1 are installed for a 13
Gbyte configuration. C-0 and C-1 are installed only if the intended
configuration is 22 Gbyte.
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What's next?

Once you have configured the capacity of your drives, configure the drives as
part of a RAID or non-RAID system.
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Rebuilding a hard disk in RAID

Introduction

In RAID level 1, two equal-capacity disks mirror one another. Both drives run
simultaneously with one disk serving as the backup copy of the other disk. If one
drive fails, the other continues to run. When the failed drive is physically
replaced with a new one, the data on the operating drive of the system pack must
be copied onto the new drive to rebuild it. RAID automatically performs this
rebuild process when the replacement drive is accessed.

If you would like to start the initiation process sooner, or monitor the rebuilding
process, use the the DAC Administration software that is installed on the system.

Before you begin

Perform this procedure in response to the system message that a hard disk has
failed. The message displays information about drive location. Perform this
procedure while the system is powered on.
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To rebuild a hard disk in a RAID system

1 Observe the warning message given by the DAC Monitor software, which
indicates a hard drive failure.

[=] DAC60 SCSI RAID Controller Monitor Utility

BACI60 Event Log

(Wed May 13 10:05:43 199
DACI60-1: The hard disk at [CH-1 : ID-0] has failed.

Sin
i#Astart ||[E DACIEO SCSI RAID . 10:05 AM

2  Record the SCSI channel SCSI ID of the drive that failed from the
information in the DAC Monitor window.

3 Identify which drive drive failed using this information and referring to the
tables contained on pages 180 and 182.

Shutdown Windows NT and power down the server.
Remove the failed hard disk.

Replace the failed hard disk with a new hard disk.
Power up the server and log on to Windows NT.
Click the DAC Administration icon.

o N o o b~
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9 Choose Rebuild Drive from the Management menu.

145 Mylex DAC3EO SCS1 RAID Controller ADMINISTRATION Utility [V 4.03]
B Configuration Help
Select Controller
Fiebuild Fiale
d Drive
Consistency Check.
Kill Diive
Make Online

[Z] DACI60 SCSI RAID Controller Monitor Utility

DAC3I60 Event Log

Wed May 13 10:09:55 199
DACI60-1: The hard disk at [CH-1 : ID-0] is NOT being
i by a

‘Wed May 13 10:09:50 199
DACS60-1: The hard disk at [CH-1 : ID-0] has failed.

‘Wed May 13 10:09:45 199
DACS60-1: The hard disk at [CH-1 : ID-0] has failed.

g start| [EDACsE0 5051 RAID Contr. [[E5 Mylex DACIB0 SCS1 1010 AM

10 Click the drive marked DED.

lylex DACG0 SCS1 RAID Controller ADMINISTRATION Utility [V 4.03] 1 ]

Management Configuation Help

Device Selection

Febuild Drive  (Controller 1)
Fobuii Pogess

Riebuilding CH-1: ID-0

L T R T

Channel 1

System Drive 0
Wed May

oentay 020 N

Chaninel 2

Wed May
DACSI60-1

ogieaton | {1 |

DACY60-1 Help K| v

automatii

Rebuid in progress:

Yed May 13 10:09:50 199
DACI60-1: The hard disk at [CH-1 : ID-0] has failed.

;asnan| [EIDAC350 SCSI RAID Contr. | {=Mylex DACIS0 5CSI ... 10:12 AW
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11 When the rebuild completes, click OK.

Note: This procedure takes from five minutes to one hour, depending on
the size of the drive.

& Mylex DACIG0 SCSI RAID Controller ADMINISTRATION Utility [V 4.03]
Managemert Configuation Help

Rebuid Diive ~ (Contioller 1]

i Rebuild Progress ]
[ DACI60 5CS1 RAID Controller Honitor Utility [ |diacH: 00

DACI960 Event Log -

stem Drive 0

Wed May 13 10:12:45 199
DACS60-1: Rebuild in Progress, Current Status : 93 %6 of
logical drive 0 left

‘Wed May 13 10:12:15 199
DACS60-1: Rebuild in Progress, Current Status : 96 % of
logical drive 0 left

‘Wed May 13 10:11:45 199 Rebild Rate = 50
DAC960-1: Rebuild in Progress, Current Status : 99 %6 of 4 3

logical drive 0 left Rebuld in progress

Wed May 13 10:09:55 199
DACS60-1: The hard disk at [CH-1 : ID-0] is NOT being
ically replaced by a hotspare.

i Stant S Mylex DACI50 5CS1 RAID. 1u13
12 After the procedure is complete, close the application.
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Maintaining RAID hard drives

Introduction

RAID hard drives must be checked for errors on a weekly basis. Errors can be
reviewed with the help of the DAC Admin Windows NT software utility that is
installed on the server.

To review errors detected on a RAID hard disk
1  Click the Start Menu.
2 Click Run.
3 Type dacadm.exe.
4  Click OK.
Result: This starts the DACAdmin software utility.

(&)

Click the Configuration menu.
6  Choose Drive Information on the Configuration menu.
Result: A list of all hard disks connected to the RAID controller appears.
Note: Hard disks marked ONL are online and part of a RAID System pack.
7  Click on a drive to see a summary of errors.
a. If there are ten or more soft errors per day, replace the drive.

b. Hard errors should not occur during normal operation. Contact your
Nortel Networks customer support representative if errors are
accumulating.

c. Miscellaneous Errors are typically due to cabling or termination
problems on the SCSI bus. Verify jumper settings on all SCSI devices
and ensure that cabling is secure.

d. When the total number of errors reaches 127, the controller marks the
drive DED. DED means offline. The drive must be replaced.

8 Repeat step 7 on all hard disk drives listed.
9 Close the configuration menu.
10 Exit from the DAC Admin software utility.
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Section C: Device settings

In this section

Overview 190

Pentium 1l or Il slot assignments 191

IRQ mapping table 192
189
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Overview

Introduction

This section describes device settings for the 1001rp server.

Procedures covered include the following:

» slot assignments for the 1001rp server configurations
m  IRQ mapping for the 1001rp server

1001rp backplane showing ISA/SBC/PCI slots

OF 4 , ,r § /53 e
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Pentium Il or Il slot assignments

Slot Device

ISA Slot 1 CLAN Network Card (if ISA)
ISA Slot 2 Available for application

ISA Slot 3 Available for application

ISA Slot 4 Available for application

ISA Slot 5 Available for application

ISA Slot 6 Available for application

ISA Slot 7 Available for application
SBC Slot Pentium Il or Pentium 11l Single Board Computer
PCI Slot 1 Reserved for COM1 and COM2 I/O Bracket
PCI Slot 2 ELAN Network Card

PCI Slot 3 CLAN Network Card (if PCI)
PCI Slot 4 Available for application

PCI Slot 5 Available for application

PCI Slot 6 Available for application

PCI Slot 7 Available for application

PCI Slot 8 Available for application

PCI Slot 9 Available for application

PCI Slot 10 | Available for application

PCI Slot 11 | VGA Card (if PCI)

PCI Slot 12 | PCI RAID Controller
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IRQ mapping table

Introduction

The IRQ table for the 1001rp Server applies to both Single Board Computer
configurations. In addition, note that IRQs 9, 10, 11, and 15 are assigned to
system PCI slots rather than to specific devices.

IRQ Slot/Device

Timer

Keyboard

System / Unused
Serial Port 2 (COM2)
Serial Port 1 (COM1)

CLAN Network Interface (if ISA) otherwise available

Floppy Controller

Parallel Port (LPT1)

Real Time Clock

O 0| N[O b~ W|DN|PF]|O

Assigned to PCI Slots 1, 7, and 12

[N
o

Assigned to PCI Slots 2, 5, and 11

11 Assigned to PCI Slots 3, 6, and 9

12 PS/2 Mouse

13 Math Coprocessor

14 Primary EIDE Controller
15 Assigned to PCI Slots 4, 8, and 10
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Section D: Video card

In this section

Overview 194
Troubleshooting the video card 195
Replacing the video card 196
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Overview

Introduction

This section describes procedures for handling and replacing video cards on the
1001rp server.

Included procedures

Procedures covered include the following:
s troubleshooting the video card
identifying the video card
determining slot assignment

replacing the video card
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Troubleshooting the video card

Video card function

The video card takes information from the computer and displays it on the
installed monitor.

Indicators for card replacement

If the monitor appears to be functioning but no display is visible, look for the
following indicators of video card malfunction. If the server is consistent with
these indicators, replace the video card:

m  Brightness and contrast are set at normal level.

m  The server is powered on and one long beep is followed by two short beeps.

m  The floppy drive light goes on when the server is powered, but no display is
visible on the monitor.

m  The floppy drive light comes on when the user types dir a: and presses
Enter, but no display is visible on the monitor.
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Replacing the video card

Introduction

If you determine that a problem exists with your video card, replace the card.
You need to identify the type of card before you can decide where to install it.

Requirements

To replace the video card, you require the following:

m one Phillips screwdriver
m One antistatic wrist strap
s the replacement video card

Identify the card

Identify a video card from other types of cards by its connector. To identify an
installed video card, look at the card to which the installed monitor connects. If
no monitor is connected, look for the card to which a monitor normally
connects.

To replace the video card
1 Review the manufacturer's documentation for the replacement video card.
2 Power down the server and disconnect all power cords.
3  Refer to the table on page 191 to determine proper slot assignment.
4 Remove the chassis cover to expose the installed cards.
5 Set aside any cables covering the video card.

Note: The video card has no internal cable connectors itself.

(2}

Free the card from the faceplate by loosening the screw.
7  Lift the card out of the slot and set it aside.

8 Unpack the replacement card and align it with the proper slot.
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9  Apply downward pressure until the card is evenly and securely seated in
the slot.

10 Secure the card by tightening the screw located at the top of the faceplate.

11 Replace the chassis cover.

What's next?

Perform system diagnostics procedures after you install or replace any server
component.
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Section E: Optional cards

In this section

Overview 200
Replacing ELAN cards 201
Replacing Ethernet CLAN cards 206
Replacing Token Ring CLAN cards 209
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Overview

Introduction
This section describes the network cards approved for use in the 1001rp server.

Procedures covered include the following:

= slot assignments for optional cards
m installing and configuring network cards

Minimum requirements

Minimum system requirements for all servers include the installation of a
network card. Install optional network cards according to server configuration.

Slot assignments described in this section show the proper location for required
and optional network cards.

Pentium Il or 1l slot assignments

Refer to" Pentium Il or Il slot assignmeriten page 191
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Replacing ELAN cards

Introduction

The ELAN network card is a minimum system requirement for the 1001rp
server. Although the card must always be an Ethernet card installed in a PCI slot,
it can be either Intel or 3Com.

To replace an ELAN network card

1 Check the slot assignment table on page 191 to determine proper slot
assignment.

2 Check that the BIOS is configured to assign the correct IRQ to the correct
slots.

Remove the chassis cover to expose the installed cards.
Disconnect external network cables.

Check the installed card to ensure that it is the ELAN network card.

o 00 b~ W

Set aside any cables covering the card.

Note: The network card has no internal cable connectors.

~

Free the card from the faceplate by loosening the screw.

8  Lift the card out of the slot and set it aside.

9  Unpack the replacement card and insert it into the proper slot.

10 Align the card with the faceplate and secure it by tightening the screw.
11 Replace the chassis cover.

12 Connect the ELAN network cable.

What's next?

= Add the appropriate network card driver if the new installed card is a
different make/model from the failed card.

= You must remove the old ELAN card driver if the new installed card is a
different make/model from the failed card.

m  Run diagnostic software (typically installed with the driver).
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To install an ELAN network card driver

1 Restart and log on to the server as Administrator.

2 Open the Network Control Panel and select the Adapters tab.

3  Click Add... to add the adapter.

Metwork H |

|dentificatinn| Sewicesl Protocols  Adapters |Eindings|

Metwark Adapters:

00 Ethernet PCl Adapter

Add... Remaove Properties. .. Update

[tem Motes:
Intel B2557-bazed 10/100 Ethernet PCI Adapter or compatible

Ok I Cancel

202
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4  Click Have Disk... to load the device driver.

Select Metwork Adapter EHE

Click the Metwork, Adapter that matches vour hardware, and then
click QK. If you have an installation digk. for this component, click
Hawe Dizk.

Mebwork Adapter:

o 16-bit Et apter il
3ACom Etherink || Adapter [alzo 116 and 11116 TR)
B8 3Com Etherlink |11 154/PCMCLA Adapter
B8 3Com EtherLink Il PCI Bus-Master Adapter [3C590]
B8 3Com Etherlink 16/EtherLink 16 TP Adapter

||
BE) e Conb Dbl ianle DL AN M OADACE T b Aorber IFTEORT

Hawve Dugk... |

0K | Cancel |

5 Insert the driver disk for the ELAN network card in the floppy drive and
press Enter.

Inzen Disk =
Inzert disk with software provided by the software or 0K
\ﬁ hardware manufacturer. |f the files can be found at a -
different location, for example on another drive type a Cancel |
new path to the files below.
2]

6 If the driver disk contains drivers for more than one network card, the
system prompts you to select the driver you want to install. Choose the
driver that matches the installed ELAN card and click OK.
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7  Click OK when the following screen appears:
Note: You only see this if ELAN and CLAN are the same.
Setup Message E

& A network card of thiz type is already installed in the system. Do you want to continue?

ok |

Result: Some files are copied to the system and the new network card is
listed in the network dialog box.

Note: Screen shots are not included for specific cards as they might be
different depending on your configuration. If you need help installing a
driver, call your Nortel Networks customer support representative.

Network E3

Identificatinnl Servicesl Pratocols  Adapters |Bindings|

Metwark, Adapters:

BB [1] Intel 82557-based 10100 Ethernet PCl Adapter
B8 [5] Intel EtherE wpress PRO Adapter

Bemove Properties.. Update

Item Hotes:
Intel 82557 -bazed 10,100 Ethemet PCI Adapter or compatible

Cloze | [Eaize]

8 Click Close to close the network control panel.

9  The TCP/IP properties panel appears.
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10 Select the new driver installed in the Adapters box.
11 Enter the customer-supplied IP address.
12 Click OK.

Result: You are prompted to restart the computer.
13 Click Yes.
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Replacing Ethernet CLAN cards

To replace the 3Com PCI Ethernet card

1 Review the slot assignments on page 191 to install the PCI CLAN network
card in the appropriate slot.

2 Check that the BIOS is configured to assign the correct IRQ to the correct
slots.

Power down the server.
Unplug the AC power cord.

Remove the chassis cover.

o 00 b~ W

Locate the CLAN Ethernet card to be removed, and unplug its network
cabling.

~

Set aside any cables covering the card.
8 Remove the screw that fastens the card in the chassis.
9  Gently pull the card out (use a slight rocking motion).
10 Remove the new Ethernet card from its protective packaging.
Note: Place the old Ethernet card into the protective packaging.
11 Line up the new Ethernet card with the slot (PCl or ISA, as appropriate).

Note: Make sure the end-plate tab is lined up with the opening in the
chassis.

12 Press the card into the slot.

CAUTION
& Risk of equipment damage

Ensure that the card is completely seated or the card will
short-circuit.

13 Secure the card to the server chassis with the fastening screw.
14 Replace the chassis covers.

15 Plug in the AC power cord.
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16 Power up the server.

To install a 3Com PCI Ethernet network card driver

o 00 b~ W

Start with Windows NT and log on to the server as Administrator.

Open the Network Control Panel, select the Adapters tab, and Click Add...
to add the adapter.

Click Have Disk... to load the device driver.
Insert the 3Com device driver disk for the CLAN card and press Enter.
Select 3Com Fast Ethernet 3C900 card and click OK.

Click Close to close the network control panel and configure the network
card.

Enter the TCP/IP information for the card.
Note: The customer must provide this information.
Click OK to close the TCP/IP configuration screen.

Click Yes to restart the computer.

To replace an Intel PCI Ethernet card

1

o o b~ W

~

Review the slot assignments on page 191 to install the PCI CLAN network
card in the appropriate slot.

Check that the BIOS is configured to assign the correct IRQ to the correct
slots.

Power down the server.
Unplug the AC power cord.
Remove the chassis cover.

Locate the CLAN Ethernet card to be removed, and unplug its network
cabling.

Set aside any cables covering the card.
Remove the screw that fastens the card in the chassis.

Gently pull the card out (use a slight rocking motion).
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10 Remove the new Ethernet card from its protective packaging.
Note: Place the old Ethernet card into the protective packaging.
11 Line up the new Ethernet card with the slot (PCl or ISA, as appropriate).

Note: Make sure the end-plate tab is lined up with the opening in the
chassis.

12 Press the card into the slot.

CAUTION
& Risk of equipment damage

Ensure that the card is completely seated or the card will
short-circuit.

13 Secure the card to the server chassis with the fastening screw.
14 Replace the chassis covers.
15 Plug in the AC power cord.

16 Power up the server.

To install an Intel PCI Ethernet network card driver

1  Start with Windows NT and log on to the server as Administrator.

2 Open the Network Control panel, select the Adapters tab, and click Add... to
add the adapter.

Click Have Disk... to load the device driver.
Insert the Intel device driver disk for the CLAN card and press Enter.
Select Intel EtherExpress PRO/100B PCI Ethernet Adapter, and click OK.

o o0 b~ W

Click Close to close the network control panel and configure the network
card.

7  Enter the TCP/IP information for the card.
Note: The customer must provide this information.

8 Click OK to close the TCP/IP configuration screen. Click Yes to restart the
computer.
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Replacing Token Ring CLAN cards

To replace the Racore PCI Token Ring card

1 Review slot assignments on page 191 and install the PCI CLAN network
card in the appropriate slot.

Power down the server.
Unplug the AC power cord.

Remove the chassis covers.

ga b~ W DN

To make access to the internal components easier, turn the server over on
its side.

6 Locate the PCI Token Ring card to be removed, and unplug its network
cabling.

7  Remove the screw that fastens the card in the chassis.

8  Gently pull the card out (use a slight rocking motion).

9 Remove the new PCI Token Ring card from its protective packaging.
Note: Place the old PCI Token Ring card into the protective packaging.

10 Line up the new PCI Token Ring card with the PCI slot.

Note: Make sure the end-plate tab is lined up with the opening in the
chassis.

11 Press the card into the slot.

CAUTION
& Risk of equipment damage

Ensure that the card is completely seated or the card will
short-circuit.

12 Secure the card to the server chassis with the fastening screw.
13 Stand the server up, and replace the chassis covers.
14  Plug in the AC power cord.

15 Power up the server.
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To install a Racore PCI Token Ring card driver

1
2
3

Start with Windows NT and log on to the server as Administrator.

Open the Network Control panel, and select the Adapters tab.

Click Add... to add the adapter, and click Have Disk... to load the device
driver.

Insert the Racore device driver disk for the CLAN card, type a:\windows.nt
as the path to the driver, and press Enter.

Select Racore Preferred Token Ring NDIS Driver, and click OK.

Type the following information in the appropriate fields:

I/O: PCI

IRQ: 5 (or 10 if PCl and MMX SBC; or 11 if PCI and PIl SBC)
DMA: Autodetect

Memory Address: Autodetect

Network Address: (leave blank)

Speed: 16 Mbytes (leave the rest of field as is)

Bus Number:

Select the appropriate bus humber from the list below:
PClslot#1=Bus 1
PClslot#2=Bus 1
PClslot#3=Bus 1
PClslot#4 =Bus 1
PCl slot#5 =Bus 2
PCl slot # 6 = Bus 2
PCl slot# 7 =Bus 2
PCl slot # 8 = Bus 2
PCl slot #9 =Bus 3
PCl slot # 10 = Bus 3
PCl slot# 11 =Bus 3
PCl slot# 12 = Bus 3

Bus Type: PCI

Note: The last two fields appear in a separate dialog box.

Click Close to close the Network Control Panel and configure the network
card.
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9
10

Enter the TCP/IP information for the card.
Note: The customer must provide this information.
Click OK to close the TCP/IP configuration screen.

Click Yes to restart the computer.

To replace the Madge ISA Token Ring card

1

o o~ WN

10

11

12

Use the BIOS Configuration utility to check that IRQ5 is available.

Note: Go to the Advanced section of the BIOS and, under PCI Devices,
ensure that IRQ5 is not assigned to a PCI IRQ Line.

Review slot assignments and install the ISA CLAN network card.
Power down the server.

Unplug the AC power cord.

Remove the chassis covers.

To make access to the internal components easier, turn the server over on
its side.

Locate the PCI Token Ring card to be removed, and unplug its network
cabling.

Remove the screw that fastens the card in the chassis.

Gently pull the card out (use a slight rocking motion).

Remove the new PCI Token Ring card from its protective packaging.
Note: Place the old PCI Token Ring card into the protective packaging.
Line up the new PCI Token Ring card with the PCI slot.

Note: Make sure the end-plate tab is lined up with the opening in the
chassis.

Press the card into the slot.

CAUTION
& Risk of equipment damage

Ensure that the card is completely seated or the card will
short-circuit.
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13
14
15
16

Secure the card to the server chassis with the fastening screw.

Stand the server up, and replace the chassis covers.

Plug in the AC power cord.

Power up the server.

To install a Madge ISA Token Ring card driver

1

Start the server from the Madge Install disk.

Note: If the disk supplied is not in a bootable format, refer to Standard
Procedures.

Press any key once the title screen appears. Press F3 to configure software
configurable ringnodes.

Select the SMART 16/4 AT PLUS RINGNODE.

Verify the following information and press Enter to configure the
information:

Transfers: 16 bit Bus Master
I/O Port: 0A20

Ring Speed: 16 Mbytes
IRQ: 5

SmartROM: Disabled

Press F5 to confirm that the hardware profile matches the configuration.

Note: If the configuration does not match, check the DIP switches.

Verify the following information and press F8 to configure:

DMA: 5
I/O Width: 16 bit
Bus Timing: Normal

Bus Mode: Asynch

Press F4 to complete the configuration.

Restart and log on to the server as Administrator.

Open the Network Control Panel and select the Adapters tab. Click Add...
to add the adapter.
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10

11

12

13

14
15

Click Have Disk... to load the device driver.

Insert the Madge Device Driver disk for the CLAN card.

a.
b.
c.
d.

Type a:\winnt.35 as the path to the driver.

Press Enter.

Select SMART 16/4 AT PLUS RINGNODE (BM).
Click OK.

Type the following information in the appropriate fields:

I/O Location: 0x0a20

IRQ: 5

DMA: 5

Number of Processors: Multiple

Max Frame Size: 4096

LAA: (leave blank)

Rx/Tx Buffers: Rx=04, Tx=04

Traffic Statistics Gathering: Enabled

Ring Speed: Set at Adapter (leave the rest of the field as is)
Bus Type: ISA

Bus Number: 0

Note: The last two fields appear in a separate dialog box.

Click Close to close the Network Control Panel and configure the network
card.

Enter the TCP/IP information for the card.

Note: The customer must provide this information.

Click OK to close the TCP/IP configuration screen.

Click Yes to restart the computer.
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Section F;: The Pentium Il SBC card
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The Pentium Il SBC card

Introduction

This section describes the Pentium Il or Pentium Il Single Board Computer
(SBC) cards. It covers procedures for replacing and configuring the SBC card.

Procedures included

Procedures covered include the following:

m replacing the SBC card
m upgrading and configuring the BIOS
s adding memory DIMMs to the SBC

Intended audience

This section is written primarily for field service technicians. It is intended to act
as a guide for installing, repairing, replacing, and upgrading hardware and

software components. This section assumes that the reader has basic computing

skills, is familiar with necessary safety procedures, and has the hardware
documentation provided by the manufacturer available as a refefdnise.
information applies to the 1001rp server only.
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The Pentium Il SBC
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Replacing the Pentium Il SBC card

Introduction

You should replace the SBC card when it fails. Use system diagnostic tools and
refer to error codes to determine whether the SBC card should be replaced.

The SBC is always installed in the SBC slot located between the ISA expansion
slots and the PCI slots on the backplane. The board features headers for
peripheral connections, jumper blocks, and DIP switches. It also features four
DIMM sockets to support up to 512 Mbytes of Fast Page Mode memory on the
Pentium Il SBC.

Requirements

Before replacing the SBC card, gather the following tools:
s one Phillips-head screwdriver

m  One antistatic wrist strap

m the replacement SBC card

= cable labels

To replace the SBC card
1 Power down the server.
Disconnect the power cord.
Remove the top cover.
Free and label all connectors from the SBC card.
Loosen and remove the screw located at the top of the 1/O bracket.
Remove the I/O bracket.
Loosen and remove the screw located at the top of the card’s faceplate.

Loosen the SBC and pull it up from the backplane.

© 00 N o o b~ W0ODN

Remove the new card from its protective wrapping.
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10 Align the card with its slot on the backplane and press it into place.

Result: The board seats properly in both the ISA-style and PCl-style
connectors.

11 Fasten the card down with the screw provided.
12 Install the new I/O bracket.
13 Fasten the I/O bracket using the screw provided.

14 Remove the labels attached to all connectors and reconnect them to the
card.

15 Replace the top cover.
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Upgrading the BIOS

Introduction

BIOS is the Basic Input/Output System of the computer. It is Flash ROM-based
code. The system is equipped with Flash BIOS, which enables you to upgrade
by running a single program that writes updated code to the Flash ROM chips.

When to configure the BIOS

BIOS configuration is necessary for first-time setup. Reconfigure the BIOS after
a BIOS or CMOS failure and recovery.

Requirements

= You need a bootable upgrade disk. For the Pentium Il SBC, the Texas
Micro BIOS release number must be 4.06.1.5c.

Contact your Nortel Networks customer support representative
organization to request a BIOS upgrade disk.

= You must perform both of the following procedures to upgrade the BIOS:
m upgrading the BIOS
m configuring the SBC
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DIP switch block on the Pentium Il SBC

‘s~ s

To upgrade the BIOS

1

ga b~ W DN

Insert the bootable BIOS upgrade disk into drive A and power on the server.

Note: You can obtain a BIOS upgrade disk from your Nortel Networks
customer representative.

Allow the flash process to complete.
Power down the system.

Remove the top cover.

Set DIP switch 3 to the ON position.
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10
11

Power on the server.

Result: A message appears on the boot screen that the system is loading
BIOS defaults.

Power off the server after seeing the above message.
Return DIP switch 3 to the OFF position.

Replace the top cover.

Restart the system.

Configure the BIOS as described in the following procedure.

To configure the Pentium Il SBC BIOS

1

Power on the system and press F2 to enter the CMOS Setup.

Note: For the following steps, use the arrow keys to navigate menus, and
press Enter to make a selection.

Result: The Setup Utility starts. The screen has two areas:

m  Options: The Options menu is on the left side of the screen, and is
composed of Basic options, Advanced options, and PCI options.

= Summary Information: The current settings appear on the right side of
the screen.

Select the items described in the tables that follow.

Crisis recovery

There are special cases when the BIOS data is corrupted or an invalid user

configuration has been entered, an incorrect BIOS file has been flashed. In some
cases, the SBC does not start at all or it displays nothing on the screen.

1

To recover the BIOS

Use the Nortel Network’s NTRH8042 disk to create the Crisis recovery
disk.

a. InDOS mode, copy the contents of the NTRH8042 disk on a temporary
directory.

b. Label a new disk Crisis Recovery.

c. Insertthe Crisis Recovery disk into drive A.
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e.

Press Enter.

At the DOS prompt, type crisdisk.

f.  After the disk is done, at the DOS prompt, type makeboot .

g.

Press Enter. Power off the server.

Identify Switch Block (SW1) on the SBC. The Switch Block contains four M

access, CMOS RAM, and configuration ports. Set dip switch humber 2 to
the closed/on position.

Note: The default position set on the switch is open/off.

Insert the Crisis Disk into the floppy drive.

Power on the server.

Result: You hear a series of beeps.

Note: During this process, the only devices that work are the floppy
controller, floppy drive, and speaker. There is no display.

disk and power off the server.

Power on the server.

Return switch number 2 back to the default position of open/off.

Result: The SBC should restart normally and prompt you to enter into

setup.

Pentium Il BIOS basic options

Note: You must first load the defaults by pressing F9.

When you do not hear any beeps (approximately 15 seconds), remove the

Item Option Default setting CallPilot setting
Time and Date Set time and date N/A Current Date/Ti
Floppy Disks Floppy Controller Enabled Enabled
Select drive A Typg 3.5” 1.44 Mbytes 3.5" 1.44 Mbytes
Select drive B Type Not Installed Not Installed
IDE Adapter O Master CD-ROM CD-ROM

ne
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Item Option Default setting CallPilot setting
Slave None None

IDE Adapter 1 Master None None
Slave None None

Fixed Disks IDE Controller Primary Primary
Setup (1FO-1F7h) (1LFO-1F7h)
Auto Detect IDE Enabled Enabled
Drives
Large Disk DOS Enabled Enabled
Compatible
Set Hard Disk N/A N/A
1/2 1 3/4 Type

Cache Memory Memory Cache Enabled Enabled

Cache System
BIOS area

Write protect

Write protect

Cache Video BIOS
area

Write protect

Write protect

Cache Base Write back Write back
0-512 kbytes

Cache Base Write back Write back
12 kbytes—640

kbytes

Cache Extended Write back Write back
Memory area

Cache AOOO-AFFH Disabled Disabled
Cache BOOO-BFFF Disabled Disabled
Cache C800-CBFK Disabled Disabled
Cache CCO0O-CFFF Disabled Disabled
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repeat delay

Item Option Default setting CallPilot setting
Cache DO00O-D3FF Disabled Disabled
Cache D400-D7FF Disabled Disabled
Boot Options Summary screen Enabled Enabled
Floppy check Enabled Enabled
Quiet boot Disabled Disabled
Post errors Disabled Disabled
Keyboard features| Numlock Auto Auto
Key click Disabled Disabled
Keyboard auto 30/sec 30/sec
repeat rate
Keyboard auto 1/2 sec 1/2 sec

System Memory

Verify only

Extended Memory

Verify only
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Pentium Il BIOS advanced options

Default
Item Option setting CallPilot setting
Integrated Serial Port A Enabled Enabled
Peripherals
Serial Port A: Base| 3F8 3F8
/O Address
Serial Port A: IRQ 4 IRQ 4
Interrupt
Serial Port B Enabled Enabled
Serial Port B: Normal Normal
Mode
Serial Port B: Basel 2F8 2F8
/O Address
Serial Port B: IRQ 3 IRQ 3
Interrupt
Parallel Port Enabled Enabled
Parallel Port: Mode Bidirectional Bidirectional
Parallel Port: Base| 378 378
/O Address
Parallel Port: IRQ7 IRQ 7
Interrupt
Floppy Disk Enabled Enabled
Controller
Floppy Disk Primary Primary
Controller: Base I/
O Address
Local Bus IDE Enabled Enabled
Adapter
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Default
Item Option setting CallPilot setting
Adaptec Ultra Disabled Enabled for non-RAID
SCSI Adapter Disabled for RAID
SCSI Adapter 40 MHz 40 MHz
Frequency
Note: This is only
an option if the
Adaptec Ultra
SCSI Adapter is
enabled.
Advanced DRAM Speed nothing Do not change.
Chipset Control displayed
ECC/Parity Config| ECC Gen &| Parity Gen & Correct
Correct
Enable Memory Disabled Disabled
Gap
Release EO00 Disabled Disabled
DMA Aliasing Enabled Enabled
8-bit /0 Recovery | 4.5 4.5
16-bit 110 4.5 4.5
Recovery
ISA Bus Speed PCI Clock /| PCI Clock / 4 (8.33 MHZz)
4 (8.33
MH2z)
Watchdog Timer | Disabled Disabled
Status
Watchdog Timer 150 ms 150 ms

Delay
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Default
ltem Option setting CallPilot setting
PCI PCI IRQ Line 1 IRQ9 IRQ9
configuration
PCI IRQ Line 2 IRQ 10 IRQ 10
PCI IRQ Line 3 IRQ 11 IRQ 11
PCI IRQ Line 4 IRQ 15 IRQ 15
ISA Graphics No Yes
Device Installed
PCI/PNP ISA Available Available
UMB Region
Exclusion
C800 - DFFF
PCI/PNP ISA IRQ | Available Reserve IRQ5 if installing
Resource ISA CLAN card.
Exclusion:
IRQ3, IRQ4, IRQ5,
IRQ7, IRQY,
IRQ10, IRQ11,
IRQ12, IRQ14,
IRQ15
PS/2 Mouse Enabled Enabled
Onboard Speaker Enabled Enabled
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Default

Item Option setting CallPilot setting
Use 1.1 1.4
Multiprocessor
Spec
CPU BIOS Enabled Enabled
Update
Plug & Play OS No No
Secured Setup Yes Yes
Configuration
Large Disk DOS DOSs
Access Mode

Pentium Il BIOS security options

Item Option Default setting CallPilot setting
Supervisor Clear Clear
Password is
User Password is Clear Clear
Set Supervisor Clear Enter
Password
Set User Password Clear Enter
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Reminder

Item Option Default setting CallPilot setting
Password on Boot Disabled Disabled
Fixed Disk Boot Normal Normal
Sector

Disk Access Supervisor Supervisor
Virus Check Disabled Disabled
Reminder

System Backup Disabled Disabled

Pentium Il BIOS power options

Item Option Default setting CallPilot setting
Power Savings Disabled Disabled
Standby Timeout Off Off
Auto Suspend Off Off
Timeout
Hard Disk Timeout Disabled Disabled
Video Timeout Disabled Disabled
Resume on Modenm off off
Ring
Resume on Time Off Off
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Pentium Il BIOS boot options

Default settings

CallPilot setting

Disk Drive Disk Drive

Hard Drive ATAP| CD-ROM Drive
ATAP| CD-ROM Drive Hard Drive

Hard drive Option

Hard Drive SCSI Hard Drive

Pentium Il BIOS server options

Baud Rate

Item Option Default setting CallPilot setting
Console Redirect Disabled Disabled
Port
Console Redirect 9600 57600

IRQ mapping table

Refer to"IRQ mapping tableon page 192
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Dual Inline Memory Modules

Introduction

Dual Inline Memory Modules (DIMMs) are the memory modules located on the
SBC. The gold-plated edge connectors on DIMMs are designed to plug into
matching edge-connector slots. The design allows you to add or remove these
modules repeatedly without tools or damage. Install DIMMs on the Pentium I
SBC only.

Capacity

Use 168-pin Fast Page Mode (FPM) parity DRAM utilizing DIMM technology
with 60ns access times. A module has a capacity of 32, 64, or 128 Mbytes.
DIMMs require only one slot filled to compose a bank. There are four slots or
banks on the SBC. Install DIMMs in any slot, combination, or order. It is
recommended that bank 0 (DIMM 1) be filled to enable troubleshooting
procedures. Install up to 512 Mbytes of memory.

DIMM slots on a Pentium Il SBC
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Requirements

To add DIMMs to the card, you require the following:

an antistatic wrist strap
DIMMs with gold-plated edge connectors

To add DIMMSs to the SBC card

1

Remove the SBC card from the server.

Note: To remove old DIMMs, perform steps 2 and 3. To add new DIMMs, go
to step 5.

Push the DIMM release tab outwards at both sides of the DIMM to be
removed.

Hold the DIMM by its edges, being careful not to touch its components.
Remove the DIMM by lifting it away from its slot. Store it in an antistatic
package.

Remove other DIMMs as necessary.

Orient the DIMM so that the two notches in the bottom edge of the DIMM
align with the keyed slot.

Insert the bottom edge of the DIMM into the slot and press down firmly on
the DIMM until it seats correctly.

Note: When the DIMM seats correctly, release tabs lock back to an upright
position. If the DIMM does not seat correctly, remove it and reinstall. Do not
force the locking tabs to close.

Repeat the above two steps to install each additional DIMM.

Replace the SBC card in the server.
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Section G: The Pentium Il SBC card

In this section

The Pentium Il SBC card

236
Replacing the Pentium 1l SBC card 237
Upgrading the BIOS 239
Dual Inline Memory Modules 24
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The Pentium Ill SBC card

Introduction

This section describes the Pentium Il Single Board Computer (SBC) card. It
covers procedures for replacing and configuring the SBC card.

Procedures included

Procedures covered include the following:

m replacing the SBC card
m upgrading and configuring the BIOS
s adding memory DIMMs to the SBC

Intended audience

This section is written primarily for field service technicians. It is intended to act

as a guide for installing, repairing, replacing, and upgrading hardware and
software components. This section assumes that the reader has basic computing
skills, is familiar with necessary safety procedures, and has the hardware
documentation provided by the manufacturer available as a refefdnise.
information applies to the 1001rp server only.
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Replacing the Pentium Ill SBC card

Introduction

You should replace the SBC card when it fails. Use system diagnostic tools and
refer to error codes to determine whether the SBC card should be replaced.

The SBC is always installed in the SBC slot located between the ISA expansion
slots and the PCI slots on the backplane. The board features headers for
peripheral connections, jumper blocks, and DIP switches. It features two DIMM
sockets to support up to 512 Mbytes (two 256 Mbytes modules SDRAM ECC)
of Fast Page Mode memory on the Pentium Il SBC.

Requirements

Before replacing the SBC card, gather the following tools:
s one Phillips-head screwdriver

m  One antistatic wrist strap

m the replacement SBC card

= cable labels

To replace the SBC card
1  Power down the server.
Disconnect the power cord.
Remove the top cover.
Free and label all connectors from the SBC card.
Loosen and remove the screw located at the top of the 1/O bracket.
Remove the 1/O bracket.

Loosen and remove the screw located at the top of the card’s faceplate.

0 N o o~ WN

Loosen the SBC and pull it up from the backplane.
Note: You can now do the following:
m Replace the SBC with a new card. To replace it, continue with step 9.
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m  Upgrade the SBC by adding DIMM(s) to the card. To upgrade it, refer to
the procedure “To add DIMMs to the SBC card” on page 233.

m  Set dip switch #3 to upgrade the BIOS.

DANGER
A Risk of explosion

10

11
12
13
14

15

16

The SBC has a lithium battery installed. If you are
discarding the SBC, dispose of used batteries according
to the manufacturer’s instructions.

Remove the new card from its protective wrapping.

Align the card with its slot on the backplane and press it into place.

Result: The board seats properly in both the ISA-style and PCl-style
connectors.

Fasten the card down with the screw provided.
Install the new 1/O bracket.
Fasten the I/O bracket using the screw provided.

Remove the labels attached to all connectors and reconnect them to the
card.

Identify the Switch Block (SW1) location on the SBC. The Switch Block
contains four DIP switches (1-4) that you configure affecting on-board
ROM access, CMOS RAM, and configuration ports. Ensure dip switch
number 4 is set to the closed/on position. This setting ensures that
configuration ports are set to I/0O address 370-373.

Note: The default switch setting is open/off.

Replace the top cover.
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Upgrading the BIOS

Introduction

BIOS is the Basic Input/Output System of the computer. It is Flash ROM-based
code. The system is equipped with Flash BIOS, which enables you to upgrade
by running a single program that writes updated code to the Flash ROM chips.

When to configure the BIOS

BIOS configuration is necessary for first-time setup. Reconfigure the BIOS after
a BIOS or CMOS failure and recovery.

Requirements

= You need a bootable upgrade disk. For the Pentium Ill SBC, the Texas
Micro BIOS release number must be 4.06a.1.4a.

Contact your Nortel Networks customer representative to request a BIOS
upgrade disk.

= You must perform both of the following procedures to upgrade the BIOS:
m upgrading the BIOS
m configuring the SBC

Before you begin

Change the position of DIP switch #3 on the SBC to the Closed or ON position.

To upgrade the BIOS

1 Insertthe bootable BIOS upgrade disk into drive A and power on the server.

Note: You can obtain a BIOS upgrade disk from your Nortel Networks
customer support representative.

2 Allow the flash process to complete.
3 Power down the system.

4  Remove the top cover.
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Set DIP switch 3 to the ON position.
Power on the server.

Result: A message appears on the boot screen that the system is loading
BIOS defaults.

Power off the server after seeing the above message.
Return DIP switch 3 to the OFF position.

Replace the top cover.

Restart the system.

Configure the BIOS as described in the following procedure.

To configure the Pentium 11l SBC

1

Power on the system and press F2 to enter the CMOS Setup.

Note: For the following steps, use the arrow keys to navigate menus, and
press Enter to make a selection.

Result: The Setup Utility starts. The screen has two areas:

m  Options: The Options menu is on the left side of the screen, and is
composed of Basic options, Advanced options, and PCI options.

= Summary Information: The current settings appear on the right side of
the screen.

Select the items described in the tables that follow.
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Pentium IIl BIOS basic options

Note: The defaults must be loaded first.

Item Option Default setting CallPilot setting
Time and Date Set time and date N/A Current Date/Ti
Floppy Disks Floppy Controller Enabled Enabled
Select drive A Typg 3.5” 1.44 Mbytes 3.5" 1.44 Mbytes
Select drive B Typeg Disabled Disabled
IDE Adapter O Master CD-ROM CD-ROM
Slave None None
IDE Adapter 1 Master None None
Slave None None
Cache Memory Memory Cache Enabled Enabled

Cache System
BIOS area

Write protect

Write protect

Cache Video BIOS
area

Write protect

Write protect

Cache Base 0-512 Write back Write back
kbytes

Cache Base 512k—{ Write back Write back
640 kbytes

Cache Extended | Write back Write back
Memory area

Cache AOOO-AFFH Disabled Disabled
Cache BOOO-BFFF Disabled Disabled
Cache C800-CBFKF Disabled Disabled
Cache CCO0-CFFF Disabled Disabled

ne
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repeat delay

Item Option Default setting CallPilot setting
Cache DO00O-D3FF Disabled Disabled
Cache D400-D7FF Disabled Disabled
Boot Options Summary screen Enabled Enabled
Floppy check Enabled Enabled
Quiet boot Disabled Disabled
Post errors Disabled Disabled
Hard disk pre-delay Disabled Disabled
Keyboard features| Numlock Auto Auto
Key click Disabled Disabled
Keyboard auto 30/sec 30/sec
repeat rate
Keyboard auto 1/2 sec 1/2 sec

System Memory

Verify only

Extended Memory

Verify only
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Pentium IIl BIOS advanced options

Default
Item Option setting CallPilot setting
Integrated Serial Port A Enabled Enabled
Peripherals
Serial Port A: Base 3F8 3F8
/O Address
Serial Port A: IRQ 4 IRQ 4
Interrupt
Serial Port B Enabled Enabled
Serial Port B: Normal Normal
Mode
Serial Port B: Base| 2F8 2F8
I/O Address
Serial Port B: IRQ 3 IRQ 3
Interrupt
Parallel Port Enabled Enabled
Parallel Port: Mode Bidirectional Bidirectional
Parallel Port: Base| 378 378
I/0O Address
Parallel Port: IRQ7 IRQ 7
Interrupt
Floppy Disk Enabled Enabled
Controller
Floppy Disk Primary Primary
Controller: Base
/O Address
Local Bus IDE Enabled Enabled
Adapter
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Default
ltem Option setting CallPilot setting
Adaptec Ultra Disabled Enabled for non-RAID
SCSI Adapter Disabled for RAID
Advanced ECC ECC ECC
Chipset Control | ConfigDRAM
Speed
Enable Memory Disabled Disabled
Gap
Alias ISA 512 -528| Disabled Disabled
Mbytes
DMA Aliasing Enabled Enabled
8-bit /0 Recovery | 4.5 4.5
16-bit I/O 4.5 4.5
Recovery
Watchdog Timer | Disabled Disabled
Status
Watchdog Timer | 1.2 sec 1.2 sec
Delay
ISA bus GAT Disabled Disabled
PCI Delayed Enabled Enabled
transactions
PCI PCI IRQ Line 1 IRQ 9 IRQ 9
configuration
PCI IRQ Line 2 IRQ 10 IRQ 10
PCI IRQ Line 3 IRQ 11 IRQ 11
PCI IRQ Line 4 IRQ 15 IRQ 15
USB IRQ Enabled | No No
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Default
Iltem Option setting CallPilot setting
Latency timer Auto Auto
Cache line size Auto Auto
ISA Graphics No Yes
Device Installed
PCI/PNP ISA Available Available
UMB Region
Exclusion
C800-DFFF
PCI/PNP ISA IRQ | Available
Resource
Exclusion:
IRQ3, IRQ4, IRQ5,
IRQ7, IRQY9,
IRQ10, IRQ11,
IRQ12, IRQ14,
IRQ15
System Verify Verify
Management
PS/2 Mouse Enabled Enabled
On-board Enabled Enabled
Speaker
Use 1.1 1.4
Multiprocessor
Spec
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Default
Item Option setting CallPilot setting
CPU BIOS Enabled Enabled
Update
Plug & Play OS No No
Secured Setup Yes Yes
Configuration
Reset No No
configuration
data
Large Disk DOS DOS
Access Mode

Pentium Ill BIOS security options

Item Option Default setting CallPilot setting
Supervisor Clear Clear
Password is
User Password is Clear Clear
Set Supervisor Enter Enter
Password
Set User Password Enter Enter
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Item Option Default setting CallPilot setting
Password on Boot Disabled Disabled
Fixed Disk Boot Normal Normal
Sector
Disk Access Supervisor Supervisor
Virus Check Disabled Disabled
Reminder
System Backup Disabled Disabled

Reminder

Pentium IIl BIOS power options

Item Option Default setting CallPilot setting
Power Savings Disabled Disabled
Standby Timeout Off Off
Auto Suspend Off Off
Timeout
Hard Disk Timeout Disabled Disabled
Video Timeout Disabled Disabled
Resume on Modem Off Off
Ring
Resume on Time Off Off
Resume time 00:00:00 00:00:00
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Pentium Ill BIOS boot options

Default settings

CallPilot setting

Diskette Drive

Diskette Drive

Hard Drive

ATAP| CD-ROM Drive

ATAP| CD-ROM Dirive

Hard Drive

Removable Devices

Removable Devices

Network Boot

Network Boot

Device Option
Hard drive Bootable add-in card
Removable Devices Legacy floppy drive
Pentium Ill BIOS server options
Item Option Default setting CallPilot setting
Console Redirect Disabled Disabled
Port
Console Redirect 9600 57600
Baud Rate

IRQ mapping table

Refer to*IRQ mapping tabfeon page 192
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Dual Inline Memory Modules

Introduction

Dual Inline Memory Modules (DIMMs) SDRAM P100 are the memory
modules located on the SBC. The gold-plated edge connectors on DIMMSs are
designed to plug into matching edge-connector slots. The design allows you to
add or remove these modules repeatedly without tools or damage. Install
DIMMs on the Pentium Il SBC only.

Capacity

Use 168-pin Error Correction Control (ECC) SDRAM utilizing DIMM
technology. A module has a capacity of 32, 64, or 128 Mbytes or 256 Mbytes.
SDRAM DIMMs require only one slot filled to compose a bank. There are two
slots or banks on the SBC. Install DIMMs in any slot, combination, or order.
Nortel Networks recommends that bank 0 (DIMM 1) be filled to enable
troubleshooting procedures. Install up to 512 Mbytes of memory. These are
P100 FSB SDRAM DIMMs.

Requirements

To add DIMMs to the card, you require the following:

m  an antistatic wrist strap
s DIMMSs with gold-plated edge connectors

To add SDRAM DIMMs to the SBC card

1 Remove the SBC card from the server.

Note: To remove old DIMMs, perform steps 2 and 3. To add new DIMMs, go
to step 5.

2 Push the DIMM release tab outwards at both sides of the DIMM to be
removed.
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Hold the DIMM by its edges, being careful not to touch its components.
Remove the DIMM by lifting it away from its slot. Store it in an antistatic
package.

Remove other DIMMs as necessatry.

Orient the DIMM so that the two notches in the bottom edge of the DIMM
align with the keyed slot.

Insert the bottom edge of the DIMM into the slot and press down firmly on
the DIMM until it seats correctly.

CAUTION
& Risk of equipment damage

When installing a DIMM in slot 1, the IDE locking latch
might get in the way and cause a memory chip to snap
out of the board.

When the DIMM seats correctly, release tabs lock back to an upright
position. If the DIMM does not seat correctly, remove it and reinstall. Do not
force the locking tabs to close.

Repeat the above two steps to install each additional DIMM.

Replace the SBC card in the server.
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Section H: Adding and replacing switch-
specific boards and cards

In this chapter

Replacing MPB16 boards 252
Adding a VoiceBridge 2000 card 260
Replacing the VoiceBridge 2000 card 262
Replacing the DT1/480SC board 264
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Replacing MPB16 boards

Introduction

This section describes replacing MPB16-4, MPB16-2T boards, and MPC-8
cards.

The parts to install

The MPB16 board comes in two different versions:

s MPB16-4 (for the Meridian 1, MSL-100/DMS-100, Lucent, Mitel, and
Rolm switches)

s MPB16-2T (for the Matra switches)

MPB16-4 (NTRH20BA)

There are four slots available on the MPB16-4 (NTRH20BA) to hold four
MPC-8 cards.

SChus connector

DB-25 —#
connector

There is also a DB-25 pin digital connector.

MPB16-2T (NTRH21CA) board

The MPB16-2T/LS*16 is a PCI form-factor card that includes two bays to hold
MPC-8 DSP cards.
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Note: The MPB16-2T/LS*16 is referred to as the MPB16-2T for the remainder
of this document.

Below is a picture of the MPB16-2T with analog mezzanine and two MPC-8
cards installed.

NORTEL

MPC 8

Analog loop start cable (NTRH0914)

The following photograph shows the 10-meter NTRH0914 analog loop start
cable. The DB-37 end connects at the back of the server to the MPB16-2T. The
other end of the cable must be stripped and connected to a bix block servicing
the Matra switch.
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CT-Bus cable (NTRH0915)
The CT-Bus ribbon cable is used to series two MPB16-2T cards in a single
server. The connectors are keyed to optimize correct installation.

MPC-8 card

The MPC-8 is a credit card-sized PC card that plugs into all MPB16-2Ts. The
MPC-8 provides multimedia expansion to the MPB16-2T. Below is a picture of
an MPC-8.

NGRTEL

NTREBIAA

MPC-8

MULTIMEDIA
PROCESSING
CARD

Maximum number of MPC-8s per server

The server supports up to a maximum of two fully loaded MPB16 boards, which
provides 96 channels, or 64 channels (if the MPB16-2T board is used), as shown
in the following table:
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Maximum multimedia
channels

Optional MPC-8s

One MPB16-4

48
(16 of which are built into the
MPB16-4 board)

4
(provides up to 32
additional channels

Two MPB16-4s

96
(32 of which are built into the
two MPB16-4 boards—16
channels per board)

8
(provides up to 64
additional channels

One MPB16-2T

32
(16 of which are built into the
MPB16-4 board)

2
(provides up to 16
additional channels

Two MPB16-2Ts

64
(32 of which are built into the
two MPB16-4 boards—16
channels per board)

4
(provides up to 32
additional channels

Maximum number of MPB16-2Ts per server

The server supports up to a maximum of two fully loaded MPB16-2Ts, which
provide 32 channels each for a maximum of 64 channels, as shown in the

following table:

Embedded multimedia

Optional MPC-8s

channels
One MPB16-2T 16 2
(provides up to 16
additional channels
Two MPB16-2Ts 32 4

(provides up to 32
additional channels
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Installing the MPC-8 cards

CAUTION
& Risk of electrical damage

Wear an antistatic ESD wrist strap when handling
multimedia processing boards and cables.

ATTENTION
Risk of system damage

MPC-8 cards are not hot-pluggable. Power down your server
before installing the cards.

1 Slide the MPC-8 into any available bay on the MPB16-2T with the label side
up.

2  Press the MPC-8 gently into the bay until you feel the card slide firmly into
place. If the card is placed in upside down, it will not slide completely into
the bay.

Note: To simplify the installation, install the MPC-8 into the MPB16-2T prior
to installing the MPB16-2T in the server.

Installing the MPB16-2T board

DANGER

Risk of electrical shock
Disconnect the AC power and remove the AC power cord from the
host product.

1 Remove the chassis cover.

2 Disconnect the CT-Bus cable from the existing MPB16-2T board.

3 Remove the existing MPB16-2T from its slot in the backplane. Retain the
screw to reuse when installing the new board.

4  Press the MPB16-2T firmly into its slot in the backplane.

Note: Take care to slide the MPB16-2T board carefully past the protective
foil strips, as they are easily damaged.
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5  Secure the board at the rear of the server using the same screw you
removed earlier.

6 If are installing a second MPB16-2T board, repeat steps 1 through 4.

7  If you have two MPB16-2Ts installed in the server, use the CT-Bus cable to
connect the two boards. This cable is keyed; do not force the cable onto the
card connectors.

8 Replace the server cover.

Note: Be careful not to pinch any cabling when sliding the server cover
back on.

9  Connect the NTRH0914 loop start cable from the MPB16-2T board to the
Matra switch. This cable connects to the punch-down panel servicing the
Matra switch.

10 Run the Configuration Wizard to detect the new hardware.

Result: The MPB16 installation is complete.

DSP numbering

Use the following table as a guide for DSP numbering with multiple MPB16-2T
cards:

MPB16-2T board DSP assignments

First MPB16-2T 1 and 2 = embedded
3 and 4 = MPC-8

Second MPB16-2T | 7 and 8 = embedded
9 and 10 = MPC-8
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MPC-8 cards are counted from the handle side of the MPB16-2T, as shown in
the following photograph.

Second MPB16-2T
DSP 10 DSP 9

Installing the MPB16-4 boards

DANGER

Risk of electrical shock

Disconnect the AC power and remove the AC power cord from the
host product.

1 Remove the chasis cover.
2 Disconnect the SCbus cable from the existing MPB16-4 board.

3 Remove the existing MPB16-4 board from its slot in the backplane. Retain
the screw to reuse when installing the new board.
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Press the MPB16-4 boardfirmly into its slot in the backplane.

Note: Take care to slide the MPB16-4 board carefully past the protective
foil strips, as they are easily damaged.

Secure the board at the rear of the server, using the same screw you
removed earlier.

If are installing a second MPB16-4 board, repeat steps 1 through 4.
Replace the server cover.

Note: Be careful not to pinch any cabling when sliding the server cover
back on.

Run the Configuration Wizard to detect the new hardware.

Result: The MPB16 installation is complete.
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Adding a VoiceBridge 2000 card

Introduction

This section describes how to add a VoiceBridge 2000 Digital PBX/CBX
integration card (also referred to as the VB2000 card). This card is installed in
the server and supports connection to a Lucent, Mitel, or Rolm switch.

Types of VoiceBridge 2000 cards

Switch

VB2000 card model  Part number

Lucent 2-wire port type

Lucent Definity Generic 3 VB-2009 NTRH9060
Mitel

SX-200D, SX-200 Light, SX-2000 Light, | VB-2007 NTRH9059
SX-2000 S, SX-2000 VS

Rolm

8000 CBX, 9000 CBX, 9751 CBX VB-2002 NTRH9057

Note: These cards are identical in external appearance, and the procedures for
installing and configuring them are the same.

The 1001rp can have a maximum of two VoiceBridge 2000 boards installed. The
first board should be installed in ISA slot 1, and the new board in ISA slot 2.
Refer to the picture on pad@0for the location of the ISA slots.

To install the VoiceBridge 2000 card

1  Shut down Windows NT and power down the server.
2 Remove the chassis cover.

3 Write down the serial number of the new VoiceBridge 2000 board.
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4 Remove the screw holding on the cover of the ISA slot and remove the
cover.

5 Insert the VoiceBridge 2000 board and secure it with the screw.

6  Connect the SChus cable so that it interconnects both of the VoiceBridge
boards and the MPB16-4 board.

7  Replace the chassis cover.

8 Connect the external cable to the PBX connector on the back of the
VoiceBridge 2000 board.

9 Restart the server and log on to Windows NT.

10 Run the VTG Configuration application (d:\nortel\bin\vtgconfiguration.exe).

11 Click ADD.
Result: The Add Board dialog box appears.

12 Enter the serial number of the new VTG board and click OK.

13 Click Close.
Result: The VTG Configuration closes.

14 Run the Configuration Wizard to reconfigure the VTG channel

configuration.

The VoiceBridge 2000 card installation is complete.
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Replacing the VoiceBridge 2000 card

Introduction

This section describes replacing the VoiceBridge 2000 Digital PBX/CBX
integration card (also referred to as the VB2000 card). This card is installed in
the server and supports connection to a Lucent, Mitel, or Rolm switch.

Types of VoiceBridge 2000 cards

Switch VB2000 card model Part number

Lucent 2-wire port type

Lucent Definity Generic 3 VB-2009 NTRH9060
Mitel

SX-200D, SX-200 Light, SX-2000 Light, | VB-2007 NTRH9059
SX-2000 S, SX-2000 VS

Rolm

8000 CBX, 9000 CBX, 9751 CBX VB-2002 NTRH9057

Note: All these cards are identical in external appearance, and the procedures for
installing and configuring them are the same.

To install the VoiceBridge 2000 card in the server
1 Disconnect the external cable from the VoiceBridge2000 card.
2 Remove the chassis cover.
3  Disconnect the internal SChus cable from the VoiceBridge2000 card.
4  Remove the existing VoiceBridge 2000 card from its ISA slot.
5 Remove the new VoiceBridge 2000 card from its ESD bag.
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10

11

12
13
14
15

16
17

18

Write down the VoiceBridge 2000 card serial number, which is printed on
the backplate of the card, and the slot number. The serial number is shown
as “S/N: XXxxx.”

Insert the VoiceBridge 2000 card into the ISA slot. The PBX connector
should be positioned in the open slot in the backplane.

Replace and tighten the retaining screw to secure the board.
Repeat steps 2 to 4 for each VoiceBridge 2000 card.

The SCbus cable consists of two connectors at one end (intended for the
MPB16-4s), a large gap with no connectors, and then seven connectors at
the other end (intended for the VoiceBridge 2000 cards).

Use the SChbus cable to connect the MPB16-4 and VoiceBridge 2000 cards.
Put the cover back on the server.

Note: Be careful not to pinch the SChus cable when sliding the server
cover back on.

Power up the server and log on to Windows NT.

Run the VTG Configuration application (d:\nortel\bin\vtgconfiguration.exe).
Select the serial number of the board that was removed and click Delete.
Click ADD.

Result: The Add Board dialog box appears.

Enter the serial number of the new VTG board and click OK.

Click Close.

Result: The VTG Configuration closes.

Run the Configuration Wizard to reconfigure the VTG channel
configuration.

Result: The VoiceBridge 2000 card installation is complete.
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Replacing the DTI/480SC board

Introduction

This section describes replacing the DTI/480SC board. The DTI/480SC board
provides a T1 network interface to the switch.

Switch settings

Board locator switch (SW100)

Switch SW100 is used to assign the unique board locator ID. The
installation procedure instructs you to assign a unique board locator ID to
each board.

Remote Loopback Switch

The loopback switch is factory-set to ON for normal mode. You can move
the loopback switch to the OFF position for loopback mode as part of
troubleshooting a system problem.
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DTI/480SC board - switch locations

SW100
Loopback
switches
Normal mode
SPanis Default
Span 1 Span 1 Span 1

Loopback

switches

Remote loopback
mode

—— Lm—) ~{ O
Red Vam
Yellow
Green

Dual RJ-48C Status Loopback Loopback
jacks lights switches LED

(G101466

Installing the DTI/480SC boards

1 Remove the chassis cover.

2 Remove the existing DT1/480SC from its ISA slot in the backplane. Retain
the screw to reuse when installing the new board.
3 Remove a DTI/480SC board from its ESD bag.
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10

11

On the board, dial the rotary switch (SW100) to select a number. Set the
first board to 0, the second to 1, and so on.

The switch has hexadecimal numbers ranging from 0 to F inclusive. See
“DT1/480SC board - switch locations” on page 265.

Ensure that the loopback switch is in the ON (down) position. See “DTI/
480SC board - switch locations” on page 265.

Use the slot’s board guides as you insert the board edge connector into the
slot. Press firmly until the board is securely seated in the slot.

Replace and tighten the retaining screw to secure the board.
Repeat steps 2 to 7 for each DTI/480SC board you are installing.

Use the SCbus cable to connect the MPB16-4 and DTI/480SC boards. See
“DTI/480SC board - switch locations” on page 265 for the location of the P4
connector.

The SCbus cable consists of two connectors at one end (intended for the
MPB16-4s), a large gap with no connectors, and then seven connectors at
the other end (intended for the DT1/480SC boards).

Put the cover back on the server.

Note: Be careful not to pinch the SChus cable when sliding the server
cover back on.

Run the Configuration Wizard to detect the new hardware.

Result: The board installation is complete.
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Section I:  Media drive bay

In this section

About the media drive bay

N
(o]

Removing drive carriers from the media drive bay

N
(o]

Replacing a drive in the media bay

N
~J
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About the media drive bay

Overview

Media drive bays contain media devices, including CD-ROM and tape and
floppy drives. If your media drives become damaged or you want to upgrade,
you can replace these drives. This section provides procedures for replacing or

upgrading any device in the drive bay.

Procedures
Perform the procedures for replacing media devices in the following order:
1. removing drive carriers
2. removing media drives

3. Replacing a drive in the media bayr
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Removing drive carriers from the media drive
bay

Introduction

When replacing the media hard drives, the first step is to remove the drive
carriers from the drive bay. Each drive carrier holds one media drive.

Requirements

To remove the drive carrier from the media drives, you require the following:
m  keys for the front bezel doors

m  a Phillips screwdriver

= cable identification labels

= apen or pencil

Locate the media drives

Media drives are located at the front of the chassis, below a cooling fan, and
beside the hot-swappable SCSI drive bay. Access installed media devices
through the key-lock media door.
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The media drive bay

0520050550 U
::’:03300’
09g00"®

Media carrier

The media drive houses up to four devices. A drive carrier holds each device.
Where no device is installed, a blank panel is secured to the drive carrier for

protection.
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Media carrier slot assignment

The carrier is designed to stack three devices horizontally, and to house the
floppy drive vertically to the right side of the carrier frame. The following
illustration shows the orientation of the drives, and the standard slot assignment
for each of the required devices:

CD-ROM

Tape drive

Floppy drive

Blank panel

To remove device carriers from the media drive bay

DANGER

Risk of electrocution
High current inside the chassis can cause severe injury.

CAUTION
& Risk of equipment damage

Electrostatic discharge due to improper handling can cause
components to be damaged or rendered unusable.

1 Remove the front bezel from the chassis.

2 Locate the media drive, and loosen the four Phillips-head screws and
washers securing the carrier to the drive bay.
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3 Holding cables away from the drive bay, pull the carrier away from the
chassis until the connectors attached behind the components can be
reached.

CAUTION
& Risk of equipment damage

Cables can be easily damaged during this procedure. Check
that no cables are crossed when moving the carrier in and out
of the drive bay.

4  Label and disconnect cables from installed media drives, and then free the
carrier from the chassis.
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See also
m  Removing and installing the front bezel
m  Configuring and replacing hard drives

What's next?

Once you have removed the device carriers from the media drive bay, remove the
media drive devices.
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Replacing a drive in the media bay

Introduction

The third step in replacing a media drive is to install the new drive in the media
bay.

Requirements

To install media drives into the carrier, you require the following:
m  a Phillips screwdriver

m  four screws from the previous procedure

m  keys for locking the front bezel

To install a drive in the media bay

1 Slide the new drive into the drive carrier, and secure it with four undercut
Phillips-head screws.

2 Reattach the removed devices to access a specific drive slot.

3 Position the carrier to the drive frame, leaving enough room to reach behind
the carrier, and attach the connectors.

4 Carefully connect the device and power cables, and then slide the carrier
into the drive bay, checking that the cables are free and undamaged.

Note: If your tape drive is a narrow device, you require a wide to harrow
adapter to connect to the wide SCSI cable.

5  Secure the carrier to the chassis with four Phillips-head screws.

6  Replace and lock the front bezel.
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Before you begin the installation

Introduction

This chapter outlines procedures for installing Windows NT 4.0 software on the
server.

Some of these procedures are necessary only if you must install the base
software as a failure recovery procedure.

Requirements

The following is a list of the media and data components you should have before
starting the Windows NT installation.

Disks received with CallPilot
s Windows NT setup disks (3 disks)
s MS-DOS 6.20 setup disks

Disks you must create

You must copy several drivers from the Application Server Driver CD to disk
before starting the Windows NT installation. You will be prompted during the
installation to insert the driver disk when appropriate.

Refer to “Copying drivers from CD” on page 279 to determine the procedure for
working with the drivers.

Label Contents

NTRH8003 PCI RAID driver Mylex RAID Driver
NTRH8023 SCSI driver Symbios SCSI Driver

NTRH8013 PCI Ethernet drivers  Intel Ethernet NIC Driver

CDs
m  Application Server Driver CD
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s MAS 2.0 Operating System CD

Configuration information

Use the following table to record data that you need to enter during the

installation of Windows NT. Consult with the company’s network administrator
to obtain the values for the items listed in the table.

Item

Information from company’s
network administrator

Name

Company name

Computer name

Administrative account password

Remote Access

Begin

End

From

To

Excluded

Network - IP address

IP address

Subnet mask

Default gateway

Network - DNS

Host name (= Computer name)
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Item

Information from company’s
network administrator

Domain

DNS Service Search Order

Domain Suffix Search Order

Network - WINS

Primary WINS server

Secondary WINS server
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Copying drivers from CD

Introduction

The network drivers that you need to install during the Windows NT installation
are provided on the Application Server Driver CD that is supplied with your
CallPilot system. For some drivers to be functional, you must copy the drivers to
disks and label them accordingly.

Requirements

Application Server Driver CD
blank disks (supplied with CallPilot)

To copy drivers to disk

1
2

Power up the server.
Insert the Application Server Driver CD into the CD-ROM drive.

Result: The CD starts a DOS session. After a few minutes, the MS-DOS
6.2 Startup Menu appears.

Select the appropriate platform type and press Enter.
Result: The platform menu appears.
Select the appropriate option, depending upon the driver you want to copy.

Result: The system responds with the following message: Please
insert a floppy into drive A. Press any key to
continue...

Insert a disk into the floppy drive and press any key.

Result: You are asked if you want to format the disk. Press N if the disk is
blank or Y if the disk contains unwanted data.

If you select Y, DOS performs a quick format of the disk and alerts you
when the format is complete.

The drivers are then copied to disk. When the copying is complete, the
following message appears: Diskettes successfully completed
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Some drivers require more than one disk. After DOS has finished copying
drivers to Disk 1, it displays the following message: [X] files copied

You are prompted to insert a blank disk into drive A. Repeat step 5 for each
subsequent disk.

7  Repeat steps 4 to 6 for each driver you want to copy.

8  Nortel Networks recommends that you label the disks with the name
specified in the “Disks you must create” table on page 276.
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Preparing the platform

To create the FAT partition

1

10

11

Insert MS-DOS Setup Disk 1 in the floppy drive. Power up the system.

Result: The system starts and after approximately 3 minutes displays the
MS-DOS Setup screen.

Press F3, and when prompted, press F3 again.

Result: The A:\> prompt appears.

Type fdisk and press Enter.

Result: The Fixed Disk Setup Program appears.

Type 1 (Create DOS Partition) and press Enter.

Result: The Create DOS Partition menu appears.

Type 1 (Create Primary DOS Partition) and press Enter.

Result: You are prompted to use the maximum size for the partition.
Type N (Do not use maximum partition size) and press Enter.
Result: You are prompted to enter primary partition size.

Enter 600 as the partition size for 4095 Mbyte hard drives, or 1024 for 9
Gbyte hard drives, and press Enter.

Result: A 600 or 1024 Mbyte Primary DOS partition is created.
Press Escape to exit.

Result: The main fdisk menu appears.

Type 2 (Set active partition) and press Enter.

Result: You are prompted to enter the active partition.

Type 1 and press Enter.

Result: The primary partition is set to active.

Press Escape to exit.

Result: The main fdisk menu appears.
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12 Press Escape to exit the fdisk program.
Result: You are prompted to restart the system.
13 Press Ctrl + Alt + Delete to restart the system.

Result: The system restarts. Power down the computer to prepare for the
Windows NT installation.
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Installing the Windows NT server operating
system

To install the Windows operating system

ATTENTION
Before you start, ensure that the server is powered down.

1 Insert Windows NT Setup Disk 1 in the floppy drive, and power up the
server.

Result: The system starts, the disk loads, and after approximately five
minutes, a prompt appears for Disk 2.

2 Insert Windows NT Setup Disk 2, and press Enter.

Result: Setup loads files from Disk 2. The Windows NT Setup screen
appears.

3 When prompted, press Enter to begin installation of Windows NT.

Result: On the Windows NT Server Setup screen, Setup prompts you to
select automatic or manual detection of mass storage controllers.

4  Type S to skip automatic detection of mass storage controllers.
Result: Setup prompts you to select mass storage controllers.
5  Type S to select a controller.
Result: Setup displays a list of controllers.

6  Use the UP arrow key to scroll through the list and highlight
IDE CD-ROM (ATAPI 1.2) / PCI IDE Controller, and press Enter.

Result: Setup prompts you to insert Windows NT Setup Disk 3 in the floppy
drive.

7 Insert Disk 3 and press Enter.
Result: The Setup window appears.
8 Type S to select another controller.

Result: Setup displays a list of controllers.
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10

11

12

13

14
15

16

Highlight Other (Requires disk provided by a hardware manufacturer) and
press Enter.

Result: You are prompted to insert the manufacturer’s support disk.

Note: You should have created this disk as part of the preparation for
installation. If you have not created this disk, refer to “Copying drivers from
CD” on page 279 for instructions on creating the disk.

If your system has a RAID controller, insert the NTRH8003 PCI RAID
driver disk. Otherwise, insert the NTRH8023 Symbios SCSI driver disk.
Press Enter.

Result: You are prompted to choose the correct driver for the installed
hardware.

Highlight the appropriate driver for the platform and operating system
version and press Enter.

Result: The driver is loaded from the disk.
Press Enter to continue the setup.

Result: Setup prompts you to insert Windows NT Setup Disk 3 in the floppy
drive.

Insert Disk 3 and press Enter.

Result: Setup loads drivers from the disk.

ATTENTION
On 9-Gbyte hard disk systems, the following message

might appear: Setup has determined that one of
your hard disks has more than 1024
cylinders... . This is not a cause for concern.
Remove Windows NT Setup Disk 3 from the floppy drive.
Press Enter to continue.

Result: The system loads more driver files, then prompts you to insert the
Windows NT Server CD-ROM into the CD-ROM drive.

Insert the CD-ROM labeled “MAS 2.0 Operating System CD” and press
Enter.

Result: The Windows NT licensing agreement appears.
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17

18

19

20

21

22

23

24

25

Setup requires you to scroll down to the end of the text with the Page Down
key. Press F8 to agree with the licensing agreement.

Result: Setup displays the list of installed hardware components.
Highlight The above list matches my computer, and press Enter.
Result: The Windows NT disk partitioning screen appears.
Select C:FAT ... 600/1024MB option. Press Enter.

Result: The system responds with the following message: The
partition you have chosen is recognized by Windows NT

but is unformatted or damaged. Setup will have to

reformat this partition to install Windows NT on it.

Type C to continue using the unformatted partition.

Result: The system responds with the following message: You have
asked to install Windows NT on the patrtition: “C:
Unformatted or damaged..600MB or 1028MB

Highlight the Format the partition using FAT file system, and press Enter.

Result: Setup prompts you to choose the location where you want the
Windows NT files installed.

Press Enter to accept the default installation path (\WINNT).
Result: Setup prompts you to perform a comprehensive disk check.

Press Enter to perform an exhaustive secondary examination of your hard
drive.

Result: Setup prompts you to insert a driver disk.

If your system has a RAID controller, insert the NTRH8003 PCI RAID
driver disk. Otherwise, insert the NTRH8023 Symbios SCSI driver disk.
Press Enter.

Result: Setup copies installation files to the hard disk, and prompts you to
restart.

Remove the MAS 2.0 Operating System CD from the CD-ROM drive,
remove the SCSI/RAID driver disk from the floppy drive, and press Enter to
restart the computer.

Result: The system restarts and begins the graphical portion of Windows
NT setup. After approximately 3 minutes, you are prompted to insert the
CD-ROM labeled “MAS 2.0 Operating System.”
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To complete the Windows NT 4.0 setup

1

Insert the MAS 2.0 Operating System CD in the CD-ROM drive and click
OK.

Result: Setup copies files to the system, then it prompts you to start the
Windows NT Setup Wizard.

Click Next to continue.

Result: Setup prompts you to enter the customer name and company
name.

Enter the name and company name, and click Next.
Result: Setup prompts you to enter the product ID.

Enter the assigned product ID and click Next to continue. The product ID is
listed on the Certificate of Authenticity that is supplied with your server.

Result: Setup prompts you to choose the Windows NT 4.0 licensing mode.

On the licensing mode screen, select Per server, specify 5 as the number
of concurrent connections, and click Next to continue.

Result: Setup prompts you to enter the computer name.

Note: The customer supplies the computer name.

Enter the computer name, and click Next to continue.

Result: Setup prompts you to select the computer’s role.

Select the radio button for Stand-Alone Server, and click Next to continue.

Result: Setup prompts you to enter the password for the Administrator
account.

Note: Passwords are case-sensitive. Ensure that the Caps Lock key on the
keyboard is not on accidentally.

Enter the Administrator account password, and reenter it to confirm it.

Note: If installing at a customer site, enter the password specified by the
Network Administrator.

Click Next to continue.

Result: Setup prompts you to create an Emergency Repair Disk.
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To create an emergency repair disk

10

Because the Setup process installs further changes, if you create the
emergency repair disk now, you must update the disk at the end of the
installation process, using the RDisk.exe utility. To skip making a repair disk
now, continue to step 13. When you are ready to make a repair disk (after
installation is finished and just before putting the system into service),
follow the procedure called “Making an emergency repair disk” on page
325. An emergency repair disk is important for support purposes.

Click Yes, create an emergency repair disk (recommended), and click Next
to continue.

Result: Setup prompts you to select the Windows components to install.

To install Windows components

11

12

13

Ensure that the component check boxes are selected as follows:

a. Accessibility Options, Games, Multimedia, and Windows Messaging
components are unchecked.

b. Check the Accessories component and then click Details. Uncheck all
subcomponents except for the WordPad component. Click OK when
done.

¢. Check the Communications component and then click Details.
Uncheck all subcomponents except for the HyperTerminal component.
Click OK when done.

Click Next to install the accessories you have chosen for Windows NT.
Result: Setup prompts you to begin the setup of Windows NT Networking.
Click Next to install Windows NT networking.

Result: Setup prompts you to select how Windows NT participates on the
network.

To configure the server for network use

14
15

Click This computer will participate on a network.
Ensure that the component check boxes are selected as follows:
m  Wired to the network—Checked

m  Remote access to the network—Unchecked
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16

17

18

19

20

21

22

23

24

25

Click Next to continue.
Result: Setup prompts you to install the Internet Information Server.

Uncheck the “Install Microsoft Internet Information server” check box and
click Next.

Result: Setup prompts you to install the network adapters.
Click Select from List to select the ELAN network card driver.
Result: Setup displays a list of network adapters.

Click Have Disk... to load the ELAN network card driver from the disk in the
floppy drive.

Result: Setup prompts you to insert the network card driver disk for the
ELAN card in the floppy drive.

Insert the NTRH8013 Ethernet driver disk in the floppy drive and click OK to
continue. Specify the path if it is other than A..

Note: You should have created this disk as part of the preparation for
installation. If you have not created this disk, refer to “Copying drivers from
CD” on page 279 for instructions on creating the disk.

Result: Setup prompts you to select the appropriate network card driver
from a list.

Click the check box that describes the appropriate installed network
adapter, and click OK to accept the selection.

Result: Setup returns to the Network Adapter setup screen. The driver you
loaded from the floppy disk is listed and checked.

Click Next to continue.

Result: Setup prompts you to select the network protocols to install.
Ensure that the check boxes are selected as follows:

m  TCP/IP Protocol: Checked

m  NWLink IPX/SPX Compatible Transport: Unchecked

m  NetBEUI Protocol: Unchecked

Click Next to continue.

Result: Setup prompts you to select which network services are installed.
From the Network Services Installation screen, click Select from List... .

Result: Setup displays a list of network services.
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26

27
28

29
30

31

32

33

34

35

Use the arrow keys to scroll to SNMP Service, then click OK.

Result: You are returned to the Network Services Installation screen.
Click Select from List... to add additional network services.

Select Microsoft TCP/IP Printing and click OK.

Result: You are returned to the Network Services Installation screen.
Click Select from List... to add additional network services.

Select Remote Access Service and click OK.

Result: You are returned to the Network Services Installation screen.
Click Next to continue.

Result: Setup prompts you to confirm the installation of network
components.

Click Next to install the selected networking components.
Result: Files are copied to the system.
Click Next to continue.

Note: At this point, Setup might prompt you with a dialog box indicating that
the network card driver was loaded successfully, and you are offered a
chance to run a diagnostics check. Follow the instructions on the screen to
perform the test. A setup message might be: A network card of this

type is already installed in the system, do you want to

continue?  Click OK to continue. This message appears when both the
ELAN and CLAN cards are of the same make, model, and manufacturer.
Click OK to complete the tests, then click OK to continue with the
installation process.

You are given the option to use DHCP to configure the network. Click No to
indicate that you do not wish to install DHCP.

Result: Setup prompts you to configure the SNMP Service. Because this
service is added only to provide additional Performance Monitor counters,
you do not need to configure it.

Click OK to accept the default SNMP configuration.

Result: The Add Remote Access Setup Device screen message displays
the following message: There are no RAS capable devices to
Add. Do you want RAS setup to invoke the Modem Installer
to enable you to add a modem?
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36

37
38

39
40

41

42

43

44

45

Click Yes to invoke the modem installer.

Result: The Install New Modem screen appears.

Check the box, Don’t detect my modem, | will select it from a list.
Click Next.

Result: Manufacturers and models appear in the Install New Modem
screen.

Select US Robotics Inc. from the Manufacturer list.
Select Sportster 28800-33600 External from the Model list.

Note: If the manufacturer and model for your modem is not listed, select
“Standard Modem types” as the Manufacturer and “Standard 28,800 bps
Modem” as the Model.

ATTENTION
If your modem is not listed and you have the

manufacturer’s installation disk, click Have disk... and
follow the instructions on the screen.

Click Next on the Install New Modem screen showing manufacturers and
models.

Result: Setup displays the port selection screen.
Click the radio button for Selected ports, click COM1, then click Next.
Result: The Location Information screen appears.

Select the customer’s country, area code, and dialing option, then click
Next.

Result: Setup displays the message Your modem has been setup
successfully.

Note: The information you enter at this step can be changed later by
double-clicking the Modems icon in the Control Panel, selecting this
modem, and then clicking Properties.

Click Finish to complete the modem installation.
Result: Setup displays the Add RAS Device screen.
Click OK to close the Add RAS Device screen.

Result: Setup displays the Remote Access Setup screen.
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46

47

48

49

50
51

52

Click Configure... .

Result: Setup displays the Configure Port Usage screen.
Select the Receive Calls Only radio button, then click OK.
Result: Setup redisplays the Remote Access Setup screen.
Click Network... .

Result: The Network configuration screen appears.

Ensure that the component check boxes are selected as follows:

Allow remote clients running:

= NetBEUI: Unchecked

m TCP/IP: Checked

m |PX: Unchecked

Encryption settings:

m  Require Microsoft encrypted authentication: Checked
m  Require data encryption: Unchecked

m  Enable multi-link: Unchecked

Click OK to display the RAS Server TCP/IP Configuration dialog box.

On the dialog box, make the following selections:

a. Under Allow remote TCP/IP clients to access, select This computer

only.
b. Select Use static address pool.

Note: For the next two selections, if installing at a customer site, the

customer must provide these addresses.

c. Enter Begin and End addresses (for example, 192.168.0.40 and

192.168.0.254)

d. Enter From and To addresses, and enter excluded ranges, if any.

e. Uncheck Allow remote clients to request a predetermined IP address.

Click OK to redisplay the Remote Access Setup screen.
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53

54

55

56

57

58

59

Click Continue.

Result: Files are copied to the system. Setup displays the Microsoft
TCP/IP Properties window and prompts you to enter the TCP/IP
parameters.

Enter the values provided by the customer’s Network Administrator for
m IP Address (for example, 1.1.1.1)

m  Subnet Mask (for example, 255.255.255.0)

m Default Gateway

m  Primary WINS Server

Click OK.

Result: You are returned to the Windows NT Server Setup screen showing
bindings.

Click Next to accept the defaults of the binding order of network services.
Binding order is optimized later in the installation.

Result: Setup indicates that Windows NT will start the network.

Click Next to display the message that Windows NT Setup will start the
network, and click Next again.

Result: Windows NT Setup starts the network, and prompts you to enter
Domain/Workgroup settings.

ATTENTION
This dialog box configures the Domain/Workgroup

settings for the CallPilot server.
Enter the Domain/Workgroup information.

Note: The customer’s network administrator supplies the name of the
workgroup.

ATTENTION
The computer must not belong to a Windows NT domain.

Click Next to add the computer to the workgroup.

Result: Windows NT prepares to complete the setup.

292

CallPilot



May 2000

Installing operating system software

60

61

62

63

64

65

66

67

68

69

Click Finish to proceed.
Result: You are prompted for Date / Time configuration settings.

Enter the correct date and time, and select the time zone. Check the check
box to Automatically adjust clock for daylight saving changes.

Click Close.

Result: Windows NT Setup detects the installed display adapter.
Click OK to accept the display adapter Windows NT has detected.
Result: Setup prompts you to configure the display adapter.
Ensure that you select the following values:

m Color Palette: 16 Colors

m  Desktop Area: 640x480

s Font Size: Small Fonts

m Refresh Frequency: Use default hardware settings

Note: You must test these settings before Windows NT Setup allows you to
proceed.

Click Test to start the test.
Result: Setup prompts you to continue with the test.
Click OK to proceed with the display settings test.

Result: A test screen appears. After five seconds, Setup prompts you to
respond whether you saw the bitmap properly.

Click Yes.

Result: Setup prompts you to save the display settings.

Click OK to save the display settings and continue.

Result: You are returned to the display settings configuration screen.

Click OK to finalize the display settings and continue with Windows NT
setup.

Result: Files are copied to the system. Windows NT Setup sets security on
system files, and saves the system configuration. You are then prompted to
insert a blank disk into the floppy drive in order to create an emergency
repair disk.
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70 Insert a blank disk and click OK.

Result: The disk is formatted and the configuration files are copied to the
disk.

71 Remove the CD from the CD-ROM drive, and the disk from the floppy disk
drive.

72 Click Restart Computer to complete Setup.
Result: Windows NT Setup restarts the server and boots to Windows NT.

What’s next

Now that the basic setup of Windows NT Server 4.0 is complete, you are ready
to format additional hard disks/partitions.
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Formatting additional hard disks/partitions

Introduction

Perform this procedure if you have more than one hard disk installed on your
server. This general procedure can be applied to all unformatted disks.

Requirements

m  aserver powered up, with MS-DOS and Windows NT 4.0 Server installed.
The server must be powered up and display the Windows N'T logon prompt.

To format additional hard disks

1 Atthe logon prompt, press Ctrl + Alt + Delete.
Result: The Windows NT logon box appears.
2  Log on to Windows NT.

3  Click Start > Programs > Administrative Tools (Common) > Disk
Administrator.

Result: Disk Administrator notifies you that this is the first time it has been
run.

4  Click OK to acknowledge the message.

Result: The Disk Administrator program might prompt you to accept that it
will write a sighature to each hard disk.

5 Click Yes to each request.

Result: Disk Administrator writes a signature to all disks, and then displays
the main program screen.

Each SCSI disk (or RAID System Pack) is represented on this screen.
Each disk has a number (Disk 0, Disk 1, and so on). Note that Disk 0 has 1
partition: a 600-Mbyte FAT partition for 4-Gbyte hard disks, or a 1-Gbyte
FAT partition for 9-Gbyte hard disks. The remainder of Disk 0 is free space.

6  Select the CD-ROM by pointing and clicking.

Result: Disk Administrator highlights the CD-ROM with a thick, black
border.
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10

11

12

13

14

15

16

17

18

19

Under the Tools menu, choose Assign Drive Letter... .
Result: An Assign Drive Letter window appears.

Ensure Assign Drive Letter is selected and, using the drop-down box,
change the CD-ROM drive letter from D: to Z:. Click OK.

Result: Setup prompts you to confirm your changes.
Click Yes to confirm.
Select the free space on Disk 0 by pointing and clicking.

Result: Disk Administrator highlights the free space with a thick, black
border.

Under the Partition menu, choose Create Extended... .
Result: You are prompted for the size of the Extended partition.

Accept or enter the maximum size of the partition (the remainder of free
space for the 4-Gbyte hard disk, or 4096 Mbytes for the 9-Gbyte hard disk),
and click OK.

Result: The extended partition is created.

Click and select the free space on Disk 0.

Result: The free space is highlighted with a thick, black border.
Under the Partition menu, choose Create... .

Result: You are prompted for the size of the logical drive.

Accept (or enter) the maximum size for the logical drive, and click OK.
Result: The logical drive is created.

Under the Partition menu, choose Commit Changes Now... .
Result: Setup prompts you to confirm your changes.

Click Yes to commit the changes to disk.

Result: Setup prompts you to update your Emergency Repair Disk.
Click OK to continue.

Result: You are returned to the Disk Administrator program screen.

Select the newly created partition and, under the Tools menu, choose
Format... .

Result: Setup prompts you to enter the formatting information.
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20 Ensure the File system is NTFS, and check the box labeled Quick Format.
Click Start to continue.
Result: Setup prompts you to confirm the format.
21 Click Yes to proceed with the format.
Result: Windows NT formats the disk/partition. A message box appears
when the format is complete with the format summary information.
22 Click Close after viewing the disk format summary information.
Result: You are returned to the Disk Administrator program screen.
23 Repeat steps 6 to 18 to format the remaining disks (or system packs) in the
server.
24  After partitioning all the disks, choose Exit under the Partition menu.
What'’s next

Install the Windows NT Service Pack 5.

Part 5: 1001rp Server Maintenance and Diagnostics 297



Installing operating system software Standard 1.0

Installing WIinNT 4.0 Service Pack 5

Introduction

A service pack is an update Microsoft provides for Windows operating systems.
Service packs provide new versions of files and fixes for problems that have
been reported.

The current service pack is Service Pack 5.

CAUTION
& Risk of system crash

Install the service pack only during the operating system
installation and as part of an upgrade from a 1.0 CallPilot system.
Do not reapply the service pack on an installed CallPilot system,
except where specifically instructed to do so in the documentation.

Requirements

CallPilot 1.07 PEP CD-ROM

a server powered up, with Windows NT 4.0 Server installed

To install the service pack

1
2
3

Insert the 1.07 PEP CD in the CD-ROM drive.
Click Start > Programs > Windows NT Explorer.

Click the plus sign (+) next to the CD-ROM drive to display its
subdirectories.

Select the directory named Service Pack 5.
Double-click the folder US-40bit and then double-click the file sp5i386.
Result: The Service Pack Install window appears.

a. Review the license agreement, and then select the Accept the License
Agreement check box.

298

CallPilot



May 2000 Installing operating system software

b. Uncheck the Backup files necessary to uninstall this Service Pack
check box.

c. Click Install.
6  Click Finish to finish installing the service pack.

Result: The program examines the system, selects the files to copy, and
then copies them. If messages appear, refer to the next step for the action
to take in response.

7  As the files are installed, the following message might appear: The
target file exists and is newer than the source.
Overwrite the newer file? Click No.

When asked if you want to replace a file, always click No.
Result: The service pack is installed.

8 Click Restart.
Result: The computer restarts.

9  After the server is restarted, remove the CallPilot PEP CD.

What’s next
If this is a new installation, install the tape device drivers.

If you installed Service Pack 5 as part of a CallPilot upgrade, continue with
“Upgrading from 1.0 or 1.06 to 1.07” on page 385.
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Installing the tape device drivers

Introduction

Perform this procedure after installing the Windows NT Server and Service
Pack 5.

Requirements
m  aserver powered up, with MS-DOS and Windows NT 4.0 Server installed
m  Application Server Driver CD
= ablank disk

Before you begin

The tape device drivers that you need to install are provided on the Application
Server Driver CD. For the drivers to be functional, you must copy the drivers to
disk before starting the installation.

It is important to review the help.txt file that is supplied on the Application
Server CD for the directory location of the drivers on the CD.

To copy the drivers to disk

1 Ensure that all system and hidden files are displayed by clicking on the My
Computer icon, selecting View from the menu bar, and then selecting
Options.. .

In the View tab, select Show all files.

Click OK.

Insert the Application Server Driver CD into the CD-ROM drive.
Insert a blank disk into the floppy drive.

o o~ WN

Use Windows Explorer to navigate to the directory on the CD-ROM
containing the drivers you require. Highlight the contents of the directory.

Note: The directory information is provided in the help.txt file on the
Application Server CD.

300 CallPilot



May 2000

Installing operating system software

7

Right-click the highlighted contents and select Send To.. 3 1/2 Floppy (A).

Result: Driver files are copied onto disk and are ready for use.

To install the tape device driver

1 Atthe logon prompt, press Ctrl + Alt + Delete to display the Windows NT
logon box.

2 Log on to the system using the customer’s Administrator ID and password.
Click OK.

3  Click Start > Settings > Control Panel, and double-click the Tape Devices
icon.
Result: On the Tape Devices control panel, Windows NT attempts to detect
the installed tape drive(s). The list of available tape drives appears.

4  If the tape driver is not listed, click Have disk... .
When prompted, insert the driver disk you created in ‘Before you begin” on
page 300, into the floppy drive and click OK. Enter the drive letter (for
example: A:).
Result: You are prompted to select a device driver from the displayed list.

6  Select Seagate tandquic (Tandberg Tape QIC SCSI drives, all), and click
OK.
Result: You are prompted to install the selected driver.

7  Type OK to install the selected driver.
Result: The driver files are copied to the system and you are prompted to
restart the computer. Remove the floppy drive before restarting the
computer.

8  When prompted, insert the MAS 2.0 Operating System CD-ROM and click
OK.
Result: The files are copied to the system, and the Tape Devices control
panel appears.

9 Click OK to close the control panel and save the changes.

What’s next

Install video card device drivers if required.
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Installing video card device drivers

Introduction

Install the video drivers after Service Pack 5 has been applied to the system and
you install pcANYWHERE3?2.

Note: Currently, Windows NT 4.0 Service Pack 5 uses the default video card
device drivers that are supplied with Windows NT 4.0. Follow this procedure
only if a new video device driver has been issued by Microsoft.

Requirements

a server powered up, with Windows NT 4.0 and Service Pack 5 installed
Application Server Driver CD
a blank disk

Before you begin

The video card device drivers that you need to install are provided on the
Application Server Driver CD. For the drivers to be functional, you must copy
the drivers to disk before starting the installation.

It is important to review the help.txt file that is supplied on the Application
Server CD for the directory location of the drivers on the CD.

To copy the drivers to disk

1

a A W N

Ensure that all system and hidden files are displayed by clicking on the My
Computer icon, selecting View from the menu bar, and then selecting
Options.. .

In the View tab, select Show all files.

Click OK.

Insert the Application Server Driver CD into the CD-ROM drive.
Insert a blank disk into the floppy drive.
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6 Use Windows Explorer to navigate to the directory on the CD-ROM
containing the drivers you require. Highlight the contents of the directory.
Note: The directory information is provided in the help.txt file on the
Application Server CD.
7  Right-click the highlighted contents and select Send To.. 3 1/2 Floppy (A).

Result: Driver files are copied onto disk and are ready for use.

To install the video card device driver

1

o 0~ WN

Press Ctrl + Alt + Delete.

Result: The Windows NT logon box appears.
Log on to Windows NT as Administrator.

Click Start > Settings > Control Panel.
Double-click the Display icon, then click Settings.
Click Display Type, then click Change.

Select the appropriate device driver for the installed video card and click
OK to continue.

Result: You are prompted to install the selected driver. If this is the correct
driver, skip to Step 8.

If the video card driver is not listed, insert the driver disk you created in
“Before you begin” on page 302 and click Have Disk... .

Result: You are prompted to insert the disk.

Insert the Video card device driver disk in the floppy drive, enter the drive
letter (for example, a:\), and click OK.

Result: You are prompted to select a device driver from the displayed list.
Select the most appropriate driver and click OK to continue.

Result: You are prompted to install the selected driver.

Click OK to install the selected driver.

Result: You are prompted to insert the MAS 2.0 Operating System CD.
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10 Insert the MAS 2.0 Operating System CD in the CD-ROM drive, and click
OK.

Result: The driver files are copied to the system. The Display Type control
panel appears.

11 Click OK to close the control panel and save the changes.

Result; You are returned to the Windows NT Control Panel.

What’s next

Install the RATD Monitoring/Administration utility.
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Install RAID Monitoring/Administration utility

Introduction

If a PCI RAID card was installed, install the monitoring and administration
utilities for the RAID card under Windows NT.

Installing the RAID utility

1 Insert the DAC960 driver disk in the floppy drive.

2  Click Start > Programs > Command Prompt.

3  Type the following commands to complete the RAID card configuration.
Note: Note the path Windows NT 4.00 (c:\winnt\). Make the appropriate
changes as you execute the steps below:
copy a:\nt\*.* c:\winnt\system32\

Result: The system displays the following message: 7 files (s)
copied

srvecefg dacmon dac960Monitor ¢:\winnt\system32\dacmon.exe
Result: The system displays the following message: Service
Installed successfully

net start dacmon

Result: The system displays the following message: The
dac960Monitor service is starting. The dac960Monitor
service was started successfully.

4  After the execution of the last command, a window is launched minimized
in the TaskBar (NT 4.0).

5 Close the Command Prompt window and remove the floppy disk.

What’s next
Install pcANYWHERE.
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Installing pcANYWHERE32

Introduction

The process of installing pcANYWHERE32 involves the following procedures:

1.
2.

Install the pcANY WHERE32 application on the server.

Start pcANYWHERE32 for the first time. This procedure allows you to set
the network device.

Set the video mode. This procedure synchronizes the video card settings
with that of the administration client PC to ensure the remote user can see
the server graphical user interfaces properly.

Set the pcANYWHERE32 service to Automatic. This procedure enables
the pcANYWHERE3?2 service to start automatically after reboot.

To install p)cANYWHERE on the server

1

2
3
4

Log on as administrator.
Insert the MAS 2.0 Operating System CD into the CD-ROM drive.
Ensure all other Windows applications are closed.

Navigate to the Installs\Pca32\Disk1 folder on the CD-ROM drive as
follows:

a. Double-click Installs.
b. Double-click Pca32.
¢. Double-click Disk1.
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d. Locate and double-click the Setup application file.

Result: The Welcome to pcANYWHERE setup program window appears.

wielcome ta the pxAMY WHERE Setup program.  Thiz procram
will ingtall pocaMTWHERE on wour corrputer.,

# It iz strongly recommended that you ext all Windows progrems

bafara running this Setup program.

Click. Cancel to guit Setup and then cloze any programs you hawve
running. Click Mest to continue with the Setup program.

WwiSHMING: This program iz pratected by copyright lavw anc
international treaties.

Jrautharized repraduction or distribution of this progrann. or angy
portion af it, may result in severe civil and criminal penalties. and
will be prozecuted to the maximum extent pozgible under law,

< Baclt

Cancel |
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5 Click Next to start the installation.
Result: The User Information window appears.
User Information

Pleaze type bath your name and the name of your company in the
zpace provided below,
Orce thiz informaton has been entered, installation will cortinue.

—

Mame: INDrteI

LCompar; IN orbel Hetwork s

< Back I Ment » I Cancel
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Online License Agreement

Enter the user name and company name, then click Next.

Result: The Online License Agreement window appears.

Fleaze read the following license ageement. Use the sooll bar to view the rest of
thiz agreement.

MOT CE: -
Symantec licenzes the accomparnying zoftwane bo you onlyp upon the condition that wou
accept all of the termg contained in thiz licenss agreement. Pleaze read the terms

careflly before continuing installation, as prezsing the "ves" button will indicate your

asgzent ta them. |f you donot agree to these tsims, please press the "no" button to exil

inztal as Symantec iz unwiling to icenze the zoftware to you, in which event you should
return the full product with proof of purchase t the dealer from wham it was acquired

within zixty dayz of purchaze, and paur rmaney will be refundsd.

LICESNSE AWND WARRAMTY:

The zoftveare which accompanies this license [the "Saoftware''] iz the property of

Symantec of itz icenzers and is protected by copyright law, While Spmantec continues bo
awn he Software, vou wil have certain rights to use the Software after your acceptance

of thiz icenze. Except az may be modified by a license addendurm which accompanies ﬂ

Do veu accept all the terrs of the preceding License Agreement? [F pou choose Mo, Setup
will cloze, Toingtall pedMrWHERE 32, pou mast accept thiz agreement.

< Back Yes Ha |

Note: Ensure that the name and company are the same as those entered
during the Windows NT installation.
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7  Click Yes to accept the software license agreement.

Result: The Choose Destination Location window appears.

Choose Destination Location E3

Setup will inztall peAlYWHERE 32 in he following director.

Ta install in this diectarny, click Mest.

# Tainstall in a different directary, click Brovese and select another

directony.

Click Cancel to ext the Setup program

" Destination Direztory

F:\Program Files\ped MY WHERE Browse... |
Cancel |

< Back
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8  Click Next to accept the default directory.

Result: The Setup Review screen appears.

Setup Review E3

pdMTWHERE Setup will now autamatically:
1] Update the "Windows Reqistry
: 2] Create a program group
J] Copy filz:

The pcaMT™WHESE program will be copied to the following
location:

F:\Program Files\pecAMNTYWHERE

9  Click Next to continue.

Result: Program and other files are copied to the system.
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When installation is complete, the Symantec Support Solutions screen
appears.

Symantec Support Solutions

StandardCate Support
Unlirmited use of elecironic and automated services and limitec

time telephone techncal suppot at no charge.

ProrityCare Support
Fast access support designed fr occasional callers
[eharged oq & per minute basiz]

PremiumCare Support
Faszt arres:, cnst-effectve support for frequent callers

[charged on a per-pear basziz).

See prr preduct manual for detailz Abook suppoet pregrams
deigried to velp pou get the most out of wour zoftware,

Scrvicos avallable may vary by country. Symantee rezervecs the
rigt ko change itz support policies at ang time.

< Black

10 Click Next to display the How To Reach Us screen.

How To Reach Us

CompuServe
GO SYMANTEC

Anenica Onlne
Feyword: SYMARNTEC

Ikterret
Wigit Symantec's Wold Wide Web site at
hibtp: A, spmantes, com,

< Bacle
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11 Click Next to continue.

Result: The Windows 95 Solutions screen appears.

Windows 95 Solutions

Symantec ako offers the following bugings: software solutions
fion wfindons: 35 users:

MHartan Mavigatar
Guaranteed ta make file management and warking in
Windows 95 fazter and easier.

Morton Antivirus
Ho product detects, destrops, and prevents mare wiuzes
tiam Marton Antiinas for Windows 95,

Order Mol
Pleaze refer to your documentztion for instructions an how ta
reach us,

.3 S00-306-3477 United Kingdom 0200-333-323
Cznada B80J-469-2857 Australia 1800 810101
Mexico  525-7E8-6316

< Bacle
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12 Click Next to continue.

Result: The Registration Wizard screen appears.

Registration Wizard

Pleaze take a moment to register now

Regizter now ta be eligible far 30 days of free technicd
support, special upgrade pricing, and up-to-date produzt and
company information.

Toregister, select the [ceation nearest you fiom the list below,

To continue without regstering, clck Skip.

Selzct location: |Carada j

Click. Mest to ontinue regiztering.

SYMANTEC,

% Back Mext »

13 Click Skip.

Result: You are asked if you want to view the README file now.

pcANYWHERE Setup ]

® Do pou want to view e README file now?
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14 Click No.

Result: Setup prompts you to restart the computer.

Selup Complete

Cengratulations!l!

PN W HERE 32 T wWiniduws 30 ard windowss NT bias been
suzcessfullpinztalled on your conputer,

Wndows must be restarted before pedMYWHERE iz wun and
before instaling any other applications.

€ ‘Yes, | want to restart my computer now

........... i)

& Mo, | will restart my compter |ater,

Remowe any dizks fram their drives, and then click Finizh to
complete selup,

< Blaclk I Finizh I

15 Click No, | will restart my computer later, and then click Finish.
Result: pcANYWHERES32 setup terminates.
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To start p)cANYWHERE32 for the first time

1 Click Start > Programs > pcANYWHERE32 > pcANYWHERE.

Result: The Smart Setup Wizard window appears, and you are prompted
for the modem device.

Smart Setup Wizard

Flease select the modern device to be uzed
Az the drfanlt far modem connechinns

If pouwant to add a moden not listed here,
click the "Add Moder' button.

Add Modem |

% Back | Mext > I Cancel |
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2 Ensure that the Sportster 28800-33600 External modem is selected, then

click Next.

Result: The system prompts you to select the network device.

Smart Setup Wizard

Pleasc zcloct the nobwaols deviee B be
uzed ag the default far natwork
cornechions.

Af wou do not have a nebwork, or you do not
knoa what vour netwark type iz, vou can
acloct one later.

< Back | Mext = I Cancel |

3  Ensure that only TCP/IP is selected, and then click Next.

Result: The system prompts you to select a port.

Smart Setup Wizard

Flease select a port tor your direct Zable
carnection.

i

< Back | Finizh I Cancel
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4  Ensure that you select COM1, then click Finish.
Result: The pcANYWHERE32 window appears.

&7 pcANYWHERE 32
File Edit Action Utlites “iew Help
< Ly ¥
Guick Be & Remote File Be & Remﬁte Call Oiline Exit
Start Host PC Cortrol Transfer Gateswray | Metvworkng Service
ForHelp, press Fl i

To set the video mode

1 From the File menu, select Application Options.

Result: The Application Options dialog box appears.
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2

Click the Host Operation tab.

Application Options

Spslen Selup l Renule Jpeialion ] Fiemule Fiinting ] DOS Sessiurs l
Hast Operation l TCRAP ] File Tramsfer ] Terminal Erulaticn ] Button Bars ]

Optiohs
Bing number to answer on; 1 _%I

Yideo mode zelection:

QK | Cancel | Apply Help

In the Video mode selection drop-down list, select Default—Accelerator
Enabled, and then click Apply.

Click OK to close the window.
Result: The pcANYWHERE32 window appears.
To finish the installation, on the pcANYWHERE32 window, click File > Exit.

If you performed the installation from the CD-ROM drive, remove the CD
from the drive.

To perform the pcANYWHERE32 patch installation

Note: The pcANYWHERE32 patches are located on the CallPilot server
CD in the following directory: platform\default\nortel\data\PCANYW_1

Install the 802up_a Patch. From the CallPilot server CD, run
platform\default\nortel\data\PCANYW _1\802up_a\disk1\setup.exe.

Double-click the setup.exe icon.

Result: The Welcome window appears.
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10

Click Next.
Result: The Start Copying Files window shows the path for copying files.
Click Next.

Result: Setup copies files to the directories, and then the Setup complete
window appears.

Select No, | will restart my computer later, and then click Finish.
Note: Do not restart the computer.

Install the 802up_b Patch. The setup executable can be found on the
CallPilot server CD in the following directory:
platform\default\nortel\data\PCANYW _1\802up_b\setup.exe.

Double-click setup.exe.
Result: The Welcome window appears.
Click Next.

Result: The Start Copying Files window appears, showing the path for
copying files.

Click Next.

Result: Setup copies files to the directories, and then the Setup Complete
window appears.

Select No, | will restart my computer later.
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11 If you see the following screen, ensure the check box is unchecked, and
then click Finish.

12 Restart the computer by clicking Start > Shutdown. Select Restart the
Computer, and then click OK.

To configure pcANYWHERE
1 Click Start > Programs > pcANYWHERE32 > PCAnywhere.
2  Select Be a Host PC.
3 Right-click the Network icon, and then click Properties.
Result: The Network Properties sheet appears.
4 Click the Connection Info tab.

Ensure that only TCP/IP is checked.
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6  Click the Settings tab and select the Launch with Window check box.

Ensure that the settings are as shown in the following example:

METWORK Properties [ ]

Connertinn Infn - Settings I Callers I Serauriby Mpknnz: I Confrrence I Pratect Iterm I

Mame: NETwORK
—Hesgt Startup — Modem Connection
i =
Callback delay: =l o
™ Lock workstation ittt EEenes
V¥ Run minimized —Ir Session
I Aun as aservice Keyboard/Mouse active during session:
—&bnormal End of Session——————— Host and Remate LI
g ID =1 minces for curment uzer
WL =1 g reconnect, —End of Session
— Taen: —a&fter a Momal End of Session:
4 Wwiait for anyone £ Wait for anyone
" Cancel host " Cancel host
—I— and Secure by ——m————— —I" and Secure by:
& Logoff user €% |ogoff user
= Bestart host comauter = Festart host comptiter
€ Lock NT workstztion ) Lock MT workstation

ak I Cancel Apply Help

7  Click the Callers tab.
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8 Click Specify individual caller privileges, as in the following example:

NETWORK Properties E

Connection Info I Settings  Callers | Security Options I Conference I Protect ltem I

= Allow full access to all callers

' Specify individual caller privileges

= Usge NT user privieges T Wser Manager |

Ok Cancel Lpply Help

9  Double-click Add Caller.
Result: The New Caller Wizard window appears.
10 Enter CallPilotDist and click Next.
11 Type CallPilotDist for the logon name.
12 In the Password field, type the new CallPilotDist password.
13 In the Confirm Password field, retype the new CallPilotDist password.
14 Click Next.
15 Click Finish.
Result: The Network Properties sheet appears.

16 Click the Security Options tab and select the check boxes for the following
entries:

m Log failed connection attempts
m  Make passwords case-sensitive

= Deny lower encryption level
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17 Ensure that the settings are as shown in the following example:

18 If you want to assign a password to control who can modify the Network
icon settings, click the Protect Item tab, then enter a password on this
screen.

19 Click OK to apply all p)cANYWHERE32 settings.

What’s next

If necessary, make an emergency repair disk. Otherwise, refer to Chapter 8,
“Installing CallPilot server software.” to install the CallPilot server software.
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Making an emergency repair disk

Introduction

An emergency repair disk enables you to start the server in the event that
Windows NT on the server does not start.

ATTENTION
An emergency repair disk should only be used by support

personnel or as requested by support personnel.

It is important that the emergency repair disk be updated on a regular basis (after
any maintenance activities are performed on the server or anytime the server
configuration changes).

Requirements

m  ablank 3.5 inch disk (not supplied with CallPilot). Label this disk
“Emergency Repair Disk.”

m  aserver with Windows NT 4.0 and the service pack installed (see “To
install the service pack™ on page 298)

To make an emergency repair disk
1 Power up the server.
Press Ctrl + Alt + Delete to display the logon window.
Log on to Windows NT as Administrator.
Insert the blank disk in the floppy drive.
Click Start, and then click Run.
When prompted, type rdisk and click OK.

N o o~ WON

Click Update Repair Info.
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8 Click Yes to continue.

Result: Setup prompts you to create the Repair disk.
9 Click Yes.
10 Click OK at the prompt.

Result: The disk is formatted and configuration files are copied to the disk
being created.

11 When complete, remove the disk from the floppy drive.
12 Click Exit on the Repair Disk Utility.

What’s next

Install the CallPilot server software.
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Installing CallPilot server software

In this chapter

Section A: Installing the CallPilot server software (for all switch types) 329
Installing the CallPilot server software 330
Section B: Installing Performance Enhancement Packages (PEPSs) 337
Installing PEPs 338
Section C: Installing switch connectivity software 347
Installing software for the Lucent, Mitel, and Rolm switch 348
Installing software for the MSL-100/DMS-100 switch 360
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Section A: Installing the CallPilot server
software (for all switch types)

In this section

[O8]
(O8]
o

Installing the CallPilot server software
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Installing the CallPilot server software

Introduction

This section describes the steps required to install CallPilot software on a
CallPilot server that is already loaded with the Windows NT 4.0 operating
system and the device drivers required by CallPilot.

Requirements
m  CallPilot 1.07 Server CD
s CallPilot 1.07 PEP CD
s CallPilot 1.07 Language CD

m  aserver powered up, with Windows NT 4.0, Service Pack 5, and all the
device drivers installed

m  current password for the Administrator account (this password was set
during the installation of Windows NT)

ATTENTION
During an installation, there are stages during which the

setup program performs automatic installation steps
between setup windows. Do not close or click on any
windows that appear during these steps unless you are
prompted. Wait for the next wizard setup window before
you use the mouse or keyboard.

Installation procedures

These procedures apply to all switch types.
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To select the platform type
This table provides information about each server that will assist you in
selecting the platform type:

Prompts 200i 702t 1001rp
machine class IPE TRP TRP
machine type IPE Tower Rack
platform series 200 702 1001
backplane type Active Active Passive

To install the CallPilot server software

1 Insert the CallPilot 1.07 Server CD into the CD-ROM drive and launch
Windows NT Explorer.

2 Click on the CD-ROM drive, and then double-click Setup to start the

CallPilot installation.

Result: The Nortel System Operations window appears.

Mortel System Operations [ ]

NERTEL
NETWORKS

CallPilot®

‘welcome to Mortel Metworks CallPilot Setup. This program allows
you to install, upgrade, reinstall or uninztall Martel networks
CallPlot software on wour computer.

Fleaze refer ta the General Relkeasze Bulletin before contiuing
thiz cperation.

It iz zrangly recommended thal yow exit all Windows pragramsz
befarz running this Setup program.

Select Exit to quit Setup, and then exit any programs vou have
running. Select Mext to continue with Setup program.

WARNING
Thiz program iz protected by copyright law and international
treaties.

Unavthorized reproduction or cistribution of this program, or any
porticn of it, may result in severe civil and criminal penalties, and
will be prozecuted ta the maximum extent pozzible under law.

< Back
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3  Click Next.

Result: You are asked to confirm the installation of CallPilot files onto your
PC.

Mortel Spstem Operations B

& Install: Installs CallPilot software anto pour spster.
Setup detected that thers iz no previous release cf CallPilot software on wour system.

wiould wou like to install ZallPilot software release 01.07.08 onto wour system?

4  Click Yes.

Result: You are prompted to start the platform setting procedure.

Mortel Spstem Operations B

If your platform is a 200§, a 02t or a 1007rp, select YES ta launch
the: utility for setting vour platform information from pour CallPilat
Server CD.

If you are running on any ather platform, pleaze put the CallPilat
zyztem platform setting diskette in the floppy drive and select MO,

5 Ifthe serveris a 200i, 702t, or a 1001rp, click Yes to perform the platform
setup from CD.

Result: The Platform Type Information Test Application window appears.

1. Set the platform type
2. Retrieve the platform type

3. Exit
>
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6  Type 1 to set the platform type and press Enter.

Result: The system prompts you to identify the machine class.

i. TRP
2. IPE

3. Unknown

7  Type 1 for the 702t or the 1001rp.
Type 2 for the 200i.

Result: The system prompts you to identify the machine type.

Select the machine type:
1. Tower
2. Rack
3. IPE
4. Unknown

8 Type 1 for the 702t.
Type 2 for the 1001rp.
Type 3 for the 200i.

Result: The system prompts you to identify the platform series.

Select the platform series:
i. 288

@A

788

a1

Jaz

1888

168681

1862

Unknown

2
3
4
o
]
?
]
2
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10

11

12

13

Type the number that identifies your server’s model number. Press Enter.

Result: The Select the backplane type prompt appears.

Select the bhackplane type:
1. Active
2. Passive

3. Unknoun

Type 1 for the 200i or the 702t.
Type 2 for the 1001rp.

Result: The Nortel System Operations window appears.

Mortel System Operation

The current platform settings on wour system are: Type= Tower, Series= 702, Backplane= Active.

If these settings are comect, click Yes, otherwize click No

If the settings are correct, click Yes to initiate the installation. Otherwise,
click No to rerun the platform setting procedure.

The installation setup process runs automatically (taking 15 to 30 minutes).
A series of messages appear to indicate the items that are being installed
(for example, backup/restore, MMFS).

Result: When installation is complete, the following prompt window
appears:

CallPilot System Operations

CallPilot server has been successfully installed.
Hext: Insert the PEP CD and install the PEPs.
After the reboot, run the Configuration Wizard
from the desktop.

Remove the Server CD and insert the CallPilot 1.07 PEP CD. Click OK.
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What’s next

Install any required PEPs.
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Section B: Installing Performance
Enhancement Packages
(PEPs)

In this section

D
(O8]
oo

Installing PEPs
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Installing PEPs

Introduction

For an initial installation of CallPilot, the Performance Enhancement Packages
(PEPs) are provided on a CD.

If you are using this procedure for a CallPilot system that is up and running, new
PEPs are issued on the NIC web site:

http://www.nortelnetworks.com/prd/nic

You require a password to access this site.

CAUTION

& Risk of system problems
For specific PEP installation instructions, refer to the readme
files that are in the PEP CD root directory and in the folder
for each PEP package. In many cases, PEPs must be
uninstalled and installed in a specific order. The readme files
provide these instructions. When the readme files instruct

you to uninstall or install PEPs, refer to the procedures in
this section.

ATTENTION
If your CallPilot system is up and running, Nortel Networks

recommends that you perform a system backup before you
install a new PEP.

See Monitoring and Security for the Administrator for more
information on performing a backup.

Identifying the PEPs
PEPs are labeled on the CD in the following format:

NMxxyyzzPwwwQ
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where

XXYyZZ is the release level (for example,
010707)

P can be “R” for a restricted PEP, “D”
for a diagnostic PEP, or “G” for a
general PEP

WWW PEP number for the release. Range is
from 001 to 999

Q indicates platform type (for example,

“S” denotes a PEP for the server)

Readme files

Readme files are provided in the following locations on the PEP CD:

= Root directory on the PEP CD

This readme file provides a general description of the PEP packages and
general PEP install and uninstall instructions.

m  In each PEP package folder

These readme files provide a list of all the PEPs in that package, and
specific PEP install and uninstall instructions.

m  Ineach PEP folder

These readme files describe the purpose of that PEP and might provide
some PEP installation instruction.

To install a PEP package

1 Ensure that you are logged on to the server where you are going to begin
PEP installation. Use a logon account that has administrative privileges (for
example, administrator).

2 Insert the CallPilot 1.07 PEP CD.

3 Read the readme files that are in the PEP CD root directory and in the
folder for each PEP package for specific uninstallation and installation
instructions.
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4 Double-click runme.exe.

Result: Setup examines the system, and the PEP’s to install window
appears.

ATTENTION
It can take 5 to 20 minutes for the PEPs to install window

to appear, depending on the number of PEPs and the
system configuration. In the meantime, a gray box might
appear while the window is loading. Do not use the
mouse or keyboard during this time

Note: The following example is for illustration purposes only, and might not
reflect what appears on your system.

PEPs to install |

NERTEL

The following PEPs are availablx_e for installation. Check the box

'RTE
METWORKS beside all the PEPs pou wish to install

CallPilot™

PBrogram and Yersion
O PEP: NMO10709G001S NMO10703G001S

Selectal | Cearal |

< Back
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5  Select the PEPs to install, then click Next. If you are uncertain about which
PEPs to install, refer to the Readme file located in the root directory of the
CD.

Result: The Nortel System Operations window appears and lists all
components in the order in which they will be installed.

Mortel Spstem Operations E

Based on your request, Setup has decided to install, upgrade, or uninstall the following
components in the given order:

1: Install of “PEP: NEO25830G0015" to version "NB025830G0015" ;I
2 Install of "PEP: NBO25830G0055" to version "NB025830G0055"
3 Install of “PEP: NBO25830G0035" to version "NB025830G0035"
4 Install of "PEP: NEO256830G0115" to version "NB025830G0115"

i o

Do you want getup to continue?

Mo
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6 Click Yes to continue.

Result: The system automatically shuts down all services and the PEPs
are installed. A summary of the installation appears, showing the success
or failure of each PEP operation.

Note: CallPilot automatically removes obsolete PEPs when you install new

PEPs.

Installation completed. Here is the status of each component:

1: Install of "PEP: NBO25830G0015" was successful. ;I
2 Install of "PEP: NBO25830G0055" was successful
3t Install of "PEP: NBO25830G0095" was successful.
4: Install of "PEP: NBO25830G0115" was successful.

i o

Do you want getup to continue?

7  Click Yes to complete the procedure.
Result: The program ends.

8 Repeat this procedure for other PEP packages. A reboot is required after
installing PEPs.

To uninstall a PEP package

CallPilot automatically removes obsolete PEPs when you install new PEPs.
However, there can be times when you want to uninstall a PEP yourself.

Use the DMI Viewer on the server to view or uninstall server PEPs. Access the
DMI Viewer by clicking Start > Programs > CallPilot > System Utilities > PEP
Maintenance Utility.

To uninstall PEPs on the server, follow these steps.
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Log on to the server where you are going to begin the PEP uninstall. Use a

logon account that has administrative privileges (for example,

administrator).

Open the PEP Maintenance utility.

Result: The DMI Viewer window appears. The following example might not
reflect exactly what appears on your system.

% DMI Viewer E

R MAS Suite’

MaS Base

— DI component
Manufacturer:

INorteI Metworks

Product Name:
IEaIIF'iIot Server

Wersion:
|m 0707

Last Operation Time:
IJan 31,00 18:56:00

EEENppEe:

Thiz component iz a software package

Thiz component iz part of the root
component

Thiz component iz present

ShowEEPsI Eemoye | Fieagl

Show Suites |

To view a list of all PEPs, click Show PEPs.

Result: A list of all PEPs appears.
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£F DMI Viewer ]
- DMl companent——————————————
List af all PEPs | Manufacturer:

PEF: NMOT0707G00S
[ PEP:; NMO10707G0025

INorteI Metworks

Product Name:
IPE P: NMO010707G0015

Wersior:
INMD‘I 0707GE001S

Last Operation Time:
IFeb 04, 00 11:04:43

FEF Type:
ITEMPDHAHY

Thiz component iz a PEP

Thiz component iz the root component

Thiz component iz present

) Bemove | Heag|

Show Suites |

4  Select the PEP you want to uninstall. You can select multiple PEPs to
uninstall in one operation by using the Ctrl key. The prefix PEP identifies
PEPs.

5  Click Remove.
Result: The system prompts you to confirm this choice.
6  Click Yes.

Result: The system automatically shuts down all services and uninstalls
the selected PEPs. When the uninstall is finished, the system automatically
restarts all services.

Note: After you uninstall a PEP, the PEP is still visible in the list of
components until you restart DMI Viewer.

7  When you are finished, close the DMI Viewer window.

What’s next

If you are installing software for recovery purposes, install switch connectivity
software. Go to the section for your switch as shown in the table below.
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Switch Refer to
Meridian 1 Part 3, Chapter 6, “Configuring the
server software—common dialog
boxes for all switch types”
MSL-100 or DMS-100 “Installing software for the MSL.-100/

Lucent, Mitel, or Rolm

Matra

DMS-100 switch” on page 360

“Installing software for the Lucent,
Mitel, and Rolm switch” on page 348

Part 3, Chapter 6, “Configuring the
server software—common dialog
boxes for all switch types”

If you are upgrading CallPilot server software, return to the upgrade procedure

described in “Upgrading from 1.0 or

1.06 to 1.07” on page 385.
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Section C: Installing switch connectivity
software

In this section

(O8]
(0]

Installing software for the Lucent, Mitel, and Rolm switch
Installing software for the MSL-100/DMS-100 switch

[O8]
o
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Installing software for the Lucent, Mitel, and
Rolm switch

Introduction

Follow these procedures to install and configure connectivity software for the
Lucent, Mitel, and Rolm switches.

To install VoiceBridge software

1 Insert the CallPilot 1.07 PEP CD into the CD-ROM drive and launch
Windows NT Explorer.

2  Click the CD-ROM drive and navigate to the vtg directory.

3  Double-click setup to start the installation.

Result: The Welcome window appears.

Welcome

Welcome to the YoiceBridge 2000 Setup pragram.
Thiz program will inztall % oiceBridge 2000 on wour
- compLter.

It iz strongly recommended that you exit all Windows programs
before running thiz Setup program.

Click. Cancel to guit Setup and then cloze any programs pou
hawe rnning. Click Mext to continue with the Setup program.

Wi RMING: Thiz program iz protected by copuright law and
international treaties.

|dnauthorized reproduction or diztribution of thiz program, or any
partion af it, may result in zevere civil and criminal penalties, and
will be prozecuted to the masimum estent pozsible under lai.

Cancel |
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4  Click Next to display the Release Notes window. Review these notes for the
most current information on the release.

Release Motes

Current Releaze Motes

10415739 =
Werzion 2. 10a iz a special releaze for Nortel Metwork s consis
problems: f

1. Calls to the Call Pilat are not answered. Calls are now ang
caller dizconnects and immediately, using a speed dial buttor
zame port, If thiz ocours within approsimately 300 millizeconc
system, but without any CPID information in the call informati
2. 8 supervized tranzfer into voice mail will use the transferir
onginatar. The carrect party iz how seen by Call Pilat.

3. An attempted out-dial to an invalid tunk on a Bolm sesten
riuzic: an hold while the Call Pilat talks to the invealid trunk. 1n
the trunk to be dropped without dropping the entire call. Do
being connected ta the errar tane. This frees the voice mail |
the: uzer.

9/30/99

Woice Technologies Group iz excited to announce version 2

-
1| | 3

Cahicel |

5  Click Next to display the Choose Destination Location window.

Choose Destination Location

Setup will install WoiceBridge 2000 in the following folder.
To install to this folder, click Mext.

To install to a different falder, click Browse and select another
falder.

Wou can choose not to install WaoiceBridge 2000 by clicking
Cancel to exit Setup.

c:WWEBPC Browesze. . |

" Destination Folder

Cahicel |
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6 Change the VoiceBridge software destination folder:
a. Click Browse... to display the Choose Folder dialog box.

b. Change the destination folder to d:\vbpc by typing the pathname in the
Path field.

c. Click OK.

Choose Folder

Please chooge the installation folder.

Path:
|dvBPC

Diirectories;

= ol ;I oK I

£ edoc

£33 Program Files Cancel |
£ sysops

£ TEMP

£ WINNT =l

Dirives:

I Hc j Metwark... |

d. On the Setup window, click Yes to confirm the change.

@ The falder:
'd\YBPLC
does not exist. Do you want the folder to be created?

o |

Result: The Choose Destination Location window appears.
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7  Click Next to display the Select Program Folder window. Accept the default
program folder name.

Select Program Folder

Setup will add program icons to the Program Folder lizted below,
Y'ou may type a new folder name, or select ane fram the existing
Folders list. Click Mest to continue.

Program Faolders:

CallFilot

Dialogic CTMS Applications
poaiyYWHERE 32

Startup

Sybase SOL Arpwhere 5.0

< Back I MHeut » I Cancel |

8 Click Next to display the Select Documentation Option window.

9 Select Install Documentation.

Select Documentation Option

Select from the following D'ocumentation options:

 |nstall Documentation

& Do Mot Install Docurmentatiors

< Back I MHeut » I Cancel
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10 Click Next to display the Select Components window.

Select Components

Select Mative AP if you are developing with the YoiceBridge
2000 Mative AP Select TAPI if vou are developing with
ticrozoft's Telephong &P [TAFI).

" oiceBridge 2000 Native &P
& Microzoft Telephony AP1 (TP

< Back I MHeut » I Cancel

11 Select Microsoft Telephony API (TAPI).
12 Click Next to display the PBX selection window.

Select the PBX that matches your YoiceBridge 2000 model.

Select the integration bwpe from the following:

" Lucent 7400
" Siemens Folm
& Mortel Meridian 1
 Mitel

" Lucent 8400

< Back I MHeut » I Cancel
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13 When Setup prompts you to select the switch type
m for Rolm, select Siemens Rolm
m for M1-DSE, select Nortel Meridian 1
m for Mitel, select Mitel
m for Lucent 2-wire, select Lucent-8400
Note: Lucent-7400 is not supported.
14 Click Next to display the Select the IRQ window.

Select the IRQ E

Select an available IRQ far pour spztem from the fallowing list. Al
YoiceBridge cards share this selected IRG. Usze the ‘Windaws
MT Diagnostics proaran to see which IRQs are in uze.

3
0l -
7
10
1
12
15

< Back I Hewt » I Cancel

15 Select IRQ 5.
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16 Click Next to display the Select the Voice Bus window.

Select the Yoice Bus

Select the cormect VYoice Buz. [MOTE: MVIP iz not an option
because TAPI was previously selected. vou may click back and
remove TAP! support to install MYIP.)

& SChus: VoiceBridge 2000 with other SChus compatible cards

< Back I MHeut » I Cancel |

17 Select the SChus: VoiceBridge 2000 with other SCbus compatible cards
option.
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18 Click Next to display the Startup Mode selection window.

Select the Startup Mode

Select the startup mode for the WoiceBridge 2000 service
[vbepload). Manual startup iz recommended until pou are sure
that the service starte properly.

 Manual

< Back I MHeut » I Cancel

19 Select Automatic startup mode for VBPC load.
20 Click Next to display the Setup finish window.
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21 Review the Current Settings list. Click Back to redisplay any window on
which you want to make changes, or click Next to continue.

Setup is ready to finish the installation

Setup has enough information ta start copying the program files.
|f pou wwant to review o change any zettingz, click Back. 1f pou
are satisfied with the zettings, click Mest to begin copying files.

Current Settings:

Documentation will not be inztallad ;I
The TAF| Service Provider will be ingtalled

Lucent 7400 Integration

"oice Bus: SCBus

IRQ: &

"foiceBridge Service: automatic start

o o

< Back

Cahicel |
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22 The Setup process displays a pop-up window that asks about Dialogic
Installation. Click No.

Question ]

A Dialogic Ingtallation waz not detected, Dialogic DMAZ iz required for the
WaoiceBridge-2000 TAPI option. ‘would you like ta run a Dialogic install now?

Result: The Setup Complete window appears.

Setup Complete

Setup has completed successfully. ou must first launch the
Configuration Manager before you can uze the system,

™ Launch Configuration M anages

Click Finizh to complete Setup.

< Hack I Finish I

23 Uncheck Launch Configuration Manager, and click Finish.

To run VTG configuration

24 After VTG software installation is finished, from the d:\nortel\bin directory,
double-click vtgconfiguration.exe.
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25 Inthe VTG Boards area, click VB1 to highlight it. Click Delete to remove it.

VTG Board Configuration
~Boards—————— [~ Board Configuration
ﬂ_ VTG Configuration
- R Serial Number I':I
Base Address: |
IRQ: [
Bus Type: |
SC Master; |
SC Clock: |
State: [
Add... LelEte | Switch Configuration
Cahicel |

26 Click Add to display the Add Board dialog box.
27 Enter the serial number of the VTG board, and then click OK.

Note: If there are multiple VTG boards, it is important that you enter the
serial numbers according to the location of the ISA slots. Refer to Chapter
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6, “Performing hardware maintenance” for more information on the location
of the ISA slots.

¥TG Board Configuration x|
— Boards Board Configuration

3 TG Configuration

Serial Mumber IU

Add Board E2

Specify Serial Mumber:

§ i

Cancel |

| State: [
Add .. | Delets | Siteh Eamfiguration
Ok | [Eaneel |
ATTENTION

You can find the VTG board serial number on a sticker on
the backplate of the switch.

28 Continue adding boards one by one.
29 After all VTG boards are added, click OK to close the VTG configuration.

30 Restart the server.

What'’s next

Run the Configuration Wizard by selecting Start > Programs > CallPilot >
Configuration Wizard.

Refer to Part 3, Chapter 6, “Configuring the server software—common dialog
boxes for all switch types” for more information on running the Configuration
Wizard.
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Installing software for the MSL-100/DMS-100
switch

Introduction

Follow these procedures to install and configure software for the MSL-100/
DMS-100 switch.

Requirements
= CallPilot 1.07 PEP CD

To install Dialogic software

1 Insert the CallPilot 1.07 PEP CD into the CD-ROM drive and launch
Windows NT Explorer.

2 Click the CD-ROM drive and navigate to the dialogic\dna3.1 directory.
3  Double-click Setup to start the Dialogic software installation.

Result: Dialogic setup initializes the system to install the Dialogic software.
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D'A mggystem
Software
and SDK

or Windows NT

Copyright @ 1935 Dislogic Corporation

Setup B

you through the rest of the setup process. Please wait.

7% [

g Setup iz preparing the InstallShield Wizard which will guide

4  The system displays the Welcome to Dialogic Setup window.

Welcome to Dialogic Setup

Thiz program will install Dialogic System Software
SDK for Windows MT DMA Verzion 3.1 onto your
- computer,
It iz strongly recommended that pou exit all \Windows programs
befare running this Setup progranm.

Click Cancel to quit Setup and then close any programs pou
have running.  Click Mext to continue with the Setup program.

WARMIMG: This program iz protected by copyright law and
international treaties.

Unauthaorized reproduction or distribution of thiz program, or any
portion of it, may result in severe civil and criminal penalties, and
will be progecuted ta the maximum extent possible under law.

’_ﬂext > | Cancel

5  Click Next to display the Registration Window.
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Registration [ %]

Fleaze enter your name and company name:

Mame: Mortel

LCompary: INorteI Metworks

< Back I Mest » I Cancel |

6  Enter the User name and Company name, and click Next to display the
Setup Options window.

Note: Use the User name and Company name you entered during the
installation of Windows NT.

Setup Options: [ %]

Using the mouse [or tab and space bar], please select one of the
following setup options:

i TYPICAL [50 MByte]: Install: options needed
by most CT developers, including the
development library and zamples. Online help
may be accesszed from CD-ROM.

g COMPLETE [120 MByte]: Install: everything.

COMPALCT [22 MEyte]: Inztalls only a basic
@ Tuntime environmert.

CLSTOM: Lets you choose exactly which
zoftware components to install

5

< Back I dEwt s I Cancel |

7  Select the Custom option, and click Next to display the Custom Component
Selection panel.
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Custom Component Selection [ %]

Select the components you want ta install by placing check
marks in adjacent boxes:

Crrivers, Firmware & Configuration Files 200 ME
[[] Development Library 1.0ME
[] Sample Programs 200 ME
(] TAPI Service Pravider 1.5MB
[] Online Dacumentatian 4.0 MB
Ferformance Lo fin WT Pert. Maritor
[]1SDM Package ROME
(] Antares Saftware 1.0 MB
[] GlobalCall 4P| Package ROME
(] TextTalk 15MB
[15Cx160 1.0MB
Selectdl | Clearal |

< Back I Mest » I Cancel |

8  Select the Drivers, Firmware and Configuration Files option. Click Next to
display the Destination Location panel.

Destination Location E

Setup will copy files inta the directory below. To accept the
directory path displayed, click Next. To select a different
directary, click Browse.

" Drestination Directary

C:\Program FileghDialogic Browse... |

Cancel |

9 Click Browse to create a directory where the setup process will copy files.
Result: The Choose Directory dialog box appears.
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Choose Directory [ %]

Fleaze choose the directory for installation.
Path:

ID:\Program Filez'Dialogic

Directories:

= ot - oK I
= Pragram Files

23 Comman Files

Cancel |
£ potNvWHERE
£ Plus!
£ Symantec LI

Dirives:
I (=N VI Metwork. .. |

10 Inthe Path box, enter d:\Program Files\Dialogic. Click OK

Result: You are asked if you want to create the directory.

Setup

<]
@ The directory:

'D:%Program Filez\Dialogic'

does not exigt. Do you want the directory to be created?

11 Click Yes.

Result: The Destination Location panel redisplays, showing the new
directory.
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Destination Location E

Setup will copy files inta the directory below. To accept the
directory path displayed, click Next. To select a different
directary, click Browse.

C:\Program FileghDialogic Browse... |

Cancel |

" Drestination Directary

< Back

12 Click Next to display the Program Group Folder panel.

Program Group Folder E

Setup will add shortcut icons to the program group folder shown
below. To chooze a different group folder, either zelect from the

list or type a new folder name.

PFrogram Folders:

Ezisting Folders:

Adr & Tools [Comman]
poaNYWHERE 32
Startup

< Back I Mest » I Cancel |

13 Click Next to accept the default values and to display the Setup Options
Summary panel.
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Setup Options Summary [ %]

These are the inztallation options pou have selected. To change
any of these settings, click Back. Otherwise, click Next to begin
the inzstallation process.

LCurrent Settings:

CUSTOM SETUP =]
Components Selected:
Drrivers, Firmware & Configuration Files

Installation Directory: D:\Program Files\Dialogic

Program Group: Dialogic System Software

14 Click the Current Settings or Back to make changes.
15 Click Next to begin installation.

Result: The copying status window appears.

Copying files...
clatalhd 4 fil

Cancel

Once the files are copied, the Dialogic Setup Finish Options panel appears.

16 Deselect the View Release Notes item. Select the Run Dialogic Board
Configuration (DCM) item.

17 Click Finish.
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Dialogic Setup Finish Options

Installation iz almost complete. Please run Dialogic Configuration
Manager [DCM] ta configure your Dialogic boards(z).

™ Wiew Fielease Motes

[+ Fun Dialogic Board Configuration [DCHE

Click Finizh to finizh installation and run the options selected
above, if any.

< Back I Finizh I

Result: You are asked if you would like to install GammalLink fax.

Question B

@ ‘wiould you like to install Gammalink Fax?

18 Click No.

Result: The Reboot Windows dialog box appears.

Reboot Windows [ %]

Some files could not be installed because they are currently in use by
other programs in the spstem. To allow for proper operation of the
driver software you should restart pour system at this time.

& ez, | want to restart ry computer now.

Mo, | will restart my cormputer later.
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19 Click No, | will restart my computer later.

Result: An information window appears showing setup is complete.

Information E

@ Setup complete. Please reboot your spstem if performance monitors or Antares component was selected.

To configure Dialogic software
20 Click OK to configure the Dialogic software.

Result: The Dialogic Configuration Manager window appears.

i Dialogic Configuration Manager

File “iew Action Service Help

X B wilem oo G| 2]

=-4ff Dislog/HD
4 DTI/80SC 5tD 0

Dialogic System Service Status © Stopped

21 From the Dialog Configuration Manager menu, select Action > Configure
Device to configure the Dialogic board.
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i Dialogic Configuration Manager

File  “iew m Service Help

#lzl Add Device Chil+D ? |
Delete Device Chil+L

LConfigure Device Chil+F
Eﬁ-ﬁ Enable levice [CHlHE
4 Disatle Device Chri+
Auto Detect Devices  Chil+0
Riefrezh
Dialogic Spstem Service Status Stopped

Configure Device

Result: The Dialogic Configuration Manager - Properties for All devices
window appears.

22 Select the Telephony Bus tab. Highlight the parameter
SCbusClockMasterSource, and edit it to have the Independent value.
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Dialogic Configuration Manager - Properties for All devices

System  Telephony Bus | Mizc I Eountryl Interfacel

Farameter | WValue
SChusClockMaster Automatic
SChusClockMasterS ource Automatic
PCMEncoding Automatic
4] | i
Edit
Parameter IS ChbusClock asterS ource
Walue A Ubomatic j
Automatic
Lo

QK I Eancell Qpplyl Help |

23 Select the Misc tab. Highlight ParameterFile, and edit it to have the
spandti.prm value.
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Dialogic Configuration Manager - Properties for All devices

System | Telephony Bus  Misc |E0untry| Interfacel

Farameter | WValue

FarameterFile spandti.prm
|sUDDSupported
ParameterFile2

1 | i

E dit

Parameter  [ParameterFile

Walue

QK I Eancell Qpplyl Help |

24 Click OK to apply these changes and close the window.
Click Cancel to exit the window without applying the changes.

Click Apply to apply the changes without closing the window. You might
select another tab to make changes.

Result: You are returned to the Dialogic Configuration Manager window.

25 Change the startup mode to automatic by selecting Service > Startup Mode
> Automatic.
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Dialogic Co
File  View Action

[ s ¢

Canhg =2
E--’ Dialog/HD
3@ DTIMB80SC atID 0

up Mode

Start Semnvice
Stop Service

(BB
Crl+T

v Manual

Dialogic Spstem Service Status

Result: The Start Service menu option activates.

File  View Action Help

#lzlﬁl I Startup Mode

Stop Semnvice

= Dislog/HD
"3 DTI/4805C &t D D

logic Configuration Manager

Fiunning

[Erl)

Dialogic Spstem Service Status

Start Dialogic System Service

Stopped
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26 Select the Start Service menu option.

Result: The Dialogic System Service pop-up window appears.

=~ Dialogic Configuration Manager

File “iew Action Service Help

Z| = =l ole| ol 2
Eﬁ Configured Devices

E’ Dialog/HD

= Dialogic System Service

Success Dialogic service started.

Dialogic Spstem Service Status Stopped

27 Click OK to close the pop-up window.

28 Click File > Exit to exit the Dialogic Configuration Manager.

29 Remove the PEP CD from the CD-ROM drive.

30 Start to configure CallPilot by running the Configuration Wizard.

What’s next

Run the Configuration Wizard by clicking Start > Programs > CallPilot >
Configuration Wizard.

For more information on running the Configuration Wizard, refer to Part 3,
Chapter 6, “Configuring the server software—common dialog boxes for all
switch types”.
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Upgrading CallPilot server software

In this chapter

Pre-upgrade checklist 376
Preparing for the upgrade 381
Upgrading from 1.0 or 1.06 to 1.07 385

Part 5: 1001rp Server Maintenance and Diagnostics 375



Upgrading CallPilot server software Standard 1.0

Pre-upgrade checklist

Introduction

This section provides an upgrade readiness checklist that should be performed
before attempting the upgrade at the customer site. This enables you to

avoid significant lost time and costs

significantly reduce system downtime resulting from upgrade problems that
might have been prevented.

A summary of the upgrade readiness checks includes the following steps:

Ensure dial-up networking can be established with the CallPilot server.

Ensure a pcANYWHERE32 session can be established with the CallPilot
server.

Ensure the MMFS is less than 90 percent full.

Check if the customer has recorded customized prompts.

Check Meridian 1 for required software, feature packages, and patches.
Check system information, such as keycode and serial number.

Check for “critical” PEPs that have been issued since the release of the last
1.07 build.

If one of these readiness checks fails, the failure should be corrected before
attempting the upgrade again. Details of the readiness checks follow.

To ensure a dial-up networking session can be established with

CallPilot

If the PC is not on an IP network connected to the CallPilot server, establish a
connection using Dial-Up Networking.

1
2

Click Start > Programs > Accessories > Dial-Up Networking.
Double-click the MAS icon.
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If the icon is unavailable, create a MAS connection profile. See “Creating
the MAS connection profile” on page 470 of the CallPilot 1.0 Maintenance
and Diagnostics Guide.

3 When prompted, enter the Windows NT logon ID and password.

4 Wait until the connection is established.

To ensure a pcANYWHERE32 session can be established with
CallPilot

If pcANYWHERE32 is not functioning prior to the upgrade, the upgrade will
not change this. If the upgrade is performed and a problem occurs, remote
support access is not possible.

Do not attempt an upgrade to 1.07 until pcANY WHERE3?2 is functioning.

Given a dial-up networking session has been established, establish a
pcANY WHERE32 connection to the CallPilot server:

1 Click Start > Programs > pcANYWHERE32 > pcANYWHERE.
2  Double-click the remote control icon for the server.

3 If the icon is unavailable, create a server connection profile. See “To create
a remote control connection icon” on page 470 of the CallPilot 1.0
Maintenance and Diagnostics Guide.

4 When prompted, enter the pcANYWHERE32 logon ID and password.

If a pcANYWHERE32 session can not be established, open a ticket with Nortel

Networks CTS. You require pcANY WHERE32 access for remote support.
Ensure MMFS volume on Disk 1 is less than 90 percent full

Use the administrative client to check that the MMFS volume on Disk 1 (drive
D) is less than 90 percent full. Do not proceed with the upgrade if the MMES
volume on Disk 1 (drive D) is greater than 90 percent full.

If the MMFS volume is greater than 90 percent full, then the upgrade of the
system to the latest release of the voice prompts might fail.

To find out how much space is used on each volume, perform the following
steps:
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10

On the Administrative client, select SMI > System Administration > System
Performance Monitoring. Double-click “Reporter Download Schedule.”

Result: The system displays the “Select the drive for the local OM
database” dialog box.

Click OK to continue.
From the Reporter Download Schedule window, press Download Now.

Note: If Nortel Communicator is not running, you are prompted to start the
Communicator. Click Yes to continue.

Select an interval for the OM collection period and click OK. A smaller
interval downloads more quickly.

Result: The system downloads the Operational Measurements data from
the server to the client PC.

When the OM download is complete, click Save.

To run the system reports, select Start > Programs > MAS Reporter >
Reports. The default password for Reporter is “password.” You might need
to change the password if you have not already done so.

Select your system name > Reports. Double-click the System folder and
double-click Multimedia File System Usage Monitor Report.

Specify an interval.
Click OK.

Result: A report appears that shows the amount of text and voice space
used for each of the volumes on the system.

Exit Reporter.

Check if custom prompts have been recorded

Use the administrative client to check if custom prompts have been recorded.

View the prompts in the System Prompts Customization main window by

selecting one of the following paths.

For 1.0 systems

Nortel SMI > Meridian Application Server > CallPilot > System Prompts

Customization.
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For 1.06 systems
Nortel SMI > Meridian Application Server > Messaging > System Prompts
Customization.

If one or more prompts are custom, then archive the custom prompts by
selecting one of the following paths:

For 1.0 systems
Nortel SMI > Meridian Application Server > CallPilot > Archive & Restore >
Archive Manager

For 1.06 systems
Nortel SMI > Meridian Application Server > Messaging > Archive & Restore >
Archive Manager

After the upgrade to 1.07, the custom prompts can be restored on the system
from the archived copy.

Ensure the Meridian 1 switch has required patches

Check the Meridian 1 patches against the requirements stated in Part 3, Chapter
3. If the required patches are not present on the Meridian 1, do not proceed with
an upgrade until the Meridian 1 switch is ready. Without the required patches on
the Meridian 1, ring-no-answer and other issues can result.

Checking system information

To locate information about your system that you might need for the upgrade,
click Start > Programs > CallPilot 1.0 (or 1.06) Server > CallPilot System
Information. Ensure that the

m  Security Device ID (Sec. Dev. ID) on the 1.07 keycode label matches the
CallPilot serial number that appears on the CallPilot System Information
dialog box. If these two items do not match, your Nortel Networks
customer support representative must generate a new keycode so you can
upgrade your system.

m  Feature limits displayed on the 1.07 keycode label are greater than or equal
to the feature limits displayed on the CallPilot System Information dialog
box.
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Features cannot be reduced. For example, if you currently have three voice
prompt languages installed on your system, you cannot reduce the number
of languages to two.

Check for critical PEPs that have been issued since 1.07 was released

Check the NIC web site at http://www.nortelnetworks.com/prd/nic (Products >
CallPilot) for any additional PEPs that might have been made available since the
manufacture of the PEP CD. If critical PEPs are available, apply them
immediately after installing the PEPs from the PEP CD.

Note: The NIC web site is a secure site and requires a user name and a password
to log on. If you do not currently have an account, you must apply for one prior
to entry. Be advised it might take three to five business days for your account
request to be processed.
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Preparing for the upgrade

Introduction

Use the procedures in this section to upgrade to a new release of CallPilot
software. To upgrade you must replace the CallPilot software with a higher
numbered release.

You can upgrade

from a previous release (1.0 or 1.06)
from a previous release (1.0 or 1.06) after performing an expansion

from a previous release (1.0 or 1.06) at the same time as performing an
expansion

Note: You cannot downgrade to a previous version of CallPilot software.

Timing

The upgrade process takes approximately 60 minutes.

Requirements

a 1.07 keycode

CallPilot 1.07 Server CD
CallPilot 1.07 PEP CD
CallPilot 1.07 Language CD

a copy of the latest General Release Bulletin (GRB). It is important that you
review this document for special instructions before starting the upgrade.

a CallPilot mailbox, a phoneset, and the phone number of the customer’s
IVF Messaging application to check that CallPilot is operational after the
upgrade

if the customer has the fax or speech recognition options, a fax machine and
the phone numbers for Express Fax Messaging and/or Speech Activated
Messaging
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Upgrade checklist

Step

Review the pre-upgrade checklist on page 376.

Disable all DSP and DS30 channels. Refer to “To disable all
DSP and DS30 channels from the Administrative PC” on page
383 for more information on performing this step.

Have on hand a 1.07 keycode and serial number. Check that the
keycode and serial number are valid by following the steps listed
in “Checking system information” on page 379.

Obtain the current password for the Administrator or NGenSys
account.

If you are unfamiliar with these passwords, contact the
company’s network administrator.

Start services. See “To start services” below for more
information.

Perform a full backup.

See Monitoring and Security for the Administrator.

Before you begin

Check that all services starting with the prefix MAS and CallPilot (MCE) are up

and running before starting the upgrade.

To start services

1  Click Start > Settings > Control Panel > Services.

Select the MAS and CallPilot (MCE) services that have not been started.

2

3  Check that the startup states are set to Automatic.
4  Click OK to confirm.
5

Exit the Services application.
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To disable all DSP and DS30 channels from the Administrative PC
Before upgrading the server, disable the DSP and DS30 channels and then shut
down the Administrative PC.

1

10

11

12

From the Administrative PC, click Start > Programs > CallPilot
Administration Client.

Result: An Explorer window appears.

Click your server icon.

Result: The SMI Login screen appears.

Enter your user ID and password, and then click OK.

From the Administration Menu, select System Administration >
Maintenance Administration.

Double-click the Channel Monitor option.

Result: The DS30 channels appear.

Highlight the channel by clicking the DS30 channel entry.
From the File menu, select Courtesy Stop.

Result: The highlighted DS30 channel changes to off-duty status and
becomes disabled.

Double-click the Multimedia Monitor option.

Result: The DSP channels appear.

Highlight the channel by clicking the DSP channel entry.
From the File menu, select Courtesy Stop.

Result: The highlighted DSP channel changes to off-duty status and
become disabled.

After disabling all DSP channels, dial in to CallPilot to test that the lines are
disabled. You should receive a busy signal.

Shut down the Administrative PC.

If you upgrade from a networked CD

If you perform an upgrade from a networked CD, the machine that serves the
CD must have Windows NT 4.0 (Server or Workstation) and be accessible over
the LAN.
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To reassign the drives
If the CD-ROM is mapped as drive E:, you need to reassign the drives.

1

6
7

Click Start > Programs > Administrative Tools (Common) > Disk
Administrator.

Select the CD-ROM drive.
On the Tools menu, select Assign Drive Letter.

Click the option button for Assign Drive Letter and select Z: from the drop-
down list.

Click OK.
Result: Setup prompts you to confirm the change.
Click Yes to confirm. The new drive assignment occurs immediately.

Select the second hard drive (currently drive F:) and change its drive to E:.

To prepare a keycode file
You require a new keycode to upgrade your CallPilot system. This keycode
should be different than the keycode supplied with your initial CallPilot system.

You can either manually enter the keycode or read it from a file.

1

Open a document in a text-editing application (such as Notepad). The
keycode is supplied by Nortel Networks, and consists of 7 sets of 4
alphanumeric characters.

Type the keycode into the file, placing a space between each set of
characters.

Save the file as a *.kc document.
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Upgrading from 1.0 or 1.06 to 1.07

To upgrade to a newer release

1

Log on to the server using an account with local administrative privileges
(for example, Administrator or NGenSys).

Close all applications except for p)cANYWHERE32, acdproxy, Sybase, and
the MASTraceWindow.

Disable all DSP and DS30 channels using the administrative PC. Refer to
“To disable all DSP and DS30 channels from the Administrative PC’ on
page 383 for instructions on how to stop these channels.

If you are upgrading from 1.0, install Service Pack 5 before starting the
upgrade. Refer to “Installing WIinNT 4.0 Service Pack 5” on page 298.

Insert the 1.07 Server CD in the CD drive.

From the Windows taskbar, click Start > Run.

Click Browse.

Result: A Browse window appears.

Select the CD-ROM drive and double-click setup.exe.
Click OK from the Run window.

Result: The Nortel System Operation window appears.
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Mortel System Operations [ ]

NERTEL
NETWORKS

CallPilot®

‘welcome to Mortel Metworks CallPilot Setup. This program allows
you to install, upgrade, reinstall or uninztall Martel networks
CallPlot software on wour computer.

Fleaze refer ta the General Relkeasze Bulletin before contiuing
thiz cperation.

It iz zrangly recommended thal yow exit all Windows pragramsz
befarz running this Setup program.

Select Exit to quit Setup, and then exit any programs vou have
running. Select Mext to continue with Setup program.

WARNING
Thiz program iz protected by copyright law and international
treaties.

Unavthorized reproduction or cistribution of this program, or any
porticn of it, may result in severe civil and criminal penalties, and
will be prozecuted ta the maximum extent pozzible under law.

< Back Exit

10 Click Next to continue with upgrade.

Result: Setup examines the system and then prompts you to confirm the

upgrade.

Mortel Spstem Operations B

release. Any CallPilot data or programs already on the spstem will be preserved and
converted ag required.

& Upgrade: Replaces the CallFilot software currently on your spstem with a higher numbered

Setup has detected that CallPilot software release 01.06.07 exists on your system.

‘wiould you like to upgrade to CallPilot software releaze 01.07.087

11 Click Yes to start the upgrade.

Result: The Keycode and Serial Number window appears.
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Keycode and Serial Humber =] E3
NERTEL
METWORKS Fleaze enter the zerial number and keycode that came with
L 2 your ingtallation CO
CallPilot
Serial Mumber: |
KeyCode: I I I I I I I

Load keycode from the file:

I Browse |
Load From Diskl

12 Enter the new 1.07 keycode, and then click Next.

Result: The Features Verification window appears.
13 Click Next.

Result: Setup automatically uninstalls previous PEPs as part of the
upgrade procedure. After all PEPs have been uninstalled, a dialog box
appears showing the PEPs that have been uninstalled.

Mortel Spstem Operations [ %]

Setup has finished PEP uninstall operation and here is the summary:

1: Application "PEP: NBO31630G0025 MEBO31E30G0025" has been successfully uninstalled &
2. Application "PEP: MBO31630G0135 MEO3E30G01 35" has been successfully uninstalled
3 Application "PEP: NBO31630G0235 MEOIE30G0235" has been successfully uninstalled
4. Application "PEP: MBO31630G0125 MEOIE30G01 25" haz been successfully uninstalled
5 Application "PEP: MBO31630G0115 MEOIE30G0115" haz been successfully uninstalled
E: Application "PEP: MBO31630G0095 MEO3E30G0095" has been successfully uninstalled
7. Application "PEP: MBO31630G006S MEO3E30GO0ES" has been successfully uninstalled
8 Application "PEP: NBO31630G0265 MEOIE30G02E5" has been successfully uninstalled
9 Application "PEP: MMM 0E0FG0035 MMO10E07G0035" has been successfully uninstalled
10: Application "PEP: MMO10607G002S M0 0B07G0025" has been successfully uninztalle
11: Application "PEP: MMO10607G0335 MO 0B07G0335" has been successfully uninztalle
12 Application "PEP: MMO10607G0285 MO0 OB07G0285" has been successfully uninztalle
13 Application "PEP: MMO10607G 0195 M0 0B07G01 95" has been successfully uninztalle

| | »
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14

15

16
17

18
19

Click OK to continue.

Result: You are prompted to confirm the platform settings for your system.
If the settings are correct, click Yes. Otherwise, click No.

The upgrade process runs automatically. A series of messages appear, to
indicate the items that are being updated (for example, backup/restore,
MMFS).

After the upgrade is complete, setup prompts you to install PEPs.
Click Yes to continue. Remove the Server CD and insert the PEP CD.

Refer to “Installing PEPs” on page 338 for more information on installing
PEPs.

After all the PEPs are installed, restart the server.

After the server restart, run the Configuration Wizard by clicking Start >
Programs > CallPilot > Configuration Wizard.

To run the Configuration Wizard

20

Leave all current values in the Configuration Wizard dialog boxes as they
are until you reach the Keycode and Serial Number dialog box shown here.
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CallFilot Server Configuration Wizard

Keycode and Serial Number:

Fleaze enter the zerial number and kepcode that came with wour CallPilot Server.

Serial Mumber from dongle 1
Serial Mumber

Keyoods I
Browse
‘Warning:  If the serial number that came with your keycode does not match the zerial

number read from the dongle the CallPilot administration client will not be able
to connect to the server; contact your distributar for a new keycode and serial
number, or dongle.

< Back | Mest » | Cancel | Help |

21 Enter the serial number you received with the CallPilot keycode in the
Serial Number box. This number should match the prefilled Serial Number
from dongle box.

If the serial number contains letters, use lowercase.

Note: The Serial Number from dongle box is prefilled with data read from
the software feature key.

22 The keycode is prefilled with the value entered in step 12. Verify that the
keycode is correct.

23 Click Next through the remaining Configuration Wizard dialog boxes until
the following dialog box.
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CallPilot Server Configuration Wizard

Language Source Directory:

Ir order to install or upgrade prompt languages, and install new speech recognition languages
you must have a CallPilot language CD.

Click Browse and locate the language CD. Select the drive letter of the language CD or select
the root directory of the language CD. Do not select subfolders or files on the language CD

If you do not want to make any changes to the languages installed on the server, select Skip
Languages installation, and Click Mext to continue.

Language CD Location | Browse

" Skip Languages installation

WARMIMG: You must have at least one prompt language on vour server before CallPilot wil
be able to function. The configuration wizard can be re-run to add the language
at a later point in time.

< Back | Nest » | Cancel | Help |

24 Remove the PEP CD and insert the CallPilot 1.07 Language CD.

25 Select Install Language.
26 Click Browse and select the CD-ROM drive.

Note: Select the root level of the CD-ROM. Do not select subfolders or files

on the CD. For example, if the CD-ROM is drive Z:, select Z:.
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27 Click Next.

Result: The following dialog box appears, which lists all currently installed
languages:

CallFilot Server Configuration Wizard

Reinstall / Upgrade Existing Languages:

Thiz screen dizplays vour currently installed languages. If you wish to upgrade or reinztall a
language [or languages] that i currently installed on wour system, then pleaze select it [or them]
fram the list below.

Only the currently installed languages that are available on the language CD may be selected.

Flease select Mest to continue.

< Back | Mest » | Cancel | Help |

28 Select the language you want to upgrade and click Next.
Result: The Add Prompt Language dialog box appears.

29 To add a language, select the prompt language check box. Click Next.
Result: The Primary and Secondary Languages dialog box appears.

30 Click Next to accept the currently assigned primary and secondary
languages.

Result: The Speech Recognition Languages dialog box appears.
31 Click Next to skip this dialog box.
Result: The language installation dialog boxes are completed.

32 Click Next through the remaining Configuration Wizard dialog boxes until
the Ready to Configure dialog box appears.
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33

34

Select Apply the current configuration, and click Next.

Result: The configuration changes are applied to the server. This is

followed by a prompt to restart to CallPilot.

Note: The configuration changes take approximately 10 minutes, plus an

additional 10 minutes for each language you are upgrading.
Click Finish, and then click Cancel to bypass the restart.

To enable the DSP channels

35

36

37
38

39

40
41

42

43

44
45

From the Administrative PC, click Start > Programs > CallPilot
Administration Client.

Result: An Explorer window appears.

Click your server icon.

Result: The SMI Login screen appears.

Enter your user ID and password, and then click OK.

From the Administration Menu, double-click Multimedia Monitor.

Result: The DSP channels appear.

If the DSP channels are not enabled, skip to step 40. Otherwise, skip to

step 42 to check the DS30 channels.
Highlight the channel by clicking the DSP channel entry.
From the File menu, select Start Channels.

Result: The highlighted DSP channel changes to online status and
becomes enabled.

Double-click the Channel Monitor option.

Result: The DS30 channels appear.

If the DS30 channels are not enabled, then skip to step 44. Otherwise, skip

to step 46 to test the system.
Highlight the channel by clicking the DS30 channel entry.

From the File menu, select Start Channels.

Result: The highlighted DS30 channel changes to online status and

becomes enabled.
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46 After disabling all DSP channels, dial in to CallPilot to test that the lines are
enabled. You should receive a prompt.

What’s next

Test that CallPilot can receive calls by following the procedures in Part 3,
Chapter 11, “Verifying that CallPilot can receive calls”.
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Expanding CallPilot features

In this chapter

(O8]
(o]
[@)]

Expanding features
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Expanding features

Introduction

This chapter summarizes how you add features to CallPilot.

CallPilot supports feature reduction only for those channels that have been
previously allocated.

Expansions

The following types of features can be expanded:

channels

languages

number of networking sites

number of MPUs

availability of features such as AppBuilderFax and Networking

To add features

1

If you are increasing system capacity, install any additional hardware that
was shipped to you (for example, additional cards or boards). Refer to the
hardware maintenance section of this Installation binder for installation
instructions.

Install the software feature key adapter if a new one was shipped to you.
Refer to Part 2 of this Installation binder for instructions.

Have your new keycode and serial number available. When you purchase
additional features or system capacity, you receive a new keycode and
serial number.

Run the Configuration Wizard (refer to Part 3, Chapter 6, “Configuring the
server software—common dialog boxes for all switch types”). In the
Configuration Wizard, ensure you do the following steps:

a. Enter the new keycode and serial number.
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b. Allocate new channels (if you have added channels).

ATTENTION
New channels are not automatically allocated. They

must be manually allocated using the Configuration
Wizard.

5  Configure additional channels on the switch and in the Configuration
Wizard.
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Chapter 11

Uninstalling CallPilot server software

In this chapter

N
o

Uninstall procedures
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Uninstall procedures

Introduction

This section provides instructions to help you uninstall the CallPilot server
software.

Uninstallation of CallPilot removes the software completely from the server. It
also removes all CallPilot registry entries, linguistic information, and all links to
CallPilot from the server database.

ATTENTION
Once you start the uninstallation process, you cannot

restore CallPilot if you decide to cancel the process. You
must perform a new installation to load CallPilot onto the
server.

What is removed during uninstallation of CallPilot

Uninstallation of CallPilot software removes the following items:

m  CallPilot entries in the Windows N'T Registry
m  all CallPilot entries in the server database
m  CallPilot files

Before you begin

Obtain the current password for the Administrator account.

Switch-related procedures

Note that the uninstall procedure varies depending upon the switch connectivity
installed at the customer site.
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To uninstall Meridian 1

See “To uninstall CallPilot server software” on page 403 for instructions on how
to uninstall Meridian 1 software.

To uninstall Lucent, Mitel, Rolm

1  Uninstall CallPilot by clicking Start > Programs > CallPilot > Uninstall.

Result: You are prompted to confirm the uninstallation.

| Hortel System Dperations <]
i & Wninstall: Rer all CallRilat software and data fram the system. I

Setup detecike,.&that CallPilot zoftware releaze 01.07.07 on your
system. -

wiould wou like to uninztall CallFilat software 7

2  Click Yes to uninstall CallPilot.

Result: The uninstall process runs automatically. During this process, the
following window appears:

Perform Uninstall [ ]

Performing uningtall of the CallPilat 1.07 Server...

Pres: the Cancel button to cancel the uninstall process and
exit this program.

Deleting Service:
nbosavs102

3  After the CallPilot uninstall is complete, the following window appears:
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Mortel Spstem Operations E

Setup has finished uninstall operation and here is the summan:

Callpilot Server has been successfally uninstalled. ;I
‘wiould wou like Setup to reboot the system for you?

Click No to bypass the server restart.

Shut down services by clicking Start > Settings > Control Panel. Double-
click Services, and stop the following services in the given order:

Notification Service
CallPilot SLEE Service
EMCI

Remote Access Server
Telephony Service

vbpcload

To uninstall the VTG software, click Start > Programs > VoiceBridge 2000 >
Uninstall.

Click Yes to confirm uninstall.

Click No to All to keep shared files.

When the uninstall is complete, shut down Windows NT and restart the
server.
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To uninstall DMS-100/MSL-100

1

Uninstall CallPilot from the server by following the procedure described in
“To uninstall CallPilot server software” below. When prompted to restart the
server, select No.

After CallPilot is uninstalled, remove the Dialogic software by clicking Start
> Programs > Dialogic > Uninstall.

Click Yes to confirm uninstall.

Restart the server.

To uninstall CallPilot server software

1

To uninstall CallPilot, click Start > Programs > CallPilot > Uninstall.
Result: You are prompted to confirm the uninstallation.

Click Yes to uninstall CallPilot.

Result: The uninstall process runs automatically.

After the CallPilot uninstall is complete, you are prompted to restart the
server.

Click Yes to restart the server.
Result: You are asked to confirm the restart.
Click OK to restart.
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Reinstalling CallPilot server software

In this chapter

Reinstalling the software (hard drive is functioning)

IN
o
()]

Reinstalling languages

IN
—\
N
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Reinstalling the software (hard drive is
functioning)

Introduction

If the hard drive is functioning but the CallPilot software appears to be
corrupted, you can reinstall the CallPilot server software. This might correct the
problem. If it does not correct the problem, then you need to rebuild the hard
drive (see “Recovering from a hard drive failure or corrupted software” on page
413).

The reinstallation procedure copies CallPilot program files from the CallPilot
Server CD-ROM to a CallPilot system running the same version of CallPilot
software. This process does not affect system or user data. It recovers most
CallPilot program files, but does not recover the operating system, service pack,
or, in the case of non-Meridian 1 systems, switch drivers.

Requirements

= CallPilot Server CD-ROM that has the same version of CallPilot that is
running on the CallPilot server

m  CallPilot Language CD
s CallPilot PEP CD

To reinstall the CallPilot server software
Note: During the reinstall, the following message might appear. If this message
appears, click OK and continue with the reinstall.

CallPilot iz running but is unable to accept calls, since
zome call processing services are not operational.

Fleaze check the event log for further information.
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1 Log on to the CallPilot server.
2 Insert the CallPilot Server CD-ROM.
3 Run setup.exe from the root directory of the CallPilot Server CD-ROM.

Result: The following window appears:

Mortel Spstem Operations [ %]

NERTEL ‘welcome to Mortel Metworks CallPilot Setup.  This program allows
NETWORKS you to install, upgrade, reinstall ar uninstall Mortel netwarks
CallPilot zoftware on your computer.

C a-” P] ] Ot Flease refer to the: General Release Bulletin before continuing
thiz operation.

It iz strongly recommended that you exit all Windows programs
befare running thiz Setup program.

Select Exit to quit Setup, and then exit any programs vou have
unning. Select Mext to continue with Setup program.

WARNING
Thiz program iz protected by copyright law and international
treaties.

Unautharized reproduction or distribution of this program, or any
portion of it, may result in severe civil and criminal penalties, and
will be progecuted to the maximum extent possible under law.

< Back

Exit

4  Click Next.

Result: Setup examines the system and the displays the following window:

Mortel Spstem Operations B

Fieingtall: Copies the same wersion of CallPilat software that you
previously installed. Use this procedure if you believe that CallPilat
zoftware has been cormuped or if CallPilat files have been erazed.
Any CallPilat data already on the spstem will be preserved. You will
need to reapply all necessary PEP: after reinstall has been
completed as Setup will remove all PEPs currently on pour system,

Setup has detected that CallFilot software release 01.07.07 iz
already on your system.

wiould you like to reinstall the same release of CallFilot software 7

5 Click Yes to reinstall the software.

Result: You are asked to confirm the platform setting for the server.
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Mortel Spstem Operations B

If your platform is a 200§, a 02t or a 1007rp, select YES ta launch
the: utility for setting vour platform information from pour CallPilat
Server CD.

If you are running on any ather platform, pleaze put the CallPilat
zyztem platform setting diskette in the floppy drive and select MO,

6  Click Yes to begin the reinstallation of CallPilot software.

Result: Files are copied to the server as part of the reinstall procedure.
This can take up to ten minutes. A series of messages appears to indicate
the items that are being reinstalled (for example, backup/restore, MMFS).

After the reinstall is complete, you are prompted to reinstall PEPs (if any
were present on CallPilot).

CallPilot System Operations . [ %]

The first phase of CallPilot reinstallation has been
successfully completed.

Replace the Current CD with the PEP CD and apply
PEPs as detailed in the GRB.

After applying PEPs run the Configuration Wizard to
reapply Languages.

7 Remove the Server CD and insert the CallPilot 1.07 PEP CD. Click OK.

Refer to “Installing PEPs” on page 338 for more information on reinstalling
PEPs.

8 After all PEPs are reinstalled, restart the server when prompted.

9  After CallPilot has restarted, run the Configuration Wizard (see Part 3,
Chapter 6, “Configuring the server software—common dialog boxes for all
switch types”).
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10 Leave all current values in the Configuration Wizard dialog boxes as they
are until you reach the Language Source Directory dialog box shown here:

CallFilot Server Configuration Wizard

Language Source Directory:

Irv arder ta install or upgrade prompt languages, and install new speech recognition languages
you muzt have a CallFilat language CD.

Click Browsze and locate the language CD. Select the drive letter of the language CD or select
the raot directory of the language CD. Do not select subfolders or files on the language CD.

If you do not want o make any changes to the languages installed on the server, select Skip
Languages installation, and Click Next ta continue.

Language CD Location | Browse

" Skip Languages installation

WARNIMG: You must have at least one prompt language on your server before CallPilat wil

be able ta function. The configuration wizard can be re-iun ta add the language
at a later point in time.

< Back | Mest » | Cancel Help

11 Insert the CallPilot Language CD.
12 Select Install Language.
13 Click Browse and select the CD-ROM drive.

Note: Select the root level of the CD-ROM. Do not select subfolders or files
on the CD. For example, if the CD-ROM is drive Z:, select Z:.
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14 Click Next.

Result: The following dialog box appears which lists all currently installed
languages:

CallFilot Server Configuration Wizard

Reinstall / Upgrade Existing Languages:

Thiz screen dizplays vour currently installed languages. If you wish to upgrade or reinztall a
language [or languages] that i currently installed on wour system, then pleaze select it [or them]
fram the list below.

Only the currently installed languages that are available on the language CD may be selected.

Flease select Mest to continue.

< Back | Mest » | Cancel | Help

15 Select all the languages listed and click Next.
Result: The Add Prompt Language dialog box appears.
16 Click Next to skip this dialog box.
Result: The Primary and Secondary Languages dialog box appears.

17 Click Next to accept the currently assigned primary and secondary
languages.

Result: The Speech Recognition Languages dialog box appears.
18 Click Next to skip this dialog box.
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Result: The language installation dialog boxes are completed.

19 Click Next through the remaining Configuration Wizard dialog boxes until
the following dialog box:

CallPilot Server Configuration Wizard

Ready to Configure the Server!

All the information required to complete the bagic configuration of wour CallPilot server haz been
enkered.

*f'ou can zave the configur ation infiormation to a CallFilot configuration file which can be used
to configure other CallFilot zervers or to recover the configuration in the event of catastrophic
failure.

If you want to continue and apply the configuration to the CallPilot zerver, select the Apply
button below and click on Mest to start the configuration process.

" Save the cument configuration to a config file
Moke:  ou can press cancel to exit without making any changes ta the CallFilot server.

Applying the configuration to the CallPilat server will not require any user input but
may take up ta an hour to complete depending on your server configuration.

< Back | Mest » | Cancel |

20 Select Apply the current configuration, and click Next.

Result: The configuration changes are applied to the server. This is
followed by a prompt to restart to CallPilot.

Note: The configuration changes take approximately 10 minutes, plus an
additional 10 minutes for each language you are reinstalling.

21 Click Finish, then click OK to restart CallPilot.
Result: The CallPilot software reinstallation is done.

22 Test your CallPilot channels as described in Part 4 of this Installation
binder.
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Reinstalling languages

Introduction

If the language prompts are not functioning, then you can reinstall them to try
and fix the problem.

Requirements
m  acCallPilot Language CD

To reinstall languages

1 Log on to the CallPilot server.

2 Run the Configuration Wizard as described in Part 3, Chapter 6,
“Configuring the server software—common dialog boxes for all switch
types.”
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Recovering from a hard drive failure
or corrupted software

In this chapter

_Overview

414
Recovering from a hard drive failure in a RAID system 415
Recovering from a hard drive failure 416
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Overview

Introduction

If the CallPilot server hard drive crashes or if software becomes corrupt, then
you must either reinstall the software or rebuild the hard drive.

ATTENTION o ntact your distributor if a hard drive recovery is required.

Reinstalling languages

If only the language prompts are not functioning, then you can reinstall
languages to try to fix the problem. S&einstalling languages” on page 412

Recovering from corrupted software (hard drive is functioning)

If the hard drive is functioning but the CallPilot software appears to be
corrupted, you can reinstall the CallPilot server software. This might correct the
problem. SeéReinstalling the software (hard drive is functioning)” on page

406. If it does not correct the problem, then you need to rebuild the hard drive.

Recovering from a hard drive failure in a RAID system
The 1001rp server is a RAID system.

In a RAID system the hard drives are mirrored. When one hard drive fails, its
secondary hard drive takes over and there is no system down time. However, you
need to replace the faulty hard drive as soon as possible to maintain hard drive
redundancy. SeeRecovering from a hard drive failure in a RAID system

page 415

Note: If both the hard drives in a mirrored pair fail, then you need to restore the
primary hard drive as described iRecovering from a hard drive failtiren

page 416
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Recovering from a hard drive failure in a RAID
system

Introduction
The 1001rp server is a RAID system.

In a RAID system the hard drives are mirrored. When one hard drive fails, its
secondary hard drive takes over and there is no system down time. However, you
need to replace the faulty hard drive as soon as possible to maintain hard drive
redundancy.

Note: If both the hard drives in a mirrored pair fail, then you need to restore the
primary hard drive as described iRecovering from a hard drive failtiren
page 416

To recover from a hard drive failure in a RAID system

Follow the instructions in the hardware maintenance chapter to replace the faulty
hard drive and rebuild the new hard drive.
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Recovering from a hard drive failure

Introduction

Contact your distributor if a hard drive fails. Your distributor has access to a
utility that is required to restore data from a backup tape. If this is a RAID
system and both drives in a mirrored pair fail, then you need to restore from
backup tape. If only one drive in a mirrored pair fails, ‘d®ecovering from a
hard drive failure in a RAID systéhon page 415

ATTENTION = 1pq recovery procedure requires access to a utility that is not

available to customers. Distributors should refer to the latest
General Release Bulletin on the Nortel Networks web site at
http://www.nortelnetworks.com/nic for the latest procedure.

Requirements
m  all software media that came with the CallPilot system

= acomplete set of server backups, including
m a system backup

= one secondary disk backup for each additional disk drive on your server
(for example E:, F:)
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